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At Hollister Incorporated, our
Mission is to make life more
rewarding and dignified for
people who use our products
and services. This Mission

is based on our unwavering
commitment to our customers
and the communities we serve.
We work in the healthcare
industry, developing innovative
medical products, services and
education materials. Our promise
and the overriding commitment
of every Hollister Associate is to
make a positive difference in the
lives of others.



General Information

HCPCS Codes Disclaimer

The reimbursement information provided herein is intended to provide
general information concerning coding of Hollister products only. Hollister
does not guarantee coverage or payment for any products. The ultimate
responsibility for proper coding, satisfying reimbursement requirements,
and obtaining reimbursement remains with the provider. Coding and
coverage policies and guidelines are complex, can vary from one carrier
or region to another, and are updated frequently. Providers should check
with their local carriers or intermediaries often and should consult with
counsel, a reimbursement specialist, and/or the DMECS website for any
coding, coverage, reimbursement, or billing questions.

HCPCS codes shown in this Product Catalog are current as of January 2018

Latex Statement

The specifications for the Hollister Continence Care products listed
below include natural rubber latex as a component; our suppliers
add natural rubber latex as part of the production process.

If a Hollister product(s) found in this catalog is not listed below,

the specification for that product(s) and packaging does not include
natural rubber latex as a component, and our component suppliers
do not add natural rubber as part of their production process.

Current Stock Numbers:

1051 9107 9207 B14R B12RB
1067 9108 9208 B16R B14RB
1084 9109 9209 B16RB
9106 9206



General Information

How to Use The Hollister Product Catalog

Hollister has created this simplified product catalog to help our
customers find what they need in a quick and efficient manner.
Ifyou...

know the stock number (or stock series number)

Go to the Index at the back of the catalog to find the page where
it appears.

Ifyou...

know the product brand or series name

Go to the Table of Gontents to find where it appears or reference the
Product Name Index.

Ifyou...

know the HCPCS code

Go to the HGPCS Code Index at the back of the catalog to find the page
where it appears.

Prior to use, be sure to read the Instructions for Use for information regarding Intended Use,
Contraindications, Warnings, Precautions, and Instructions.


http://www.hollister.com
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Choosing the Right Skin Barrier

Choosing the Right Skin Barrier
Makes All the Difference

* No single skin barrier works for everyone
e Matching individual needs is at the core of skin barrier selection

— Skin type: healthy, normal, thin, fragile, sensitive, dry,
flaky, oily, sweaty

— Type of stomal output: semi-formed/formed stool,
liquid stool, urine

— Change frequency

Types of Skin Barriers and Their Performance

CeraPlus extended wear skin barrier

e Contains all skin barrier characteristics (adhesion, absorption
and erosion resistance) and is infused with ceramide — a naturally
occurring lipid in the skin which protects against dryness

e |ts formulation is designed to help protect the skin’s
natural moisture barrier and help maintain good peristomal
skin health

Flextend extended wear skin barrier

e Durable with high resistance to erosion

e Swells when it comes in contact with liquid to help form a seal
between the skin and the stoma

e High initial tack and suitable for those who perspire heavily

e Strong adhesion and flexibility

FormaFlex extended wear skin barrier

* Helps to provide a secure peristomal skin seal as it will maintain its
shape after being stretched or shaped

¢ Provides an easy-to-customize opening due to barrier material

e Fasy to shape to individual stomas without the use
of scissors



Choosing the Right Skin Barrier

FlexWear standard wear skin barrier
e Good balance of durability and gentleness providing moderate
adhesion, and can handle frequent or infrequent pouch changes

¢ Resistant to fluid erosion and tends to hold its shape in the
presence of fluids

e Suitable for all skin types, depending on change frequency

* Designed to be worn more than one day

SoftFlex standard wear skin barrier

e Appropriate choice for:

— Those who have thin, fragile, or sensitive skin (such as those
who have undergone chemo/radiation therapy)

— People who desire frequent removal
e Offers low erosion resistance

* Designed to limit skin damage as its gentle to the skin, which
allows for frequent pouch changes

e Thin and flexible without compromising security

Karaya 5 standard wear skin barrier

¢ Well-suited for sensitive skin or in some cases where allergic
reactions to synthetic barriers has occurred

e Mildly adhesive — needs a belt or tape to secure pouching system
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Education

Hollister Secure Start Services
Personalized Patient Support

Support Throughout the Continuum of Care

We are proud to offer dedicated support for each and
every patient we serve along the continuum of care.
Hollister Secure Start services provide a lifetime of
personalized support for our members.

Our team is focused on helping patients with:
® Finding the right product fit
® Navigating insurance coverage
® |dentifying supplier options
® Providing condition specific education
® And more!

To learn more, call us at 1.888.808.7456.

£ Hollister

The Hollister logo and Secure Start are trademarks of Hollister Incorporated.
©2017 Hollister Incorporated.
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Medicare Allowables Quick Reference Guide

General Medicare Product Maximum Allowables of
Selected Ostomy Products

Two-Piece Pouching Systems Maximum Quantity per Month

Flat, Standard Wear Skin Barriers with Floating Flanges 20

Drainable Pouches 20

Closed Pouches 60

Urostomy Pouches 20

Irrigator Sleeves 4 o
L
o

One-Piece Pouching Systems Maximum Quantity per Month =
<<

Drainable Pouches with Flat, Standard Wear Skin Barriers 20 g

Closed Pouches with Flat, Standard Wear Skin Barriers 60 =

Stoma Caps 31

Pediatric Pouching Systems Maximum Quantity per Month

One-Piece Drainable and Urostomy Pouches 20

Two-Piece Skin Barriers 20

Two-Piece Drainable and Urostomy Pouches 20

Two-Piece Mini Closed Pouches 60

Pediatric Ostomy Belt 1

Accessories Maximum Quantity per Month

Skin Barrier Rings *

Skin Barrier Paste 40z

Stoma Powder 10 0z/6 months

Lubricating Deodorant * =

Ostomy Belt 1 = §

Skin Protective Wipes 150/6 months % cSD'
=
Q
[4°]

Note: Medicare allows a usual maximum quantity of supplies each month. The table above
provides the maximum allowable amounts. The amount of supplies you need may vary from
the maximum quantities. That will be determined by your physician and must be on your
order and in your medical record. If you require more ostomy supplies than what is listed

in the table, your physician will need to provide a medical justification for the additional
supplies. The ostomy supplier will need to have that medical justification on file when billing
the Medicare program for the additional supplies.

aleq jamog

* No usual maximum amount established.
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Reimbursement for Fistula Management

Reimbursement For Fistula Management by Medicare

Reimbursement for fistula management under the Medicare program
is described in the Surgical Dressings Policy Article. Specifically the
article states:

“Surgical dressings are covered when either of the following criteria
are met:
1. They are required for the treatment of a wound caused by, or
treated by, a surgical procedure; or

2. They are required after debridement of a wound.”
The article goes on to explain:

“Examples of situations in which dressings are noncovered under the
Surgical Dressings benefit are:

a. Drainage from a cutaneous fistula which has not been caused by
or treated by a surgical procedure”

For information see The Fistula Management Care Tip on www.hollister.com

Sources: Local Coverage Article: Surgical Dressings - Policy Article - Effective 7-24-2017 (A52491)

Hollister Incorporated 1.800.323.4060
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Medicare Utilization Chart

Medicare’s Usual Maximum Quantity for Ostomy Supplies

The quantity of ostomy supplies needed by a patient is determined
primarily by the type of ostomy, its location, its construction, and

the condition of the skin surface surrounding the stoma. There will be
variation according to individual patient need and their needs may vary
over time. The table below lists the maximum number of items/units

of service that are usually medically necessary. The actual quantity
needed for a particular patient may be more or less than the amount
listed depending on the factors that affect the frequency of barrier and
pouch change. The medical necessity for use of a greater quantity of
supplies than the amounts listed must be clearly documented in the
patient’s medical record, and must be available upon request. If adequate
documentation is not provided when requested, the excess quantities will
be denied as not medically necessary. The HCPCS and reimbursement
information provided herein is intended to provide general information
concerning coding of Hollister products only. Please refer to the HGPCS
Code Disclaimer for more information.

Per Medicare LCD for Ostomy Supplies (L33828),
effective 1-1-2017.

HCPCS Long Description Maximum Quantity

A4331  Extension drainage tubing, any type, any length, with *
connector/adapter, for use with urinary leg bag
or urostomy pouch, each

ase) AwoisQ

A4357  Bedside drainage bag, day or night, with or without 2 ea/mo
anti-reflux device, with or without tube, each
A4361 Ostomy faceplate, each 3 ea/6 mo
A4362  Skin barrier, solid, 4 x 4 or equivalent, each 20 ea/mo o
A4363 Ostomy clamp, any type, replacement only, each * o %_
A4364 Adnesive, liquid or equal, any type, per ounce 4 0z/mo @ §
A4366 Ostomy vent, any type, each * &
A4367 Ostomy belt, each 1 ea/mo
A4368 Ostomy filter, any type, each * =
A4369  Ostomy skin barrier, liquid (spray, brush, etc.), per ounce 2 0z/mo g
A4371  Ostomy skin barrier, powder, per ounce 10 0z/6 mo %
A4372 Olstomyl skjn barrierl, solid 4 x 4 or equivalent, standard wear * %
with built-in convexity, each
A4373  Ostomy skin barrier, with flange (solid, flexible, or accordion), *
with built-in convexity, any size, each
A4375  Ostomy pouch, drainable, with faceplate attached, plastic, each * é" -
A4376  Ostomy pouch, drainable, with faceplate attached, rubber, each * g %
A4377 Ostomy pouch drainable for use on faceplate, 10 ea/mo 7]
plastic, each
A4378 Ostomy pouch, drainable, for use on faceplate, rubber, each *
A4379  Ostomy pouch, urinary, with faceplate attached, plastic, each * =
A4380 Ostomy pouch, urinary, with faceplate attached, rubber, each * §
A4381  Ostomy pouch, urinary, for use with faceplate, plastic, each 10 ea/mo ;{
A4382  Ostomy pouch, urinary, for use on faceplate, * @
heavy plastic, each
A4383  Ostomy pouch, urinary, for use on faceplate, rubber, each *
A4384  Ostomy faceplate equivalent, silicone ring, each * m
*No established usual maximum, refer to Medicare Utilization Guidelines. §'_
(=}
=

www.hollister.com Hollister Incorporated
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Medicare Utilization Chart

HCPCS Long Description Quantity

A4385  Ostomy skin barrier, solid 4 x 4 or equivalent, extended wear, *
without built-in convexity, each
A4387  Ostomy pouch, closed, with barrier attached, with built-in *
convexity (one-piece), each
A4388 Ostomy pouch, drainable, with extended wear barrier *
attached, (one-piece), each
A4389 Ostomy pouch, drainable, with barrier attached, with built-in *
5 convexity (one-piece), each
< A4390 Ostomy pouch, drainable, with extended wear barrier *
‘i attached, with built-in convexity (one-piece), each
S A4391  Ostomy pouch, urinary, with extended wear barrier *
% attached (one-piece), each
© A4392  Ostomy pouch, urinary, with standard wear barrier *
attached, with built-in convexity (one-piece), each
A4393  Ostomy pouch, urinary, with extended wear barrier *
attached, with built-in convexity (one-piece), each
A4394  Ostomy deodorant, with or without lubricant, for use in *
ostomy pouch, liquid, per fluid ounce
A4395  Ostomy deodorant for use in ostomy pouch, solid, *
per tablet
A4396  Ostomy belt with peristomal hernia support *
A4397 lrrigation supply, sleeve, each 4 ea/mo
A4398  Ostomy irrigation supply, bag, each 2 ea/6 mo
A4399  Ostomy irrigation supply, cone/catheter, with or without brush 2 ea/6 mo
A4402  Lubricant, per ounce 4 0z/mo
A4404  Ostomy ring, each 10 ea/mo
§ A4405  Ostomy skin barrier, non-pectin based, paste, per ounce 4 0z/mo
g % A4406  Ostomy skin barrier, pectin-based, paste, per ounce 4 0z/mo
§ = A4407  Ostomy skin barrier, with flange (solid, flexible, or *

accordion), extended wear, with built-in convexity,
4 x 4 inches or smaller, each

A4408 Ostomy skin barrier, with flange (solid, flexible, or accordion), *
extended wear, with built-in convexity, larger than 4 x 4
inches, each

A4409  Ostomy skin barrier, with flange (solid, flexible, or accordion), *
extended wear, without built-in convexity, 4 x 4 inches
or smaller, each

A4410 Ostomy skin barrier, with flange (solid, flexible, or accordion), *
extended wear, without built-in convexity, larger than 4 x 4
inches, each

A4411  Ostomy skin barrier, solid 4 x 4 or equivalent, extended
wear, with built-in convexity, each *

A4412  Ostomy pouch, drainable, high output, for use on a
barrier with flange (two-piece system), without filter, each *

A4413  Ostomy pouch, drainable, high output, for use on a *
barrier with flange (two-piece system), with filter, each

A4414  Ostomy skin barrier, with flange (solid, flexible, or 20 ea/mo
accordion), without built-in convexity, 4 x 4 inches or
smaller, each

A4415  Ostomy skin barrier, with flange (solid, flexible, or 20 ea/mo
accordion), without built-in convexity, larger than
4 x 4 inches, each

Bowel Care

Tube
Fasteners

Wound Care

*No established usual maximum, refer to Medicare Utilization Guidelines.

Education

Hollister Incorporated 1.800.323.4060



Medicare Utilization Chart

HCPCS Long Description Quantity

A4416  Ostomy pouch, closed, with barrier attached, with filter 60 ea/mo
(one-piece), each
A4417  Ostomy pouch, closed, with barrier attached, with 60 ea/mo
built-in convexity, with filter (one-piece), each
A4418  Ostomy pouch, closed, without barrier attached, with 60 ea/mo
filter (one-piece), each
A4419  Ostomy pouch, closed, for use on barrier with 60 ea/mo
non-locking flange, with filter (two-piece), each =
A4420 Ostomy pouch, closed, for use on barrier with locking 60 ea/mo X«
flange (two-piece), each g
A4421  Ostomy supply; miscellaneous * ‘c<_)
A4422  Ostomy absorbent material (sheet/pad/crystal packet) * %

for use in ostomy pouch to thicken liquid stomal
output, each

A4423  Ostomy pouch, closed, for use on barrier with locking 60 ea/mo
flange, with filter (two-piece), each

A4424  Ostomy pouch, drainable, with barrier attached, with filter 20 ea/mo
(one-piece), each

A4425  Ostomy pouch, drainable, for use on barrier with 20 ea/mo
non-locking flange, with filter (two-piece system), each

A4426  Ostomy pouch, drainable, for use on barrier with 20 ea/mo
locking flange (two-piece system), each

A4427  Ostomy pouch, drainable, for use on barrier with 20 ea/mo
locking flange, with filter (two-piece system) each

A4428  Ostomy pouch, urinary, with extended wear barrier *

attached, with faucet-type tap with valve (one-piece), each

A4429  Ostomy pouch, urinary, with barrier attached, with built-in 20 ea/mo
convexity, with faucet-type tap with valve (one-piece), each

A4430 Ostomy pouch, urinary, with extended wear barrier *
attached, with built-in convexity, with faucet-type tap
with valve (one-piece), each

ale9
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A4431  Ostomy pouch, urinary, with barrier attached, with 20 ea/mo
faucet-type tap, with valve (one-piece), each
A4432  Ostomy pouch, urinary, for use on barrier with 20 ea/mo w
non-locking flange, with faucet-type tap with valve g
(two-piece), each @
A4433  Ostomy pouch, urinary, for use on barrier with 20 ea/mo S
locking flange (two-piece), each @2
A4434  Ostomy pouch, urinary, for use on barrier with 20 ea/mo

locking flange, with faucet-type tap with valve
(two-piece), each

mu
(<%
A4435  Ostomy pouch, drainable, high output, with extended * % =
wear barrier (one-piece system), with or without filter, each 2 =
A4450  Tape, non-waterproof, per 18 square inches 40 ea (18 sq in)/mo @
A4452  Tape, waterproof, per 18 square inches 40 ea (18 sq in)/mo

A4455  Adhesive remover or solvent (for tape, cement, or other 16 0z/6 mo

adhesive), per ounce g
A4456  Adhesive remover, wipes, any type, each * §_
A5051  Ostomy pouch, closed, with barrier attached 60 ea/mo S
(one-piece), each =
A5052  Ostomy pouch, closed, without barrier attached, 60 ea/mo
(one-piece), each
A5053  Ostomy pouch, closed, for use on faceplate, each 60 ea/mo m
*No established usual maximum, refer to Medicare Utilization Guidelines. §
g.
=
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Medicare Utilization Chart

HCPCS Long Description Quantity

Ab5054  Ostomy pouch, closed, for use on barrier with flange 60 ea/mo
(two-piece), each
A5055 Stoma Cap 31 ea/mo
A5056 Ostomy pouch, drainable, with extended wear barrier 40 ea/mo
attached, with filter, (one-piece), each
A5057  Ostomy pouch, drainable, with extended wear barrier 40 ea/mo
attached, with built-in convexity, with filter, (one-piece), each
® A5061 Ostomy pouch, drainable, with barrier attached 20 ea/mo
8 (one-piece), each
> A5062 Ostomy pouch, drainable, without barrier attached 20 ea/mo
g (one-piece), each
D A5063 Ostomy pouch, drainable, for use on barrier with flange 20 ea/mo
© (two-piece system), each
A5071  Ostomy pouch, urinary, with barrier attached 20 ea/mo
(one-piece), each
A5072  Ostomy pouch, urinary, without barrier attached 20 ea/mo
(one-piece), each
A5073  Ostomy pouch, urinary, for use on barrier with flange 20 ea/mo
(two-piece), each
A5081  Continent device, plug for continent stoma 31 ea/mo
A5082  Continent device, catheter for continent stoma 1 ea/mo
A5083  Continent device, stoma absorptive cover for continent stoma 150 ea/mo
A5093  Ostomy accessory, convex insert 10 ea/mo
A5102 Bedside drainage bottle with or without tubing, rigid or 2 ea/6 mo
expandable, each
A5120  Skin barrier, wipes or swabs, each 150 ea/6 mo
§ A5121  Skin barrier, solid, 6 x 6 or equivalent, each 20 ea/mo
28 A5122  Skin barrier, solid, 8 x 8 or equivalent, each 20 ea/mo
§ = A5126  Adhesive or non-adhesive, disk or foam pad 20 ea/mo
A5131  Appliance cleaner, incontinence and ostomy 1 ea (16 0z btl)/mo
appliances, per 16 ounce
o A6154  Wound pouch, each 3/wk
g AG209 Foam dressing, wound cover, sterile, pad size, 16 sq in
= or less, without adhesive boarder, each dressing 3/wk
§ A6216  Gauze, non-impregnated, non sterile, pad size 16 sq in 60 ea/mo
(=) or less, without adhesive border, each dressing
A9270  Non-covered item or service *

*No established usual maximum, refer to Medicare Utilization Guidelines.

<
2
=R 7 | DID YOU KNOW...
[N
How to Size Hollister Ostomy Pouches
=
S A properly-fitted pouching system is essential to minimize stomal
= and skin irritation, and to obtain optimum pouch wear time. A stoma
2 measuring guide allows correct measurement of the stoma. Measure
= the stoma before every barrier application. Select the barrier opening
which fits where the skin and stoma meet. Verify that no skin is showing
between the skin barrier and the stoma. Too large of an opening will
s leave skin exposed and could lead to skin irritation or erosion.
2
o
=
=]
Ll
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Makes all the Difference

Available on Premier One-Piece and
New Image Two-Piece Pouching Systems

The CeraPlus Skin Barrier with Remois Technology*

At Hollister, we realize the importance of healthy peristomal skin.
Our newest skin barrier is infused with ceramide, the skin’s naturally
occurring protection against dryness. The CeraPlus skin barrier

is designed to help protect the skin’s own moisture barrier, and is
available on Premier one-piece and New Image two-piece pouching
systems. This means you can enjoy the same pouch and skin barrier

features from Hollister that you’ve come to rely on—and more!

The CeraPlus skin barrier from Hollister—because peristomal skin

deserves better.

www.ceraplus.us

IS
% Hollister: oo

Remois

*Remois is a technology of Alcare Co., Ltd.
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Infused

Tube Continence Ostomy Care Ostomy Care Ostomy Care Ostomy Care
Fast Bowel Care C Ogﬁ:?rzlcycegsaol;g . Pouchkins Pediatric Premier One-Piece New Image Two-Piece Ceram
asteners are y ' Pouching System Pouching System Pouching System

Wound Care

Education

Ceramide Infused Products

Geramide is a natural component of human skin, consisting of waxy lipid
molecules. Ceramide links cells of the outer skin (gpidermis) together to
form a waterproof, protective barrier. Ceramides help prevent water loss
that can lead to skin damage and dryness.

All stock numbers shaded in gray throughout this catalog denote
ceramide infused products.

New Image Two-Piece Pouching System

Color Matching System

To help you select compatible New Image pouching system components,
every box label is color-coded. First, select the proper skin barrier; then
select a matching color-coded pouch ("red" skin barrier box label is
compatible to "red" pouch box label).

1-3/4" 4"
(44 mm) (102 mm)

GeraPlus Flat Skin Barriers with Integrated Floating Flange

<= 1120x (CUT-TO-FIT) Box of 5
Q @ > CeraPlus (extended wear) Skin Barrier
> With Tape Border

HCPCS: A4409
Stock No Flange Size For Stomas Up To
11202 @& 1-3/4" (44 mm) 1-1/4" (32 mm)
11203 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
11204 @& 2-3/4" (70 mm) 2-1/4" (57 mm)

1510x (CUT-TO-FIT) Box of 5
> CeraPlus (extended wear) Skin Barrier
> Without Tape Border

HCPCS for 15102, 15103: A4409
HCPCS for 15104: A4410

Stock No Flange Size For Stomas Up To
15102 @& 1-3/4" (44 mm) 1-1/4" (32 mm)
15103 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
15104 @ 2-3/4" (70 mm) 2-1/4" (57 mm)

CeraPlus Convex Skin Barriers with Integrated Floating Flange

= 1140x (CUT-TO-FIT) Box of 5
@ @ > CeraPlus (extended wear) Skin Barrier C
> With Tape Border CONVEX

HCPCS: A4407
Stock No Flange Size For Stomas Up To
11402 @ 1-3/4" (44 mm) 1" (25 mm)
11403 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
11404 @& 2-3/4" (70 mm) 2" (51 mm)

Hollister Incorporated 1.800.323.4060
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CeraPlus Convex Skin Barriers with Integrated Floating Flange
(continued)

1530x (CUT-TO-FIT) Box of 5
> CeraPlus (extended wear) Skin Barrier
> Without Tape Border C CONVEX

HCPCS for 15302, 15303: A4407
HCPCS for 15304: A4408

walsAs Buiyanod
903]d-0M| abew| maN
areq AwolsQ

Stock No Flange Size For Stomas Up To
15302 @& 1-3/4" (44 mm) 1" (25 mm)
15303 @ 2-1/4" (57 mm) 1-1/2" (38 mm) 330
15304 @& 2-3/4" (70 mm) 2" (51 mm) = &
3 o3
23 5
@ <= 1150x (PRE-SIZED) Box of 5 § z g
> CeraPlus (extended wear) Skin Barrier =
@ ; CONVEX
> With Tape Border (
HCPCS: A4407 32 =
Stock No Flange Size Barrier Opening § % =53
11503 & 1-3/4" (44 mm) 7/8" (22 mm) ‘i i 5
11504 & 1-3/4" (44 mm) " (25 mm) 23
11505 @& 2-1/4" (57 mm) 1-1/8" (29 mm) g g =
11506 @ 2-1/4" (57 mm) 1-1/4" (32 mm) 5 ®

Premier One-Piece Pouching System

Drainable Pouches with CeraPlus Flat Barriers

$98110SS820y /(LUO],SO
aren Awolso

i 8931 (CUT-TO-FIT) Box of 10
g0 > Drainable Pouch
el > CeraPlus (extended wear) Skin Barrer
./ > With Tape Border g
- > Without Integrated AF300 Filter ) =L
> Lock 'n Roll Microseal Closure S
> With Comfort\/ear Panels — Body Side Only §
HCPCS: A4388
Ultra-Clear
Stock No For Stomas Up To Pouch Length =
8931 2-1/2" (64 mm) 12" (30 cm) g
@
o
= 8901 (CUT-TO-FIT) Box of 10 &
| > Drainable Pouch =
Y > CeraPlus (extended wear) Skin Barrer
> With Tape Border
- > With Integrated AF300 Filter -
> Lock 'n Roll Microseal Closure ﬁ_ —
» With ComfortWear Panels — Both Sides ] §
HCPCS: A5056 3
Beige w/Viewing Option
Stock No For Stomas Up To Pouch Length
8901 2-1/2" (64 mm) 12" (30 cm) =
o
=
=
o
)
=\
@
m
Q.
=
Q
=L
=
=]

www.hollister.com Hollister Incorporated
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Ceramide Infused Products

Drainable Pouches with GeraPlus Flat Barriers (continued)

N 89xx (PRE-SIZED) Box of 10

> CeraPlus (extended wear) Skin Barrer

> With Tape Border

> With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

> With Comfort\Wear Panels — Both Sides

== > Drainable Pouch

HCPCS: A5056
Beige w/Viewing Option
Stock No Barrier Opening Pouch Length
8925 1" (25 mm) 12" (30 cm)
8930 1-3/16" (30 mm) 12" (30 cm)
8935 1-3/8" (35 mm) 12" (30 cm)
8940 1-9/16" (40 mm) 12" (30 cm)

Drainable Pouches with GeraPlus Soft Convex Barriers

= 895xx (CUT-TO-FIT) Box of 5
— > Drainable Pouch
= > Soft Convex ( COh?\?E)I
- > CeraPlus (extended wear) Skin Barrier
i > With Tape Border
> With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
> With Belt Tabs
> With Comfort\Wear Panels — Both Sides
HCPCS Code: A5057
Beige w/Viewing Option
Stock No For Stomas Up To Pouch Length
8954 1" (25 mm) 12" (30 cm)
8958 1-1/2" (38 mm) 12" (30 cm)
89511 2-1/8" (55 mm) 12" (30 cm)
s 896X (PRE-SIZED) Box of 5
== > Drainable Pouch SOFT
- > Soft Convex ( CONVEX
"y > CeraPlus (extended wear) Skin Barrier
o > With Tape Border
o » With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
> With Belt Tabs
> With Comfort\Wear Panels — Both Sides
HCPCS: A5057
Beige w/Viewing Option
Stock No Barrier Opening Pouch Length
8960 3/4" (19 mm) 12" (30 cm)
8961 7/8" (22 mm) 12" (30 cm)
8962 1" (25 mm) 12" (30 cm)
8963 1-1/8" (29 mm) 12" (30 cm)

Hollister Incorporated 1.800.323.4060



Ceramide Infused Products

Drainable Pouches with CeraPlus Convex Barriers

k

g

1§
1‘]

891x (CUT-TO-FIT) Box of 5
> Drainable Pouch

> CeraPlus (extended wear) Skin Barrier CCONVEX
> With Tape Border

> With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

> With Belt Tabs

> With Comfort\Wear Panels — Both Sides

HCPCS Code: A5057

Beige w/Viewing Option

Stock No For Stomas Up To Pouch Length
8914 1" (25 mm) 12" (30 cm)
8918 1-1/2" (38 mm) 12" (30 cm)
89111 2" (51 mm) 12" (30 cm)
0 898x (CUT-TO-FIT) Box of 5
= > Drainable Pouch
7‘-'\{ > CeraPlus (extended wear) Skin Barrier (CONVEX
= > With Tape Border
> Without Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
> With Belt Tabs
> With Comfort\/ear Panels — Body Side Only
HCPCS Code: A4390
Ultra-Clear
Stock No For Stomas Up To Pouch Length
8984 1" (25 mm) 12" (30 cm)
8988 1-1/2" (38 mm) 12" (30 cm)
89811 2" (51 mm) 12" (30 cm)
e 899x (PRE-SIZED) Box of 5
i > Drainable Pouch
& > CeraPlus (extended wear) Skin Barrier (CONVEX
ey > With Tape Border
e > With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
> With Belt Tabs
> With Comfort\Wear Panels — Both Sides
HCPCS: A5057
Beige w/Viewing Option
Stock No Barrier Opening Pouch Length
8990 3/4" (19 mm) 12" (30 cm)
8991 7/8" (22 mm) 12" (30 cm)
8992 1" (25 mm) 12" (30 cm)
8993 1-1/8" (29 mm) 12" (30 cm)

www.hollister.com

Hollister Incorporated
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Ceramide Infused Products

Urostomy Pouches with GeraPlus Soft Convex Barriers

Upg Design

. 8413xx (CUT-TO-FIT)
> Urostomy Pouch
> Anti-Reflux Valve

Box of 5

includes 1 adapter

SOFT
> CeraPlus (extended wear) Skin Barrier CONVEX
> With Tape Border
> With Belt Tabs A3
> With ComfortWear Panels — Body Side Only
Upgraded Design Features:
> Multi-Chamber Design
» Softer, Streamlined Tap
> Drain Valve Indicator
HCPCS: A4430

Ultra Clear Stock No For Stomas Up To Pouch Length
84134 17 (25 mm) 9” (23 cm)
84138 1-1/2” (38 mm) 9” (23 cm)
841311 21/8” (55 mm) 9” (23 cm)

841X (PRE-SIZED)
> Urostomy Pouch
> Anti-Reflux Valve

Upgraded Design

Box of 5

includes 1 adapter

SOFT
> CeraPlus (extended wear) Skin Barrier CONVEX
> With Tape Border
> With Belt Tabs NEW
> With Comfort\/ear Panels — Body Side Only
Upgraded Design Features:
> Multi-Chamber Design
> Softer, Streamlined Tap
> Drain Valve Indicator
HCPCS: A4430

Beige w/Viewing Option

Stock No Barrier Opening Pouch Length

8412 3/4" (19 mm) 9” (23 cm)

8413 1/8" (22 mm) 9” (23 cm)

8414 1" (25 mm) 9" (23 cm)

8415 1-1/8” (29 mm) 9” (23 cm)

Hollister Incorporated

1.800.323.4060



Ceramide Infused Products

Non Sterile Kits — Drainable

1960x
2 Colostomy/lleostomy Kit includes:
. @ > (1) 1120x CeraPlus (extended wear)
¥ Skin Barrier with Tape Border

Box of 5

> (1) 1800x (Lack 'n Roll Microseal Closure) Ultra-Clear

> Single-Use Package
HCPCS: A5063 + A4414

Ultra-Clear Flange

Stock No Size For Stomas Up To

19602 @ 1-3/4" (44 mm) 1-1/4" (32 mm)

19603 @ 2-1/4" (57 mm) 1-3/4" (44 mm)

19604 @& 2-3/4" (70 mm) 2-1/4" (57 mm)
Box of 5

1980x
° Colostomy/lleostomy Kit includes:
> (1) 1120x CeraPlus (extended wear)

Skin Barrier with Tape Border
L\ > (1) 1817x (Clamp Closure) Ultra-Clear
> Single-Use Package

HCPCS: A5063 + A4414

Ultra-Clear Flange
Stock No Size For Stomas Up To
19802 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19803 @D 2-1/4" (57 mm) 1-3/4" (44 mm)
19804 @& 2-3/4" (70 mm) 2-1/4" (57 mm)
Non Sterile Kits — Urostomy

1990x Box of 5

Urostomy Kit includes:
> (1) 1120x CeraPlus (extended wear)
Skin Barrier with Tape Border

> (1) 7331 Urostomy Drain Tube Adapter
> Single-Use Package

HCPCS: A4432 + A4409

> (1) 1892x with Comfortwear panels (Ultra-Clear Pouch Film)

Ultra-Clear Flange

Stock No Size For Stomas Up To
19902 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19903 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19904 @& 2-3/4" (70 mm) 2-1/4" (57 mm)

www.hollister.com

Hollister Incorporated
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Infused with the Science

of Skin Health

Adapt CeraRing barrier ring

Sealed with the confidence
of ceramide

Adapt barrier ring technology was

introduced more than 10 years ago. Its

ability to be stretched and shaped to help
minimize the risk of leakage and protect the peristomal skin

makes it a favorite among WOC nurses.

Now, innovation has reached the next level, with the introduction
of Adapt CeraRing.

Infused with ceramide—a natural component of the skin—
Adapt CeraRing is designed to support the healthy peristomal
skin your patients deserve. Ceramides help protect the skin’s
natural moisture barrier and help prevent water loss that may

lead to damage and dryness.

Experience the confidence of ceramide—try Adapt CeraRing today.

% Hollister
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Ceramide Infused Products

omy Accessories

Adapt CeraRing Flat Barrier Rings

88xx Box of 10
o > Barrier Rings (Flat)
> Flextend M (extended wear) with Ceramide
HCPCS: A4385
Stock No Outer Diameter Thickness
8805 2" (48 mm) 4.5mm
8815 2" (48 mm) 2.3 mm END

Adapt CeraRing Convex Barrier Rings

O & 895xx Box of 10
_ > Convex Barrier Rings

° > Flextend (extended wear) with Ceramide CCONVEX

HCPCS: Ad4411

Stock No Inner Diameter
89520 13/16" (20 mm) — can be stretched to 1" (25 mm)
89530 1-3/16" (30 mm) — can be stretched to 1-3/8" (35 mm)
89540 1-9/16" (40 mm) — can be stretched to 1-3/4" (45 mm)

Adapt CeraRing Oval Convex Barrier Rings

896xx Box of 10

o Oval G Barrier Ril
o o > Oval Convex Barrier Rings < convex

> Flextend (extended wear) with Ceramide

HCPCS: A4411
Stock No Inner Diameter
89601 7/8" x 1-1/2" (22 mm x 38 mm)
— can be stretched to 1-1/8" x 1-3/4" (27 mm x 43 mm)
89602 1-3/16" x 1-7/8" (30 mm x 48 mm)
— can be stretched to 1-3/8" x 2-1/8" (35 mm x 53 mm)
89603 1-1/2" x 2-3/16" (38 mm x 56 mm)

— can be stretched to 1-3/4" x 2-3/8" (43 mm x 61 mm)

Hollister Incorporated 1.800.323.4060
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Keeping peristomal skin

for all we do
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New Image

Two-Piece Pouching System




Ostomy Care

New Image Two-Piece

Pouching System

Why choose a two-piece
pouching system?

With a two-piece pouching system,

the skin barrier and pouch are separate
and connect together with a plastic ring,
or flange. Here are a few reasons why
you might want to use a two-piece
pouching system:

* You may want to change your pouch
more often than your skin barrier

* You may want to alternate between
different pouch styles. For example,
you might want to wear a smaller pouch
during exercise or in the shower, and a
larger pouch at night

* You may find it easier to center your
skin barrier over your stoma using a
two-piece system



New Image Two-Piece Pouching System

S)0npoId
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Color Matching System

To help you select compatible New Image pouching system components,
every box label is color-coded. First, select the proper skin barrier; then
select a matching color-coded pouch (“red” skin barrier box label is
compatible to “red” pouch box label).

wialshg bu

4ll
(102 mm)

9091d-0M| abew| maN
aren fwoisQ

Flat Skin Barriers with Integrated Floating Flange

o 1120x (CUT-TO-FIT) Box of 5
Q' @ > CeraPlus (extended wear) Skin Barrier
> With Tape Border

HCPCS: A4409
Stock No Flange Size For Stomas Up To

11202 @& 1-3/4" (44 mm) 1-1/4" (32 mm)
11203 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
11204 @ 2-3/4" (70 mm) 2-1/4" (57 mm)

waisAs Buiyanod
8281d-8UQ Jalald
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1510x (CUT-TO-FIT) Box of 5
> CeraPlus (extended wear) Skin Barrier
» Without Tape Border

HCPCS for 15102, 15103: A4409
HCPCS for 15104: A4410

811088902y ALOISQ
aren AwojsQ

Stock No Flange Size For Stomas Up To

15102 @& 1-3/4" (44 mm) 1-1/4" (32 mm)

15103 @ 2-1/4" (57 mm) 1-3/4" (44 mm)

15104 @& 2-3/4" (70 mm) 2-1/4" (57 mm) =

o=

1460x (CUT-TO-FIT) Box of 5 5 3
> Flextend (extended wear) Skin Barrier =
> With Tape Border &
HCPCS for 14602, 14603 & 14604: A4409
HCPCS for 14606: A4410

Stock No Flange Size For Stomas Up To g

14602 @ 1-3/4" (44 mm) 1-1/4" (32 mm) @

14603 @ 2-1/4" (57 mm) 1-3/4" (44 mm) o

14604 @ - 3/4 (70 mm) 2-1/4" (57 mm) Y

14606 4" (102 mm) 3-1/2" (89 mm) @

1560x (CUT-TO-FIT) Box of 5
> Flextend (extended wear) Skin Barrier

» Without Tape Border

HCPCS for 15602 & 15603: A4409
HCPCS for 15604: A4410

SI9UA)SE
agqny

Stock No Flange Size For Stomas Up To

15602 @& 1-3/4" (44 mm) 1-1/4" (32 mm)

15603 @& 2-1/4" (57 mm) 1-3/4" (44 mm) =

15604 @ 2-3/4" 70 mm) 2-1/4" (57 mm) S
=
=5
()
=\
@
m
(=}
=
Q
=L
=
=

www.hollister.com Hollister Incorporated
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New Image Two-Piece Pouching System

Ceramide Infused
Products

Ostomy Care

Flat Skin Barriers with Integrated Floating Flange (continued)

1420x (CUT-TO-FIT) Box of 5
J > FlexWear (standard wear) Skin Barrier
» With Tape Border

o8
< T2
‘if %) HCPCS for 14202, 14203 & 14204: Ad414
E HCPCS for 14206: A4415
g o Stock No Flange Size For Stomas Up To
14202 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
14203 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
™ = 14204 @& 2- 3/4“ (70 mm) 2-1/4" (57 mm)
5E = 14206 4" (102 mm) 3-1/2" (89 mm)
Ss5: 1520x (CUT-TO-FT) Box of 5
853 > FlexWear (standard wear) Skin Barrier
& » Without Tape Border
HCPCS for 15202 & 15203: Ad4414
eEe HCPCS for 15204: A4415
8 g :‘% Stock No Flange Size For Stomas Up To
== 15202 @& 1-3/4" (44 mm) 1-1/4" (32 mm)
S£5 15203 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
828 15204 @ 2-3/4" 70 mm) 2-1/4" (57 mm)

1470x (PRE-SIZED) Box of 5
> Flextend (extended wear) Skin Barrier
» With Tape Border

Ostomy Care
Ostomy Accessories

HCPCS: A4409
Stock No Flange Size Barrier Opening
14701 @ 1-3/4" (44 mm) 5/8" (16 mm)
14702 @& 1-3/4" (44 mm) 3/4" (19 mm)
14703 @ 1-3/4" (44 mm) 7/8" (22 mm)
8 14704 @& 1-3/4" (44 mm) 1" (25 mm)
c 14705 @& 1-3/4" (44 mm) 1-1/8" (29 mm)
o g 14706 @& 1-3/4" (44 mm) 1-1/4" (32 mm)
E=lra ] 14707 @ 2-1/4" (57 mm) 1-3/8" (35 mm)
S 14708 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
o 14709 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
i 1610x (PRE-SIZED) Box of 5
g - > Flextend (extended wear) Skin Barrier
o *» Without Tape Border
% HCPCS: A4409
(=2] Stock No Flange Size Barrier Opening
16101 @& 1-3/4" (44 mm) 5/8" (16 mm)
16102 @ 1-3/4" (44 mm) 3/4" (19 mm)
16103 @ 1-3/4" (44 mm) 7/8" (22 mm)
) 16104 @& 1-3/4" (44 mm) 1" (25 mm)
-] 16105 @ 1-3/4" (44 mm) 1-1/8" (29 mm)
=B 16106 @& 1-3/4" (44 mm) 1-1/4" (32 mm)
=7 16107 @ 2-1/4" (57 mm) 1-3/8" (35 mm)
e 16108 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
. ?  DID YOU KNOW...
]
(&)
=}
(=
3
=  Fach box of New Image pouches includes one disposal bag per pouch
for discreet disposal
o Cutting guides are provided for all cut-to-fit barriers
s e [t is not recommended that you cut a pre-sized skin barrier
= e |t is not recommended to cut past the stop line on a cut-to-fit barrier
S
o
Ll

Hollister Incorporated 1.800.323.4060



New Image Two-Piece Pouching System

Flat Skin Barriers with Integrated Floating Flange (continued)

Y

1430x (PRE-SIZED) Box of 5
> FlexWear (standard wear) Skin Barrier
» With Tape Border

HCPCS: Ad414

Stock No Flange Size Barrier Opening
14301 @ 1-3/4" (44 mm) 5/8" (16 mm)
14302 @ 1-3/4" (44 mm) 3/4" (19 mm)
14303 @ 1-3/4" (44 mm) 7/8" (22 mm)
14304 @ 1-3/4" (44 mm) 1" (25 mm)
14305 @& 1-3/4" (44 mm) 1-1/8" (29 mm)
14306 @& 1-3/4" (44 mm) 1-1/4" (32 mm)
14307 @ 2-1/4" (57 mm) 1-3/8" (35 mm)
14308 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
14309 @ 2-1/4" (57 mm) 1-3/4" (44 mm)

1640x (PRE-SIZFD) Box of 5
- > FlexWear (standard wear) Skin Barrier
" » Without Tape Border

HCPCS: Ad414

Stock No Flange Size Barrier Opening
16402 @ 1-3/4" (44 mm) 3/4" (19 mm)
16403 @ 1-3/4" (44 mm) 7/8" (22 mm)
16404 @ 1-3/4" (44 mm) 1" (25 mm)
16405 @ 1-3/4" (44 mm) 1-1/8" (29 mm)
16406 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
16407 @ 2-1/4" (57 mm) 1-3/8" (35 mm)
16408 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
) 1410x (SHAPE-TO-FIT) Box of 5

» FormaFlex (extended wear) Skin Barrier

» With Tape Border

HCPCS: A4409
Stock No Flange Size For Stomas Up To
14102 @ 1-3/4" (44 mm) 1/2"-1-1/4" (13-32 mm)
14103 @ 2-1/4" (57 mm) 5/8"-1-11/16" (16-43 mm)
14104 @ 2-3/4" (70 mm) 5/8"-2-1/4" (16-57 mm)

2 DID YOU KNOW...

A True Original

The Hollister integrated floating flange—as featured
in the New Image two-piece pouching system—offers
flexibility and security for you and your
patients. The first of its kind, this integrated
floating flange helps relieve pressure on
the tender postoperative or soft abdomen
while offering an easy-to-use, low-profile
solution patients can continue to use after
they transition home. Included in all flat and
convex New Image skin barriers.

www.hollister.com Hollister Incorporated
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New Image Two-Piece Pouching System

Convex Skin Barriers with Integrated Floating Flange

1140x (CUT-TO-FIT)
@ > CeraPlus (extended wear) Skin Barrier
> With Tape Border

HCPCS: A4407

Box of 5

< cowex

Stock No Flange Size For Stomas Up To
11402 & 1-3/4" (44 mm) " (25 mm)
11403 @& 2-1/4" (57 mm) 1-1/2" (38 mm)
11404 @ 2-3/4" (70 mm) 2" (51 mm)

1530x (CUT-TO-FIT) Box of 5

» Without Tape Border

HCPCS for 15302, 15303: A4407
HCPCS for 15304: A4408

> CeraPlus (extended wear) Skin Barrier

C conex

Stock No Flange Size For Stomas Up To
15302 @ 1-3/4" (44 mm) 1" (25 mm)
15303 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
15304 @& 2-3/4" (70 mm) 2" (51 mm)

Box of 5

1480x (CUT-TO-FIT)
> Flextend (extended wear) Skin Barrier
» With Tape Border

HCPCS: A4407

< convex

Stock No Flange Size For Stomas Up To

14802 @& 1-3/4" (44 mm) 1" (25 mm)

14803 @ 2-1/4" (57 mm) 1-1/2" (38 mm)

14804 @& 2-3/4" (70 mm) 2" (51 mm)
1580x (CUT-TO-FIT) Box of 5
> Flextend (extended wear) Skin Barrier

» Without Tape Border

HCPCS for 15802 & 15803: A4407
HCPCS for 15804: A4408

< convex

Stock No Flange Size For Stomas Up To
15802 @ 1-3/4" (44 mm) 1" (25 mm)
15803 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
15804 @ 2-3/4" (70 mm) 2" (51 mm)

2 DID YOU KNOW...

The CeraPlus skin barrier is infused

ceramide and other lipids

a»

dead cells:
Stratum Corneum
“dead cells ceranide and othr pids B

. . ceramide and other lipids
Epidermis

live live
cells cells

ceramide and other lipids

Dermis g T‘ : T‘

Holds in moisture

with ceramide

 Ceramide is a natural
component of the
human skin

 Ceramide links the
cells of the stratum
corneum together to
form a waterproof,
protective barrier

© Ceramide helps
prevent water loss
that can lead to skin
damage and dryness

Hollister Incorporated

1.800.323.4060
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New Image Two-Piece Pouching System s5§
282
g >0
Convex Skin Barriers with Integrated Floating Flange (continued) 8 %
Upg Design Recommended replacement for 1440x series below
2o
0 . 1340x (CUT-TO-FIT) Box of 5 g
> FlexWear (standard wear) Skin Barrier 283
> With Tape Border (CONVEX g =
Upgraded Design Features: 3 2
> Flexible Release Liner ©
» Tapered Barrier Edges
el
HCPCS: A4373 gz &
Stock No Flange Size For Stomas Up To § i é
13402 @ 1-3/4" (44 mm) 1" (25 mm) 23 5
13403 @ 2-1/4" (57 mm) 1-1/2" (38 mm) ]
13404 @ 2-3/4" (70 mm) 2" (51 mm) 38 @
Original Design g % 1
1440x (CUT-TO-FIT) Box of 5 E §§
> FlexWear (standard wear) Skin Barrier e TP
> With Tape Border << convex BE g
HCPCS: A4373 =
Stock No Flange Size For Stomas Up To =
14402 @ 1-3/4" (44 mm) 1" (25 mm) z3
14403 @ 2-1/4" (57 mm) 1-1/2" (38 mm) 23
14404 @ 2-3/4" (70 mm) 2" (51 mm) = é
1540x (CUT-TO-FIT) Box of 5 z @

> FlexWear (standard wear) Skin Barrier
> Without Tape Border ( CONVEX

HCPCS: A4373 §
Stock No Flange Size For Stomas Up To Q g‘
15402 @ 1-3/4" (44 mm) 1" (25 mm) @ 8
15403 @ 2-1/4" (57 mm) 1-1/2" (38 mm) ]
15404 @ 2-3/4" (70 mm) 2" (51 mm)

2 | DID YOU KNOW...

aleq [amog

Select New Image two-piece pouching systems

feature two important product upgrades:

* Lock 'n Roll microseal closure with ribbed strips to facilitate ease of use,
and transparent flap for increased security (as compared to previous design)

 Upgraded skin barrier design to help increase comfort and help improve
ease of use:

- Flexible release liner covers both the skin barrier and the tape border to
help provide improved ease of use

slauajsed
agny

- Tapered barrier edges to help provide increased comfort g
- No change in skin barrier application =
(=1
- Same HCPCS code o
=
(1°]
m
=5
=
Q
=
=
=

www.hollister.com Hollister Incorporated
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Education

New Image Two-Piece Pouching System

Convex Skin Barriers with Integrated Floating Flange (continued)

1150x (PRE-SIZFD) Box of 5
O ° > CeraPlus (extended wear) Skin Barrier
» With Tape Border < convex

HCPCS: A4407
Stock No Flange Size Barrier Opening
11503 @& 1-3/4” (44 mm) 7/8” (22 mm)
11504 @ 1-3/4” (44 mm) 1” (25 mm)
11505 @ 2-1/4” (57 mm) 1-1/8” (29 mm)
11506 @ 2-1/4” (57 mm) 1-1/4” (32 mm)

Upgraded Design Recommended replacement for 149xx series below

139xx (PRE-SIZED) Box of 5
0 > Flextend (extended wear) Skin Barrier C
» With Tape Border CONVEX

Upgraded Design Features:
> Flexible Release Liner
» Tapered Barrier Edge

HCPCS: A4407

Stock No Flange Size Barrier Opening
13901 @ 1-3/4" (44 mm) 5/8" (16 mm
13902 @& 1-3/4" (44 mm) 3/4" (19 mm
13903 @ 1-3/4" (44 mm) 7/8" (22 mm
13904 @& 1-3/4" (44 mm) 1" (25 mm
13905 @ 2-1/4" (57 mm) 1-1/8" (29 mm
13906 @ 2-1/4" (57 mm) 1-1/4" (32 mm
13907 @ 2-1/4" (57 mm) 1-3/8" (35 mm
13908 @ 2-1/4" (57 mm) 1-1/2" (38 mm
13909 @ 2-3/4" (70 mm) 1-5/8" (41 mm
13910 @ 2-3/4" (70 mm) 1-3/4" (44 mm
13911 @ 2-3/4" (70 mm) 2" (51 mm
Original Design
149xx (PRE-SIZED) Box of 5

> Flextend (extended wear) Skin Barrier
» With Tape Border (CONVEX

HCPCS: A4407

Stock No Flange Size Barrier Opening
14901 @& 1-3/4" (44 mm) 5/8" (16 mm
14902 @& 1-3/4" (44 mm) 3/4" (19 mm
14903 @ 1-3/4" (44 mm) 7/8" (22 mm
14904 @ 1-3/4" (44 mm) 1" (25 mm
14905 @ 2-1/4" (57 mm) 1-1/8" (29 mm
14906 @ 2-1/4" (57 mm) 1-1/4" (32 mm
14907 @ 2-1/4" (57 mm) 1-3/8" (35 mm
14908 @ 2-1/4" (57 mm) 1-1/2" (38 mm
14909 @ 2-3/4" (70 mm) 1-5/8" (41 mm
14910 @ 2-3/4" (70 mm) 1-3/4" (44 mm
14911 @ 2-3/4" (70 mm) 2" (51 mm

2  DID YOU KNOW...

Convex Skin Barrier Options

The New Image two-piece pouching system delivers several skin barrier
options to fit a variety of patient needs. Built-in convexity options provide
security for recessed and flush stomas, and peristomal skin with soft
muscle tone. Convex skin barriers are also available with and without tape.

Hollister Incorporated 1.800.323.4060
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New Image Two-Piece Pouching System s5§
=
g >0
Convex Skin Barriers with Integrated Floating Flange (continued) 8 §
1590x (PRE-SIZED) Box of 5
> Flextend (extended wear) Skin Barrier =z
» Without Tape Border << convex =4
HCPCS: A4407 2 §
Stock No Flange Size Barrier Opening %’ = Q
15903 @ 1-3/4" (44 mm) 7/8" (22 mm) S
15904 @ 1-3/4" (44 mm) 1" (25 mm) 8
15905 @ 2-1/4" (57 mm) 1-1/8" (29 mm)
15906 @ 2-1/4" (57 mm) 1-1/4" (32 mm)

Upgraded Design Recommended replacement for 1450x series below

‘
walshg Buyonod
8991d-8UQ Jajwald
alen AwolsQ

1350x (PRE-SIZED) Box of 5
> FlexWear (standard wear) Skin Barrier
> With Tape Border < convex

Upgraded Design Features: 3 S
> Flexible Release Liner ssg
» Tapered Barrier Edge 323
&L P
HCPCS: A4373 Y
Stock No Flange Size Barrier Opening Sz
13503 @& 1-3/4" (44 mm) 7/8" (22 mm)
13504 @ 1-3/4" (44 mm) 1" (25 mm) =
13505 @ 2-1/4" (57 mm) 1-1/8" (29 mm) 29
13506 @ 2-1/4" (57 mm) 1-1/4" (32 mm) 33
=3
Q <
4 q o
Original Design gs
1450x (PRE-SIZED) Box of 5 -

> FlexWear (standard wear) Skin Barrier
> With Tape Border C CONVEX

HCPCS: A4373

alen
22UBUNU0Y

Stock No Flange Size Barrier Opening
14503 @& 1-3/4" (44 mm) 7/8" (22 mm)
14504 @ 1-3/4 (44 mm) 1" (25 mm)
14505 @ 2-1/4" (57 mm) 1-1/8" (29 mm)
14506 @ 2-1/4" (57 mm) 1-1/4" (32 mm)

aleq [amog

27 | DID YOU KNOW... @
Education
Get FIT

with the new digital ostomy
skin barrier Fit Indicator Tool

slauajsed
agny

Developed with an international panel of experienced stoma care nurses, g
a new tool from Hollister Education has been designed to provide a =
simple patient assessment methodology to determine the need for a =%
flat or convex barrier. =
Ready to get started? Visit www.hollister.com/education or =
download the app by searching “Hollister Education” on iTunes or
Google Play.
m
=5
=
Q
=
(=]
=

www.hollister.com Hollister Incorporated
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Ostomy Care Ostomy Care
New Image Two-Piece Ceramide Infused
Products

Ostomy Care
Premier One-Piece
Pouching System

Tube Continence Ostomy Care
o Bowel Care 0 o(s)tgrtnng;eS;rrgs Pouchkins Pediatric
asteners are V Pouching System

Wound Care

Education

New Image Two-Piece Pouching System

Convex Skin Barriers with Integrated Floating Flange (continued)

1550x (PRE-SIZED)
> FlexWear (standard wear) Skin Barrier
» Without Tape Border

HCPCS: A4373

o ©
u, J

Box of 5

< convex

Stock No Flange Size Barrier Opening
15503 @ 1-3/4” (44 mm) 7/8” (22 mm)
15504 @ 1-3/4” (44 mm) 17 (25 mm)
15505 @ 2-1/4” (57 mm) 1-1/8” (29 mm)
15506 @ 2-1/4” (57 mm) 1-1/4” (32 mm)
Drainable Pouches

1818x/1819x Box of 10

» Drainable Pouch

> With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

» With Belt Tabs

» With ComfortWear Panels

- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4425
Transparent Beige Flange Pouch
Stock No Stock No Size Length
18192 18182 @ - 3/4 (44 mm) 12" (30 cm)
18193 18183 @ 21 57 mm) 12" (30 cm)
18194 18184 @& 23 70 mm) 12" (30 cm)

1828x/1829x Box of 20

» Drainable Mini-Pouch

: > With Integrated AF300 Filter
- > Lock 'n Roll Microseal Closure
> With Belt Tabs
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4425
Transparent Beige Flange Pouch
Stock No Stock No Size Length
18292 18282 @ 1-3/4" (44 mm) 7" (18 cm)
18293 18283 @ 2-1/4" (57 mm) 7" (18 cm)
18294 18284 @& 2-3/4" (70 mm) 7" (18 cm)

1811x/1813x/1800x Box of 10

» Drainable Pouch

> Without Integrated Filter

> Lock ’n Roll Microseal Closure
» With Belt Tabs

» With ComfortWear Panels

- Transparent and Ultra-Clear — Body Side Only

- Beige — Both Sides
HCPCS: A5063

Ultra-Clear Transparent  Beige Flange Pouch
Stock No Stock No  Stock No Size Length
18002 18132 18112 @ 1-3/4" (44 mm) 12" (30 cm)
18003 18133 18113 @ 2-1/4" (57 mm) 12" (30 cm)
18004 18134 18114 [ J 273/4 (70 mm) 12" (30 cm)
18006 — — 4" (102 mm) 12" (30 cm)

Hollister Incorporated

1.800.323.4060
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New Image Two-Piece Pouching System =S
529
Drainable Pouches (continued) g5
1814x/1816x Box of 10
» Drainable Pouch Includes 1 clamp

» With Integrated AF300 Filter

» Clamp Closure

> With Belt Tabs

» With ComfortWear Panels

= - Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4425

wia)sAs Bu
9081d-0M] abew| maN
alen Awolso

IFES

Transparent Beige Flange Pouch S 3 %
Stock No Stock No Size Length = g =
18162 18142 @ 1-3/4" (44 mm) 12" (30 cm) 23 ‘g
18163 18143 @ 2-1/4" (57 mm) 12" (30 cm) g2
18164 18144 @ 2-3/4" (70 mm) 12" (30 cm) 38 @
f \ 1810x/1812x/1817x Box of 10 %o
|‘ 1 > Drainable Pouch Includes 1 clamp g5 g,
\ y > Without Integrated Filter 553
> Clamp Closure 22

— > With Belt Tabs g5
- > With ComfortWear Panels Sge

- Transparent and Ultra-Clear — Body Side Only
- Beige — Both Sides

HCPCS: A5063

$91108$899Y AW0ISO
alen Awolso

» Without Integrated Filter

> Clamp Closure

> With Belt Tabs

» With ComfortWear Panels — Both Sides

Ultra-Clear Transparent  Beige Flange Pouch
Stock No Stock No  Stock No Size Length
18172 18102 18122 @& 1-3/4" (44 mm) 12" (30 cm)
18173 18103 18123 @ 2-1/4" (57 mm) 12" (30 cm)
18174 18104 18124 @ 2-3/4" (70 mm) 12" (30 cm)
18176 — — 4"(102mm) 12" (30 cm)

o

E]

1820x Box of 10 £

> Drainable Mini-Pouch Includes 1 clamp @ o

Q

@

o)

HCPCS: A5063 g

Beige Flange Pouch A

Stock No Size Length g

18202 @ 1-3/4" (44 mm) 9" (23 cm) @
18203 @ 2-1/4" (57 mm) 9" (23 cm)
18204 @ 2-3/4" (70 mm) 9" (23 cm)

sJauajseq
aqny

?  DID YOU KNOW...
=
(=]
S
o All New Image pouches are made up of multiple layers of odor-barrier film g
o New Image barriers must be used with New Image pouches and can't be 8
interchanged with other pouching systems =
m
Q
S
=
=
=

www.hollister.com Hollister Incorporated
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; Ostomy Care Ostomy Care Ostomy Care Ostomy Care
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Wound Care

Education

New Image Two-Piece Pouching System

High Output Drainable Pouches

= 1801x
» Drainable Pouch

Box of 10

» Without Integrated Filter
s » Soft Drain Tap
h > With Belt Tabs
» With Comfort\Wear Panel — Body Side Only
» No adapter needed to connect to bedside collector
HCPCS: A4412
Ultra-Clear Flange Pouch
Stock No Size Length
18012 @& 1-3/4" (44 mm) 12" (30 cm)
18013 @ 2-1/4" (57 mm) 12" (30 cm)
18014 @ 2-3/4" (70 mm) 12" (30 cm)
18016 4" (102 mm) 12" (30 cm)
Closed Pouches
! 1836x/1837x Box of 60
> Closed Pouch
» With Integrated AF300 Filter
> With Belt Tabs
> With ComfortiWear Panels
- Transparent — Body Side Only
- Beige — Both Sides
HCPCS: A4419
Transparent Beige Flange Pouch
Stock No Stock No Size Length
18362 18372 @ 1-3/4" (44 mm) 9" (23 cm)
18363 18373 @ 2-1/4" (57 mm) 9" (23 cm)
18364 18374 @ 2-3/4" 70 mm) 9" (23 cm)
- Y 1832x Box of 30
qu > Closed Pouch
ﬁ » With Integrated AF300 Filter
» With Belt Tabs
» With QuietWear Pouch Material — Both Sides
HCPCS: A4419
Beige Flange Pouch
Stock No Size Length
18322 @ 1-3/4" (44 mm) 9" (23 cm)
18323 @ 2-1/4" (57 mm) 9" (23 cm)
18324 @ 2-3/4" (70 mm) 9" (23 cm)

2 DID YOU KNOW...

New Image two-piece pouching system features

QuietWear material for enhanced discretion

Hollister Ostomy offers many choices for patients—including
the unique option of QuietWear pouch material on select closed pouches
that reduces the noise that can be experienced with other pouches.

Hollister Incorporated

1.800.323.4060



New Image Two-Piece Pouching System

Closed Pouches (continued)

1838x/1839x Box of 60
» Closed Mini-Pouch
» With Integrated AF300 Filter
> With Belt Tabs
» With ComfortWear Panels
- Transparent — Bodly Side Only
- Beige — Both Sides

HCPCS: A4419

Transparent Beige Flange Pouch
Stock No Stock No Size Length
18382 18392 @ 1-3/4" (44 mm) 7" (18 cm)
18383 18393 @ 2-1/4" (57 mm) 7" (18 cm)
18384 18394 @ 2-3/4" (70 mm) 7" (18 cm)

1833x Box of 30

1873x Box of 60

» Closed Pouch

> Without Integrated Filter

> With Belt Tabs

» With QuietWear Pouch Material — Both Sides

HCPCS: A5054
Beige Beige
Stock No Stock No Flange Pouch
Box of 30 Box of 60 Size Length
18332 18732 @ 1-3/4" (44 mm) 9" (23 cm)
18333 18733 @ 2-1/4" (57 mm) 9" (23 cm)
18334 18734 @ 2-3/4" (70 mm) 9" (23 cm)

1835x Box of 30
1875x Box of 60
» Closed Mini-Pouch

» Without Integrated Filter
» With Belt Tabs
» With ComfortWear Panels — Both Sides

HCPCS: A5054
Beige Beige
Stock No Stock No Flange Pouch
Box of 30 Box of 60 Size Length
18352 18752 @ 1-3/4" (44 mm) 7" (18 cm)
18353 18753 @ 2-1/4" (57 mm) 7" (18 cm)
18354 18754 @ 2-3/4" (70 mm) 7" (18 cm)

See Irrigation Products for Colostomy Irrigations

www.hollister.com Hollister Incorporated
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Tube Continence Ostomy Care Ostomy Care Ostomy Care Ostomy Care
Fast Bowel Care C O(s)tﬁﬁonc%e(s:sac;zs Pouchkins Pediatric Premier One-Piece™ " New Image Two-Piece Ceramide Infused
asteners are y Pouching System Pouching System Pouching System Products

Wound Care

Education

New Image Two-Piece Pouching System

Urostomy Pouches

Up ded Design Recommended replacement for 1840x/1841x/1842xx

series below
1890x/1891x/1892x Box of 10
» Urostomy Pouch Includes 2 adapters

> Anti-Reflux Valve
> With Belt Tabs
» With ComfortWear Panels
- Transparent and Ultra-Clear — Body Side Only
S - Beige — Both Sides
Upgraded Design Features:
» Multi-Chamber Design
» Softer, Streamlined Tap
» Drain Valve Indicator

HCPCS: A4432

Ultra-Clear Transparent  Beige Flange Pouch
Stock No Stock No  Stock No Size Length
18922 18902 18912 @ 1-3/4" (44 mm) 9" (23 cm)
18923 18903 18913 @ 2-1/4" (57 mm) 9" (23 cm)
18924 18904 18914 @& 2-3/4" (70 mm) 9" (23 cm)
Original Design

P 1840x/1841x/1842x Box of 10

5 > Urostomy Pouch Includes 1 adapter

> Anti-Reflux Valve
> With Belt Tabs
» With ComfortWear Panels

o - Transparent and Ultra-Clear — Body Side Only
- Beige — Both Sides
HCPCS: A4432
Transparent  Beige Ultra-Clear Flange Pouch
Stock No Stock No  Stock No Size Length
18402 18412 18422 @& 1-3/4" (44 mm) 9" (23 cm)
18403 18413 18423 @ 2-1/4" (57 mm) 9" (23 cm)
18404 18414 18424 @& 2-3/4" (70 mm) 9" (23 cm)

2 | DID YOU KNOW...

® The upgraded 1890x urostomy pouch series comes with two adapters.
The original 1840x urostomy pouch series only comes with one

e Please see Hollister bedside drainage collection system with

anti-reflux valve or visit www.hollister.com for all Hollister leg bag

systems

Hollister Incorporated 1.800.323.4060
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New Image Two-Piece Pouching System

Non Sterile Kits — Drainable

©

1960x Box of 5
Colostomy/lleostomy Kit includes:
> (1) 1120x CeraPlus (extended wear)
Skin Barrier with Tape Border
> (1) 1800x (Lock 'n Roll Microseal Closure) Ultra-Clear
> Single-Use Package

HCPCS: A5063 + A4414

Ultra-Clear Flange
Stock No Size For Stomas Up To
19602 @& 1-3/4" (44 mm) 1-1/4" (32 mm)
19603 @D 2-1/4" (57 mm) 1-3/4" (44 mm)
19604 @ 2-3/4" (70 mm) 2-1/4" (57 mm)
1980x Box of 5
° Colostomy/lleostomy Kit includes:
> (1) 1120x CeraPlus (extended wear)
Skin Barrier with Tape Border
L\ > (1) 1817x (Clamp Closure) Ultra-Clear
> Single-Use Package
HCPCS: A5063 + A4414
Ultra-Clear Flange
Stock No Size For Stomas Up To
19802 & 1-3/4" (44 mm) 1-1/4" (32 mm)
19803 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19804 @& 2-3/4" (70 mm) 2-1/4" (57 mm)
1900x Box of 5
. . Colostomy/lleostomy Kit includes:
\1 > (1) 1420x FlexWear (standard wear)
¥ r\ \‘ Skin Barrier with Tape Border
' V/ > (1) 1800x (Lock 'n Roll Microseal Closure) Ultra-Clear
- > (1) 7767 Loop Ostomy Bridge (in 19006 only)
» Single-Use Package
HCPCS for 19002, 19003 & 19004: A5063 + A4414
HCPCS for 19006: A5063 + A4415
Ultra-Clear Flange
Stock No Size For Stomas Up To
19002 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19003 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19004 @ - 3/4 (70 mm) 2-1/4" (57 mm)
19006 4" (102 mm) 3-1/2" (89 mm)
1910x Box of 5
. oy Colostomy/lleostomy Kit includes:
f: = > (1) 1420x FlexWear (standard wear)
_7' Skin Barrier with Tape Border
__\ — » (1) 1817x (Clamp Closure) Ultra-Clear
» (1) 7767 Loop Ostomy Bridge (in 19106 only)
» Single-Use Package
HCPCS for 19102, 19103 & 19104: A5063 + A4414
HCPCS for 19106: A5063 + A4415
Ultra-Clear Flange
Stock No Size For Stomas Up To
19102 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19103 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19104 @& 2-3/4" (70 mm) 2-1/4" (57 mm)
19106 4" (102 mm) 3-1/2" (89 mm)

www.hollister.com

Hollister Incorporated
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Products

Ostomy Care
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asteners are V Pouching System

Wound Care

Education

New Image Two-Piece Pouching System

Non Sterile Kits — Drainable (continued)

o 1930x Box of 5
' Colostomy/lleostomy Kit includes:
! - » (1) 1410x FormaFlex (extended wear)

‘(Q) Skin Barrier with Tape Border
> (1) 1800x (Lock 'n Roll Microseal Closure) Ultra-Clear
» Single-Use Package
HCPCS: A5063 + A4409

Ultra-Clear Flange

Stock No Size For Stomas Up To
19303 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19304 @ 2-3/4" (70 mm) 2-1/4" (57 mm)

Non Sterile Kits — Urostomy

1990x Box of 5
Urostomy Kit includes:
> (1) 1120x CeraPlus (extended wear)

Skin Barrier with Tape Border
> (1) 1892x with Comfortwear panels (Ultra-Clear Pouch Film)
> (1) 7331 Urostomy Drain Tube Adapter
> Single-Use Package

HCPCS: A4432 + A4409

Ultra-Clear Flange

Stock No Size For Stomas Up To
19902 @& 1-3/4" (44 mm) 1-1/4" (32 mm)
19903 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19904 @ 2-3/4" (70 mm) 2-1/4" (57 mm)

1920x Box of 5
Urostomy Kit includes:
> (1) 1460x Flextend (extended wear)
Skin Barrier with Tape Border
> (1) 1842x with Comfortwear Panels
(Ultra-Clear Pouch Film)
> (1) 7331 Urostomy Drain Tube Adapter
» Single-Use Package

HCPCS: A4432 + A4409

Ultra-Clear Flange

Stock No Size For Stomas Up To

19202 @& 1-3/4" (44 mm) 1-1/4" (32 mm)

19203 @ 2-1/4" (57 mm) 1-3/4" (44 mm)

19204 @ 2-3/4" (70 mm) 2-1/4" (57 mm)
- 1940x Box of 5

@ Urostomy Kit includes:

> (1) 1410x Formaflex (extended wear)
T— Skin Barrier with Tape Border
i > (1) 1842x with Comfortwear Panels
(Ultra-Clear Pouch Film)
> (1) 7331 Urostomy Drain Tube Adapter
» Single-Use Package

HCPCS: A4432 + A4409

Ultra-Clear Flange

Stock No Size For Stomas Up To
19402 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19403 @ 2-1/4" (57 mm) 1-3/4" (44 mm)

Hollister Incorporated 1.800.323.4060



New Image Two-Piece Pouching System

Sterile Kits — Drainable

1905x Box of 5
. . Colostomy/lleostomy Kit includes:

Q > (1) 1420x FlexWear (standard wear)
~ Skin Barrier with Tape Border
> (1) 1800x (Lock 'n Roll Microseal Closure) Ultra-Clear
with Comfortwear Panels
> (1) 7767 Loop Ostomy Bridge (in 19056 only)
» Single-Use Package

HCPCS for 19052, 19053 & 19054: A5063 + A4414
HCPCS for 19056: A5063 + A4415

Ultra-Clear Flange
Stock No Size For Stomas Up To
19052 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19053 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19054 @ 2-3/4" (70 mm) 2-1/4" (57 mm)
19056 4" (102 mm) 3-1/2" (89 mm)
. 1915x Box of 5
"Q Colostomy/lleostomy Kit includes: 1 clamp per kit
Z b > (1) 1420x FlexWear (standard wear)
\ J Skin Barrier with Tape Border
>~ »(1)1817x (Clamp Closure) Ultra-Clear with
Comfortwear Panels

> (1) 7767 Loop Ostomy Bridge (in 19156 only)

» Single-Use Package

HCPCS for 19152, 19153 & 19154: A5063 + A4414

HCPCS for 19156: A5063 + A4415
Ultra-Clear Flange
Stock No Size For Stomas Up To
19152 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19153 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19154 @ 2-3/4" (70 mm) 2-1/4" (57 mm)
19156 4" (102 mm) 3-1/2" (89 mm)

o 1935x Box of 5
~ Colostomy/lleostomy Kit includes:

.\' § "’L > (1) 1520x FlexWear (standard wear)
-3 Skin Barrier without Tape Border
= > (1) 1800x (Lock 'n Roll Microseal Closure) Ultra-Clear

with Comfortwear Panels
» Single-Use Package

HCPCS for 19353: A5063 & A4414
HCPCS for 19353: A5063 & A4415

Ultra-Clear Flange

Stock No Size For Stomas Up To
19353 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19354 @ 2-3/4" (70 mm) 2-1/4" (57 mm)

www.hollister.com Hollister Incorporated
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http://www.hollister.com

Tube Continence Ostomy Care Ostomy Care Ostomy Care Ostomy Care
Fast Bowel Care C Oggﬁ?T%gg;‘;gS Pouchkins Pediatric Premier One-Piece | New Image Two-Piece Ceramide Infused
asieners are Yy Pouching System Pouching System Pouching System Products

Wound Care

Education

New Image Two-Piece Pouching System

Sterile Kits — Urostomy

1925x Box of 5
. Urostomy Kit includes:
> (1) 1460x Flextend (extended wear)

Skin Barrier with Tape Border
» (1) 1842x with Comfortwear Panels
(Uttra-Clear Pouch Film)
> (1) 7331 Urostomy Drain Tube Adapter
» Single-Use Package

HCPCS: A4432 + A4409

Ultra-Clear Flange

Stock No Size For Stomas Up To
19252 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19253 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19254 @ 2-3/4" (70 mm) 2-1/4" (57 mm)

1950x Box of 5
. Urostomy Kit includes:
> (1) 15603 Flextend (extended wear)

Skin Barrier without Tape Border
> (1) 18423 Ultra-Clear Pouch Film
> (1) 7331 Urostomy Drain Tube Adapter
» Single-Use Package

HCPCS: A4432 & A4409

Ultra-Clear Flange
Stock No Size For Stomas Up To
19503 @ 2-1/4" (57 mm) 1-3/4" (44 mm)

Hollister Incorporated 1.800.323.4060
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Ostomy Care
Premier One-Piece

Pouching System

Why choose a one-piece
pouching system?

With a one-piece pouching system, the
skin barrier and pouch are connected
and cannot be separated. Here are a few
reasons why you might want to use a
one-piece pouching system:

* You may want your pouching system
to lay very flat against your body

* You need a pouching system that
is flexible

* You may prefer a pouching system that
does not require putting pieces together

* You do not wish to change your pouch
more often than your skin barrier
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Product Design
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Select Premier One-Piece
Pouching Systems feature two
important product updates:
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¢ Lock ’'n Roll microseal closure with ribbed
strips to facilitate ease of use, and transparent
flap for increased security
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e Upgraded skin barrier design to help increase
comfort and help improve ease of use:

- Flexible release liner covers both the skin barrier
and the tape border to help provide improved
ease of use

aleq
22UBUNU0Y

- Tapered barrier edges to help provide
increased comfort

- No change in skin barrier application g
- Same HCPCS code S
Look for the UFE,%@‘,\(?,ED header above these
stock numbers.

slauajsed
agny

For more information, contact your
Hollister Ostomy sales representative.

2189 punop

2% Hollister
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Ostomy Care
Ceramide Infused
Products

Ostomy Care
New Image Two-Piece
Pouching System

ng System

Ostomy Care
Premier One-Piece

Pou

Tube Continence Ostomy Care
Wound Care = Bowel Care 0 033?%5;:& Pouchkins Pediatric
asteners are y Pouching System

Education

Premier One-Piece Pouching System

Drainable Pouches with Flat Barriers

== 8901 (CUT-TO-FIT) Box of 10
;_3 > Drainable Pouch
é > CeraPlus (extended wear) Skin Barrer

: > With Tape Border

> With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
> With Comfort\//ear Panels — Both Sides

HCPCS: A5056
Beige w/Viewing Option
Stock No For Stomas Up To Pouch Length
8901 2-1/2" (64 mm) 12" (30 cm)
G 8931 (CUT-TO-FIT) Box of 10
¥ » Drainable Pouch
;qpf > CeraPlus (extended wear) Skin Barrer
- > With Tape Border
- > Without Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» With ComfortWear Panels — Body Side Only
HCPCS: A4388
Ultra-Clear
Stock No For Stomas Up To Pouch Length
8931 2-1/2" (64 mm) 12" (30 cm)
'—f" : 8331/8371 (CUT-TO-FIT) Box of 10
4 » Drainable Pouch
wf > Flextend (extended wear) Skin Barrier
ﬁ}/ » With Tape Border
e » With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige with Viewing Option — Both Sides
HCPCS: A5056
Transparent  Beige w/Viewing Option
Stock No Stock No For Stomas Up To Pouch Length
8331 8371 2-1/2" (64 mm) 12" (30 cm)
l(’ = 8531/8551 (CUT-TO-FIT) Box of 10
R o » Drainable Pouch
‘:‘7 > Flextend (extended wear) Skin Barrier
? » With Tape Border
= » Without Integrated Filter
> Lock 'n Roll Microseal Closure
» With ComfortWear Panels
- Beige — Both Sides
- Ultra-Clear — Body Side Only
HCPCS: A4388
Ultra-Clear Beige
Stock No Stock No For Stomas Up To Pouch Length
8531 8551 2-1/2" (64 mm) 12" (30 cm)

Hollister Incorporated 1.800.323.4060



Premier One-Piece Pouching System

Drainable Pouches with Flat Barriers (continued)
° 8631/8651 (CUT-TO-FIT) Box of 10
» Drainable Pouch Includes 1 clamp
« > Flextend (extended wear) Skin Barrier
. » With Tape Border
- > Without Integrated Filter
- > Clamp Closure
» With ComfortWear Panels — Body Side Only
HCPCS: A4388
Ultra-Clear Transparent
Stock No Stock No For Stomas Up To Pouch Length
8651 8631 2-1/2" (64 mm) 12" (30 cm)
TN 8641 (CUT-TO-FIT) Box of 10
o » Drainable Mini-Pouch Includes 1 clamp
L% ,= > Flextend (extended wear) Skin Barrier
o > With Tape Border
> Without Integrated Filter
- > Clamp Closure
» With ComfortiWear Panels — Body Side Only
HCPCS: A4388
Transparent
Stock No For Stomas Up To Pouch Length
8641 2-1/2" (64 mm) 9" (23 cm)
g = 8081/8181/8381 (CUT-TO-FIT) Box of 10

» Drainable Pouch
> FlexWear (standard wear) Skin Barrier
» With Tape Border
» With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige and Beige with Viewing Option — Both Sides

HCPCS: A4424

Transparent Beige Beige w/Viewing Option

Stock No Stock No Stock No For Stomas Up To  Pouch Length

8081 8181 8381 2-1/2" (64 mm) 12" (30 cm)
2 | DID YOU KNOW...

Epidermis

The CeraPlus skin barrier is infused with ceramide

ceramide and other lipids dead cells:  Ceramide is a natural
a» Sz e component of the
“dead cells coramide and other pids human skin
live . .
cells eeramide and other lpids  Ceramide links the
cells of the stratum
- - corneum together to
- i form a waterproof,

’ ) protective barrier
ceramide and other lipids

Dermis

[ 4 |4 o Ceramide helps
T‘ T‘ prevent water 10ss
Holds in moisture that can lead to skin
damage and dryness

www.hollister.com

Hollister Incorporated
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Ostomy Care
Ceramide Infused
Products

Ostomy Care
New Image Two-Piece
Pouching System

e-Piece
System

Ostomy Care

Prem

Tube Continence Ostomy Care
Wound Care et Bowel Care : 02;:‘”0':\10{85;:28 Pouchkins Pediatric
asteners are y Pouching System

Education

Premier One-Piece Pouching System

Drainable Pouches with Flat Barriers (continued)

Pt 8031 (CUT-TO-FIT) Box of 10
é“ > Drainable Pouch

F;."' | > FlexWear (standard wear) Skin Barrier

W » With Tape Border

> Without Integrated Filter
> Lock 'n Roll Microseal Closure
» With ComfortiWear Panels — Body Side Only

HCPCS: A5061

Ultra-Clear

Stock No For Stomas Up To Pouch Length

8031 2-1/2" (64 mm) 12" (30 cm)
T 8131 (CUT-TO-FIT) Box of 10
ﬁ > Drainable Pouch Includes 1 clamp

e > FlexWear (standard wear) Skin Barrier

g » With Tape Border

» Without Integrated Filter
= » Clamp Closure
» With ComfortWear Panels — Body Side Only

HCPCS: A5061

Ultra-Clear
Stock No For Stomas Up To Pouch Length
8131 2-1/2" (64 mm) 12" (30 cm)

» SoftFlex (standard wear) Skin Barrier
» Without Tape Border
> With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

= 88300/88400 (CUT-TO-FIT) Box of 10
N —5 | > Drainable Pouch

HCPCS: A4424
Transparent Beige
Stock No Stock No For Stomas Up To Pouch Length
88400 88300 2-1/8" (55 mm) 12" (30 cm)
88800/88700 (CUT-TO-FIT) Box of 20

» Drainable Mini-Pouch

» SoftFlex (standard wear) Skin Barrier

» Without Tape Border

> With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

©

HCPCS: A4424
Transparent Beige
Stock No Stock No For Stomas Up To Pouch Length
88800 88700 2-1/8" (55 mm) 7" (18 cm)

Hollister Incorporated 1.800.323.4060



Premier One-Piece Pouching System

Drainable Pouches with Flat Barriers (continued)

o 88302/88402 (OVAL CUT-TO-FIT)
\ > Drainable Pouch
“ » SoftFlex (standard wear) Skin Barrier
» Without Tape Border

» With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4424

S19Npo.d
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Transparent Beige
Stock No Stock No For Stomas Up To
88402 88302 3"x2.5" (75 mm x 65 mm)

walshg Buyonod

ale) fwoisQ

88401 (CUT-TO-FIT)

» Drainable Pouch

» SoftFlex (standard wear) Skin Barrier
» Without Tape Border

> Without Integrated Filter

> Lock 'n Roll Microseal Closure

walshg Buiyonod
9LIJBIpad SUMUoNod
areq fwo)sQ

» With ComfortiWear Panels — Body Side Only

HCPCS: A5061
Ultra-Clear

5911055909y AW0}SQ

alen AwolsQ

alen
22UBUNU0Y

Stock No For Stomas Up To
88401 2-1/2" (64 mm)
P 88501 (CUT-TO-FIT)
\ \ » Drainable Pouch Includes 1 clamp
I » SoftFlex (standard wear) Skin Barrier
» Without Tape Border
el » Without Integrated Filter
» Clamp Closure
== » With ComfortWear Panels — Body Side Only
HCPCS: A5061
Ultra-Clear
Stock No For Stomas Up To
88501 2-1/2" (64 mm)
s 89xX (PRE-SIZED)

> Drainable Pouch

> CeraPlus (extended wear) Skin Barrer
- > With Tape Border

— | > With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

aleq [amog

agny

> With Comfort\//ear Panels — Both Sides

S19U3)Se4

HCPCS: A5056
Beige w/Viewing Option
Stock No Barrier Opening
8925 1" (25 mm)
8930 1-3/16" (30 mm)
8935 1-3/8" (35 mm)
8940 1-9/16" (40 mm)

ale punop
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Ostomy Care
Ceramide Infused
Products

Ostomy Care
New Image Two-Piece
Pouching System

e-Piece
System

Ostomy Care

Prem

Tube Continence Ostomy Care
Wound Care et Bowel Care : Ogti:‘no':\gef;fgs Pouchkins Pediatric
asteners are y Pouching System

Education

Premier One-Piece Pouching System

Drainable Pouches with Flat Barriers (continued)

853x/855X (PRE-SIZED)
» Drainable Pouch
> Flextend (extended wear) Skin Barrier
» With Tape Border
» Without Integrated Filter
> Lock 'n Roll Microseal Closure
» With ComfortWear Panels
- Transparent — Bodly Side Only
- Beige — Both Sides

HCPCS: A4388

Transparent Beige
Stock No Stock No

Barrier Opening

Box of 10

Pouch Length

8532 8552 1" (25 mm)
8538 8558 1-1/4" (32 mm)
8533 8553 1-1/2" (38 mm)
8539 8559 1-3/4" (44 mm)

12" (30 cm)
12" (30 cm)
12" (30 cm)
12" (30 cm)

P 863X (PRE-SIZED)
o > Drainable Pouch
K« : > Flextend (extended wear) Skin Barrier
» Without Integrated Filter

» With Tape Border
- » Clamp Closure

Box of 10

Includes 1 clamp

» With ComfortWear Panels — Body Side Only

HCPCS: A4388
Transparent
Stock No Barrier Opening Pouch Length
8637 3/4" (19 mm) 12" (30 cm)
8632 1" (25 mm) 12" (30 cm)
8638 1-1/4" (32 mm) 12" (30 cm)
8633 1-1/2" (38 mm) 12" (30 cm)
8639 1-3/4" (44 mm) 12" (30 cm)
8634 2" (51 mm) 12" (30 cm)
8635 2-1/2" (64 mm) 12" (30 cm)

864X (PRE-SIZED) Box of 10

> Drainable Mini-Pouch
> Flextend (extended wear) Skin Barrier
» With Tape Border
- > Without Integrated Filter

> Clamp Closure

Includes 1 clamp

» With ComfortiWear Panels — Both Sides

HCPCS: A4388

Beige

Stock No Barrier Opening Pouch Length
8647 3/4" (19 mm) 9" (23 cm)
8642 1" (25 mm) 9" (23 cm)
8648 1-1/4" (32 mm) 9" (23 cm)
8643 1-1/2" (38 mm) 9" (23 cm)
8649 1-3/4" (44 mm) 9" (23 cm)

Hollister Incorporated

1.800.323.4060



Premier One-Piece Pouching System

Drainable Pouches with Flat Barriers (continued)

¢ dz.’j 80xx/81xx (PRE-SIZED) Box of 10
:" = » Drainable Pouch
{ > FlexWear (standard wear) Skin Barrier
- > With Tape Border
» With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides
HCPCS: A4424
Transparent Beige
Stock No Stock No Barrier Opening Pouch Length
8025 8125 1" (25 mm) 12" (30 cm)
8030 8130 1-3/16" (30 mm) 12" (30 cm)
8035 8135 1-3/8" (35 mm) 12" (30 cm)
8040 8140 1-9/16" (40 mm) 12" (30 cm)
883xx/884xx (PRE-SIZED) Box of 10
» Drainable Pouch
£ » SoftFlex (standard wear) Skin Barrier
d » Without Tape Border
» With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides
HCPCS: A4424
Transparent Beige
Stock No Stock No Barrier Opening Pouch Length
88425 88325 1" (25 mm) 12" (30 cm)
88430 88330 1-3/16" (30 mm) 12" (30 cm)
88435 88335 1-3/8" (35 mm) 12" (30 cm)
88440 88340 1-9/16" (40 mm) 12" (30 cm)
(e 887xX (PRE-SIZED) Box of 20
= > Drainable Mini-Pouch
» SoftFlex (standard wear) Skin Barrier
» Without Tape Border
» With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» With ComfortWear Panels — Both Sides
HCPCS: A4424
Beige
Stock No Barrier Opening Pouch Length
88725 1" (25 mm) 7" (18 cm)
88730 1-3/16" (30 mm) 7" (18 cm)
88735 1-3/8" (35 mm) 7" (18 cm)
88740 1-9/16" (40 mm) 7" (18 cm)

www.hollister.com

Hollister Incorporated
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Ceramide Infused
Products

Ostomy Care
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Ostomy Care
Premier One-Piece

’ A Flexible Fit
’ Made Secure

Ostomy Care
Pouchkins Pediatric
Pouchlng System

Ostomy Care
Ostomy Accessories

Premier Soft Convex Pouching System
Designed to stay secure, no matter what shape
the body takes.

When it comes to finding the right solution for patients, fit comes

Continence
Care

first. Comfort and ease-of-use are also essential to help ensure
positive outcomes—in the hospital and after patients

leave your care.

Hollister Ostomy presents Premier soft convex—a pouching

system that delivers both convex support and flexibility. The skin

Bowel Care

barrier is designed to conform to the body, without compromising
fit. Belt tabs and a tape-bordered barrier help provide an extra
sense of security. And the new viewing option offers a convenient
way to help position the pouch and observe output.

SOFT
- Look for the soft convex symbol CONVEX

Fasteners

- Available in CeraPlus and Flextend (extended wear)
skin barrier formulations

Wound Care

% Hollister

Education



Premier One-Piece Pouching System

Drainable Pouches with Soft Convex Barriers

L 895xx (CUT-TO-FIT) Box of 5
;_3 > Drainable Pouch SOFT
é > Soft Convex CONVEX
: > CeraPlus (extended wear) Skin Barrier
e > With Tape Border
> With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
> With Belt Tabs
> With Comfort\//ear Panels — Both Sides
HCPCS Code: A5057
Beige w/Viewing Option
Stock No For Stomas Up To Pouch Length
8954 1" (25 mm) 12" (30 cm)
8958 1-1/2" (38 mm) 12" (30 cm)
89511 2-1/8" (55 mm) 12" (30 cm)
857x/867x (CUT-TO-FIT) Box of 5

L

» Drainable Pouch
> Soft Convex
> Flextend (extended wear) Skin Barrier
» With Tape Border
> With Integrated AF300 Filter
> Lock ’n Roll Microseal Closure
» With Belt Tabs
» With ComfortWear Panels
- Ultra-Clear — Body Side Only
- Beige with Viewing Option — Both Sides

HCPCS: A5057

- SOFT
< convex

Ultra-Clear  Beige w/Viewing Option

Stock No Stock No For Stomas Up To Pouch Length

8574 8674 1" (13-25 mm) 12" (30 cm)

8578 8678 11/2" (13-38 mm) 12" (30 cm)

85711 86711 21/8" (13-55 mm) 12" (30 cm)
896X (PRE-SIZED) Box of 5

L

> Drainable Pouch

> Soft Convex

> CeraPlus (extended wear) Skin Barrier

> With Tape Border

> With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

> With Belt Tabs

> With Comfort\Wear Panels — Both Sides

HCPCS: A5057

SOFT
 CONVEX

Beige w/Viewing Option

Stock No Opening Pouch Length
8960 3/4" (19 mm) 12" (30 cm)
8961 7/8" (22 mm) 12" (30 cm)
8962 1" (25 mm) (30 cm)
8963 1-1/8" (29 mm) " (30 cm)

www.hollister.com

Hollister Incorporated
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Premier One-Piece Pouching System

Ceramide Infused
Products

Ostomy Care

Drainable Pouches with Soft Convex Barriers (continued)

s 866X (PRE-SIZED) Box of 5
ﬁ- = » Drainable Pouch

> Soft Convex ( COI&\?EF)I
> Flextend (extended wear) Skin Barrier

» With Tape Border

> With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

> With Belt Tabs

» With ComfortWear Panels — Both Sides

Ostomy Care
New Image Two-Piece
Pouching System

£85 HCPCS: A5057

[ = . . .

2% Beige w/Viewing Option

[ Stock No Barrier Opening Pouch Length

2 8661 7/8 22 mm) 12" (30 cm)

oSL& 8662 1" (25 mm) 12" (30 cm)
8663 1-1/8" (29 mm) 12" (30 cm)
8664 1-1/4" (32 mm) 12" (30 cm)

. 8665 1-1/2" (38 mm) 12" (30 cm)

L= £ 8666 1-3/4" (44 mm) 12" (30 cm)

Sc B

s == Drainable Pouches with Convex Barriers

w S 3

cgx s 891x (CUT-TO-FIT) Box of 5

ﬁ > Drainable Pouch

é > CeraPlus (extended wear) Skin Barrier < convex
> With Tape Border

> With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

> With Belt Tabs

> With Comfort\Wear Panels — Both Sides

HCPCS Code: A5057

Ostomy Care
Ostomy Accessories

@ Beige w/Viewing Option
= = Stock No For Stomas Up To Pouch Length
.GE, < 8914 1" (25 mm) 12" (30 cm)
€ © 8918 1-1/2" (38 mm) 12" (30 cm)
3 89111 2" (51 mm) 12" (30 cm)
™ -, 898x (CUT-TO-FIT) Box of 5
5 x ;”, > Drainable Pouch
% .\q\/ > CeraPlus (extended wear) Skin Barrier (CONVEX
= = > With Tape Border
a > Without Integrated AF300 Filter

> Lock 'n Roll Microseal Closure
> With Belt Tabs
> With Comfort\/ear Panels — Body Side Only

HCPCS Code: A4390

Tube
Fasteners

Ultra-Clear
Stock No For Stomas Up To Pouch Length
8984 1" (25 mm) 12" (30 cm)
8988 1-1/2" (38 mm) 12" (30 cm)
89811 2" (51 mm) 12" (30 cm)

o

<

S

=}

=

=

=)

=

=

=]

®

o

=

S

]

Hollister Incorporated 1.800.323.4060



Premier One-Piece Pouching System

Drainable Pouches with Convex Barriers (continued)

nt for 858xx series below

827xx/854xx (CUT-TO-FIT)
» Drainable Pouch
> Flextend (extended wear) Skin Barrier
» With Tape Border
» With Integrated AF300 Filter
> With Belt Tabs
» With ComfortWear Panels
- Transparent — Bodly Side Only

Box of 5

< convex

- Beige with Viewing Option — Both Sides

Upgraded Design Features:
» Lock 'n Roll Microseal Closure

with Ribbed Strips and Transparent Flap

> Flexible Release Liner
» Tapered Barrier Edges

HCPCS Code: A5057
Transparent  Beige w/Viewing Option
Stock No Stock No For Stomas Up To Pouch Length
8274 8544 1" (25 mm) 12" (30 cm)
8278 8548 1-1/2" (38 mm) 12" (30 cm)
82711 — 2" (51 mm) 12" (30 cm)

Original Design

858xx (CUT-TO-FIT)

» Drainable Pouch

> Flextend (extended wear) Skin Barrier
» With Tape Border

» With Integrated AF300 Filter

» With Belt Tabs

Box of 5

< conex

» With ComfortiWear Panels — Body Side Only

> Lock 'n Roll Closure
HCPCS Code: A5057

Transparent

Stock No For Stomas Up To Pouch Length
8584 1" (25 mm) 12" (30 cm)
8588 1-1/2" (38 mm) 12" (30 cm)
85811 2" (51 mm) 12" (30 cm)

2 DID YOU KNOW...

Select Premier one-piece pouching systems
feature two important product upgrades:

ease of use:

help provide improved ease of use

- No change in skin barrier application
- Same HCPCS code

- Tapered barrier edges to help provide increased comfort

e Lock ’n Roll microseal closure with ribbed strips to facilitate ease of use,
and transparent flap for increased security (as compared to previous design)

© Upgraded skin barrier design to help increase comfort and help improve

- Flexible release liner covers both the skin barrier and the tape border to

www.hollister.com

Hollister Incorporated
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http://www.hollister.com

Premier One-Piece Pouching System

Ceramide Infused
Products

Ostomy Care

Drainable Pouches with Convex Barriers (continued)

® 8. Upgraded Design Recommended replacement for 850xx/852xx series below
‘-3 2 & 821xx/824xx (CUT-TO-FIT) Box of 5
ES 2 > Drainable Pouch C
SES » Flextend (extended wear) Skin Barrier CONVEX
S g » With Tape Border
> Without Integrated Filter
> With Belt Tabs
g g5 > With ComfortiWear Panels
o2 - Transparent — Body Side Only
E IS - Beige — Both Sides
% = Upgraded Design Features:
- > Lock 'n Roll Microseal Closure
with Ribbed Strips and Transparent Flap
© > Flexible Release Liner
% § § » Tapered Barrier Edges
LS HCPCS: A4390
g % % Transparent
g § § Stock No For Stomas Up To Pouch Length
& 8244 1" (25 mm) 12" (30 cm)
8248 1-1/2" (38 mm) 12" (30 cm)
® 8 82411 2" (51 mm) 12" (30 cm)
E‘% Original Design
§ s 850xx/852xx (CUT-TO-FIT) Box of 5
S » Drainable Pouch
> Flextend (extended wear) Skin Barrier ( CONVEX
» With Tape Border
3] > Without Integrated Filter
§ o > With Belt Tabs
= 3 > With ComfortWear Panels
S - Transparent — Body Side Only
- Beige — Both Sides
> Lock 'n Roll Closure
= HCPCS: A4390
S Transparent Beige
= Stock No Stock No For Stomas Up To Pouch Length
g 8524 8504 1" (25 mm) 12" (30 cm)
2 8528 8508 1-1/2" (38 mm) 12" (30 cm)
85211 85011 2" (51 mm) 12" (30 cm)

Wound Care Tibe
Fasteners

Education

Hollister Incorporated 1.800.323.4060



oo
- 0 0 L N
Premier One-Piece Pouching System »58
S 32

) . ) ) 29
Drainable Pouches with Convex Barriers (continued) 2 ;eg
DeS|gn Recommended replacement for 862xx series below E § o

G 8262xx (CUT-TO-FIT) Box of 5 S2§
)& » Drainable Pouch Includes 1 clamp e <
LQL‘ > Flextend (extended wear) Skin Barrier ( g g =
» With Tape Border CONVEX 533

— > Without Integrated Filter
> Clamp Closure
- > With Belt Tabs
» With ComfortWear Panels — Body Side Only

Upgraded Design Features:
> Flexible Release Liner
» Tapered Barrier Edges

HCPCS: A4390

walshg Buiyanod
99914-0UQ Jolwald
aren AwoisQ

Transparent od o
Stock No For Stomas Up To Pouch Length g5 g..
82624 1" (25 mm) 12" (30 cm) 553
82628 1-1/2" (38 mm) 12" (30 cm) o3
826211 2" (51 mm) 12" (30 cm) 28§
= = @
Original Design
2o
862xx (CUT-TO-FIT) Box of 5 g g..
> Drainable Pouch Includes 1 clamp fg 3
> Flextend (extended wear) Skin Barrier 3 ‘;
> With Tape Border < cowex g s
» Without Integrated Filter 5 @
» Clamp Closure
> With Belt Tabs
» With ComfortWear Panels — Body Side Only =
=
HCPCS: A4390 &5
Transparent © 3
Stock No For Stomas Up To Pouch Length =
8624 1" (25 mm) 12" (30 cm)
8628 1-1/2" (38 mm) 12" (30 cm)
86211 2" (51 mm) 12" (30 cm)

o sJauajseq
J PUnom agny alen jamog

uoneanp3
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Premier One-Piece Pouching System

Ceramide Infused
Products

Ostomy Care

Drainable Pouches with Convex Barriers (continued)

899x (PRE-SIZED) Box of 5

> Drainable Pouch

> CeraPlus (extended wear) Skin Barrier < comex
> With Tape Border

> With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

> With Belt Tabs

> With Comfort\//ear Panels — Both Sides

HCPCS: A5057

Beige w/Viewing Option
Stock No Barrier Opening Pouch Length

8990 3/4" (19 mm) 12" (30 cm)
8991 7/8" (22 mm) 12" (30 cm)
= 8992 1" (25 mm) 12" (30 cm)
8993 1-1/8" (29 mm) 12" (30 cm)

Ostomy Care
New Image Two-Piece
Pouching System

r One-Piece
g System

Ostomy Care

Ostomy Care
Pouchkins Pediatric
Pouching System

Ostomy Care
Ostomy Accessories

Continence
Care

Bowel Care

2 DID YOU KNOW...

® Premier cut-to-fit products have a 1/2" (13 mm) starter hole and can
be used as a pre-sized product for some small stomas (excludes high
output pouches, wound drainage collectors and Pouchkins products)

o Cutting guides are provided for all cut-to-fit barriers

e Drainable pouches without an integrated closure include one pouch
clamp per box

¢ \We do not recommend protective wipes be used with extended wear
skin barriers, as they may decrease wear time

e Filtered pouches do not require a cover

o Al convex Premier pouches have tape border barriers

o Al convex Premier pouches have belt tabs

Tube
Fasteners

Wound Care

Education

Hollister Incorporated 1.800.323.4060



Premier One-Piece Pouching System

Drainable Pouches with Convex Barriers (continued)

Upgraded Design Recommended replacement for 851xx/859xx series below

828x/829x (PRE-SIZED) Box of 5

> Drainable Pouch < convex
> Flextend (extended wear) Skin Barrier

» With Tape Border

> Without Integrated Filter

> With Belt Tabs

» With ComfortWear Panels
- Transparent — Bodly Side Only
- Beige — Both Sides

Upgraded Design Features:
» Lock 'n Roll Microseal Closure
with Ribbed Strips and Transparent Flap
» Flexible Release Liner
» Tapered Barrier Edges

HCPCS: A4390

Transparent Beige

Stock No Stock No Barrier Opening Pouch Length
8280 8290 3/4" (19 mm) 12" (30 cm)
8281 8291 7/8" (22 mm) 12" (30 cm)
8282 8292 1" (25 mm) 12" (30 cm)
8283 — 1-1/8" (29 mm) 12" (30 cm)
8284 8294 1-1/4" (32 mm) 12" (30 cm)
8285 8295 1-3/8" (35 mm) 12" (30 cm)
8286 — 1-1/2" (38 mm) 12" (30 cm)
8288 — 1-3/4" (44 mm) 12" (30 cm)

Original Design

851xx/859x (PRE-SIZED) Box of 5

> Drainable Pouch
> Flextend (extended wear) Skin Barrier
» With Tape Border (CUNVEX
> Without Integrated Filter
> With Belt Tabs
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides
» Lock 'n Roll Closure

HCPCS: A4390

Transparent Beige
Stock No Stock No Barrier Opening Pouch Length
8510 8590 3/4" (19 mm) 12" (30 cm)
8511 8591 7/8" (22 mm) 12" (30 cm)
8512 8592 1" (25 mm) 12" (30 cm)
8513 8593 1-1/8" (29 mm) 12" (30 cm)
8514 8594 1-1/4" (32 mm) 12" (30 cm)
8515 8595 1-3/8" (35 mm) 12" (30 cm)
85116 8596 1-1/2" (38 mm) 12" (30 cm)
— 8597 1-5/8" (41 mm) 12" (30 cm)
85118 — 1-3/4" (44 mm) 12" (30 cm)
85119 8599 2" (51 mm) 12" (30 cm)

www.hollister.com

Hollister Incorporated
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http://www.hollister.com

Premier One-Piece Pouching System

Ceramide Infused
Products

Ostomy Care

Drainable Pouches with Convex Barriers (continued)

® 8. Upgraded Design Recommended replacement for 861xx series below
8 § = A 8261X (PRE-SIZED) Box of 5
gago e : > Drainable Pouch Includes 1 clamp
% EF k > Flextend (extended wear) Skin Barrier CCONVEX
S =& » With Tape Border
— = » Without Integrated Filter
- > Clamp Closure

> With Belt Tabs

» With ComfortWear Panels — Body Side Only
Upgraded Design Features:

> Flexible Release Liner

& » Tapered Barrier Edges

HCPCS: A4390

r One-Piece
g System

Ostomy Care

[ E=l Transparent
8 S2 Stock No Barrier Opening Pouch Length
=
>.§ = 82610 3/4" (19 mm) 12" (30 cm)
EE S 82611 7/8" (22 mm) 12" (30 cm)
SEE 82612 1" (25 mm) 12" (30 cm)
o3& 82613 1-1/8" (29 mm) 12" (30 cm)
& 82614 1-1/4" (32 mm) 12" (30 cm)
82615 1-3/8" (35 mm) 12" (30 cm)
5 82616 1-1/2" (38 mm) 12" (30 cm)
O 82617 1-5/8" (41 mm) 12" (30 cm)
S 2 82619 2" (51 mm) 12" (30 cm)
D
>3
E2 ” :
@ s Original Design
©3
861X (PRE-SIZED) Box of 5
» Drainable Pouch Includes 1 clamp
3 > Flextend (extended wear) Skin Barrier
= » With Tape Border
[<*]
:é S > Without Integrated Filter (—CONVEX
= » Clamp Closure
(=] > With Belt Tabs
» With ComfortWear Panels — Body Side Only
HCPCS: A4390
% Transparent
3] Stock No Barrier Opening Pouch Length
© 8610 3/4" (19 mm) 12" (30 cm)
% 8611 7/8" (22 mm) 12" (30 cm)
[~2] 8612 1" (25 mm) 12" (30 cm)
8613 1-1/8" (29 mm) 12" (30 cm)
8614 1-1/4" (32 mm) 12" (30 cm)
8615 1-3/8" (35 mm) 12" (30 cm)
8616 1-1/2" (38 mm) 12" (30 cm)
0 8617 1-5/8" (41 mm) 12" (30 cm)
22 8618 1-3/4" (44 mm) 12" (30 cm)
S 8 8619 2" (51 mm) 12" (30 cm)
T8

<5}

3 2

g [ DID YOU KNOW...

=

=3

(=)

= I
o All high output pouches and wound drainage collectors can be connected

= directly into a bedside collector without an adapter

=]

©

o

=

=}

Ll

Hollister Incorporated 1.800.323.4060




Premier One-Piece Pouching System

High Output Drainable Pouches

| 2

Ultra-Clear

80070/80110 (CUT-TO-FIT) Box of 10
> Non Sterile, Drainable Pouch

> Flextend (extended wear) Skin Barrier — Flat

» Without Tape Border

» With Soft Tap

> With Access Window

» With ComfortWear Panels — Body Side Only

> Without Starter Hole

» No adapter needed to connect to bedside collector

HCPCS: A4435

Stock No For Stomas Up To Pouch Length
80070 2-3/4" (70 mm) 12" (30 cm)
80110 4-1/3" (110 mm) 12" (30 cm)
(‘ 81070/81110 (CUT-TO-FIT) Box of 5
: ﬁ > Sterile, Drainable Pouch
# > Flextend (extended wear) Skin Barrier — Flat
¥ » Without Tape Border

Ultra-Clear

» With Soft Tap

> With Access Window

» With ComfortWear Panels — Body Side Only

> Without Starter Hole

» No adapter needed to connect to bedside collector

HCPCS: A4435

Stock No For Stomas Up To Pouch Length

81070 2-3/4" (70 mm) 12" (30 cm)

81110 4-1/3" (110 mm) 12" (30 cm)
970x/977x
» For Management of Draining Wounds, Fistulae,

d or Draining Tube Sites
| o A > Available With and Without FlexWear (standard wear)
~ {.-/ Skin Barriers — Flat

» Sterile and Non Sterile Drainable Pouches

> With Access Window

» Reclosable Cap

» Without Starter Hole

» No adapter needed to connect to bedside collector

HCPCS: A6154

With Barrier: Non Sterile

Stock No Description Quantity/Box
9773 Small (for wounds up to 3") 10
9776 Medium (for wounds up to 3-3/4") 10
9778 Large (for wounds up to 4" x 8") 3
With Barrier: Sterile

Stock No Description Quantity/Box
9701 Small (for wounds up to 3") 5
9702 Medium (for wounds up to 3-3/4") 5
9703 Large (for wounds up to 4" x 8") 3
Without Barrier: Sterile

Stock No Description Quantity/Box
9772 Small (for wounds up to 3") 10
9775 Medium (for wounds up to 3-3/4") 10

www.holliste

r.com Hollister Incorporated
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http://www.hollister.com

Premier One-Piece Pouching System

Ceramide Infused
Products

Ostomy Care

Closed Pouches with Flat Barriers
82300/82400 (CUT-TO-FIT) Box of 30

2 £} > Closed Pouch
% E‘:’ 5 hﬁa:('__ » SoftFlex (standard wear) Skin Barrier — Flat
SgZ ~ » Without Tape Border
E‘ o2 » With Integrated AF300 Filter
SES » With ComfortWear Panels
o:& - Transparent — Body Side Only
— - Beige — Both Sides
® 8= HCPCS: A4416
8L 2 Transparent Beige
‘i © & Stock No Stock No For Stomas Up To Pouch Length
g = 82400 82300 2-1/8" (55 mm) 9" (23 cm)
8e&
82302/82402 (OVAL CUT-TO-FIT) Box of 30
> Closed Pouch
] § = » SoftFlex (standard wear) Skin Barrier — Flat
33 = » Without Tape Border
Eeo > With Integrated AF300 Filter
S=£§ > With ComfortWear Panels
8 § 8 - Transparent — Body Side Only

- Beige — Both Sides

HCPCS: A4416

Transparent Beige
Stock No Stock No For Stomas Up To Pouch Length

82402 82302 3"x2.5" (75 mm x 65 mm) 9" (23 cm)

Ostomy Care
Ostomy Accessories

82100/82500 (CUT-TO-FIT) Box of 30
> Closed Mini-Pouch
» SoftFlex (standard wear) Skin Barrier — Flat
» Without Tape Border
» With Integrated AF300 Filter
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4416

Continence
Care

Transparent Beige
Stock No Stock No For Stomas Up To Pouch Length
82500 82100 2-1/8" (55 mm) 7" (18 cm)

Bowel Care

823xx (PRE-SIZED) Box of 30
> Closed Pouch

» SoftFlex (standard wear) Skin Barrier — Flat

» Without Tape Border

» With Integrated AF300 Filter

» With ComfortWear Panels — Both Sides

HCPCS: A4416

Tube
Fasteners

Beige
Stock No Barrier Opening Pouch Length
® 82325 1" (25 mm) 9" (23 cm)
= 82330 1-3/16" (30 mm) 9" (23 cm)
o 82335 1-3/8" (35 mm) 9" (23 cm)
B
=
=)
=
=
2
=
o
=
S
i}

Hollister Incorporated 1.800.323.4060



Premier One-Piece Pouching System

Closed Pouches with Flat Barriers (continued)

821xx (PRE-SIZED)
» Closed Mini-Pouch

» Without Tape Border
> With Integrated AF300 Filter

» With ComfortiWear Panels — Both Sides

Box of 30

» SoftFlex (standard wear) Skin Barrier — Flat

HC416: A4416
Beige
Stock No Barrier Opening Pouch Length
82125 1" (25 mm) 7" (18.cm)
82130 1-3/16" (30 mm) 7" (18 cm)
82135 1-3/8" (35 mm) 7" (18 cm)
Stoma Cap
_,;;\;q 1796 (PRE-SIZED) Box of 30
{ Ji > Stoma Cap
M » SoftFlex (standard wear) Skin Barrier — Flat
B » Without Tape Border
» With Integrated Filter
HCPCS: A5055
Beige
Stock No Barrier Opening Size
1796 1-15/16" (50 mm) 4" (102 mm)

www.hollister.com

Hollister Incorporated
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http://www.hollister.com

Ceramide Infused
Products

Ostomy Care

Ostomy Care
New Image Two-Piece
Pouching System

One-Piece
System

Ostomy Care

&

Tube Continence Ostomy Care
Wound Care o Bowel Care 0 ogtﬁkoTc{eg;:gs Pouchkins Pediatric
asteners are V Pouching System

Education

Premier One-Piece Pouching System

Urostomy Pouches with Flat Barriers

Recommended replacement for 8440/8450/8460

Upgraded Design

series below
84490/84590/84690 (CUT-TO-FIT) Box of 10
» Urostomy Pouch Includes 2 adapters

q > Anti-Reflux Valve
e > Flextend (extended wear) Skin Barrier
;'r > With Tape Border
> With Comfort\Wear Panels
- Transparent and Ultra-Clear — Body Side Only
- Beige — Both Sides

Upgraded Design Features:
» Multi-Chamber Design
» Softer, Streamlined Tap

HCPCS: A4428

-

Ultra-Clear  Transparent Beige
Stock No Stock No Stock No For Stomas Up To  Pouch Length

84590 84690 84490 2-1/2" (64 mm) 9" (23 cm)

Original Design

o , 8440/8450/8460 (CUT-TO-FIT) Box of 10
. ,f" i

» Urostomy Pouch Includes 1 adapter
> Anti-Reflux Valve
> Flextend (extended wear) Skin Barrier
» With Tape Border
> With ComfortWear Panels
- Transparent and Ultra Clear — Body Side Only
- Beige — Both Sides

HCPCS: A4428

Ultra-Clear  Transparent Beige
Stock No Stock No Stock No For StomasUp To  Pouch Length

8450 8460 8440 2-1/2" (64 mm) 9" (23 cm)

The upgraded Hollister urostomy pouch is available

in the Premier one-piece pouching system

The upgraded pouch features several innovations designed to deliver more
comfort and a greater sense of control (as compared to previous design):

- Skin barrier options to create custom solutions for your patients’
unique needs

> Flat or convex
> Tape border
> Flextend (extended wear) skin barrier

- Enhanced flow-control tap is made with soft material and a
streamlined shape

- Multi-chamber design helps to facilitate even distribution of urine
- Improved adapter helps facilitate ease of use
- Belt tab option (convex)

Hollister Incorporated 1.800.323.4060



Premier One-Piece Pouching System

Urostomy Pouches with Flat Barriers (continued)

esign Recommended replacement for 844x/846x series below

8449x/8469x (PRE-SIZED) Box of 10

» Urostomy Pouch Includes 2 adapters

> Anti-Reflux Valve

> Flextend (extended wear) Skin Barrier

> With Tape Border

» With ComfortWear Panels

- Transparent — Body Side Only
- Beige — Both Sides

Upgraded Design Features:

» Multi-Chamber Design

» Softer, Streamlined Tap

HCPCS: A4428
Transparent Beige
Stock No Stock No Barrier Opening Pouch Length

— 84497 3/4" (19 mm) 9" (23 cm)

84692 — 1" (25 mm) 9" (23 cm)
84698 84498 1-1/4" (32 mm) 9" (23 cm)
84693 — 1-1/2" (38 mm) 9" (23 cm)
84699 84499 1-3/4" (44 mm) 9" (23 cm)
84694 84494 2" (51 mm) 9" (23 cm)

Original Design

844x/846X (PRE-SIZED)

Box of 10

! .‘? \ » Urostomy Pouch Includes 1 adapter
4 .
k) > Anti-Reflux Valve
“-g";r’ : > Flextend (extended wear) Skin Barrier
: , » With Tape Border
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides
HCPCS: A4428
Transparent Beige
Stock No Stock No Barrier Opening Pouch Length
8467 8447 3/4" (19 mm) 9" (23 cm)
8462 8442 1" (25 mm) 9" (23 cm)
8468 8448 1-1/4" (32 mm) 9" (23 cm)
8463 8443 1-1/2" (38 mm) 9" (23 cm)
8469 8449 1-3/4" (44 mm) 9" (23 cm)
8464 — 2" (51 mm) 9" (23 cm)

www.hollister.com
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http://www.hollister.com

Ceramide Infused
Products

Ostomy Care

Ostomy Care
New Image Two-Piece
Pouching System

One-Piece
System

Ostomy Care

&

Tube Continence Ostomy Care
Wound Care o Bowel Care 0 ogtﬁkoTc{eg;:gs Pouchkins Pediatric
asteners are V Pouching System

Education

Premier One-Piece Pouching System

Urostomy Pouches with Convex Barriers

esign Recommended replacement for 847x/843x series below

8479xxx/8439xxx (CUT-TO-FIT) Box of 5
» Urostomy Pouch Includes 1 adapter

> Anti-Reflux Valve
> Flextend (extended wear) Skin Barrier < cowex
» With Tape Border
> With Belt Tabs
» With ComfortWear Panels
- Ultra-Clear — Body Side Only
- Beige — Both Sides

Upgraded Design Features:
» Multi-Chamber Design
» Softer, Streamlined Tap

HCPCS: A4430

Ultra-Clear Beige For Stomas Pouch
Stock No Stock No Up To Length
84794 — 1" (25 mm) 9" (23 cm)
84798 — 1-1/2" (38 mm) 9" (23 cm)
8479111 8439111 2" (51 mm) 9" (23 cm)
Original Design
o 847x/843x (CUT-TO-FIT) Box of 5
| | ’ » Urostomy Pouch Includes 1 adapter
&% ) > Anti-Reflux Valve
- > Flextend (extended wear) Skin Barrier (CONVEX

) » With Tape Border
pe—— » With Belt Tabs
» With ComfortWear Panels
- Transparent — Bodly Side Only
- Beige — Both Sides

HCPCS: A4430

Transparent Beige

Stock No Stock No For Stomas Up To Pouch Length
8474 8434 1" (25 mm) 9" (23cm)
8478 8438 1-1/2" (38 mm) 9" (23 cm)
84711 84311 2" (51 mm) 9" (23 cm)

2 DID YOU KNOW...

e eaving urine in the urostomy pouch before connecting to a bedside
collector/leg bag may minimize the suction effect and allow urine to
drain better into the collection system

Hollister Incorporated 1.800.323.4060



==
Premier One-Piece Pouching System ==
2 D

. . : ZF20

Urostomy Pouches with Convex Barriers (continued) 85
Design Recommended replacement for 848x/849x series below o § =

S S

8489x/8499x (PRE-SIZED) Box of 5 =¥ =

» Urostomy Pouch Includes 1 adapter e <

> Anti-Reflux Valve ( % 5 S

> Flextend (extended wear) Skin Barrier CONVEX S

» With Tape Border

> With Belt Tabs

> With ComfortiWear Panels
- Ultra-Clear — Body Side Only
- Beige — Both Sides

Upgraded Design Features:
> Multi-Chamber Design
» Softer, Streamlined Tap

HCPCS: A4430

walshg Buiyanod
99914-0UQ Jolwald
aren AwoisQ

e
Ultra Clear Beige S e g
Stock No Stock No Barrier Opening Pouch Length S = g
84890 — 1/2" (13 mm) 9" (23 cm) ook
84891 84991 5/8" (16 mm) 9" (23 cm) 289
84892 84992 3/4" (19 mm) 9" (23 cm) gE3
84893 84993 7/8" (22 mm) 9" (23 cm) &
84894 84994 1" (25 mm) 9" (23 cm)
84895 84995 1-1/8" (29 mm) 9" (23 cm)
84896 84996 1-1/4" (32 mm) 9" (23 cm) o
84897 84997 1-3/8" (35 mm) 9" (23 ¢m) ga
84898 84998 1-1/2" (38 mm) 9" (23 cm) = g
84899 84999 1-3/4" (44 mm) 9" (23 cm) a2
@
@ O
S 8
e . @ D
Original Design @
848x/849x (PRE-SIZED) Box of 5
» Urostomy Pouch Includes 1 adapter

Nl
) > Anti-Reflux Valve
k‘—.' ' > Flextend (extended wear) Skin Barrier CCONVEX
) » With Tape Border
e > With Belt Tabs
> With ComfortiWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

aleq
92UBUNU0Y

@

HCPCS: A4430 E

. @

Transparent Beige —
Stock No Stock No Barrier Opening Pouch Length g
8480 — 1/2" (13 mm) 9" (23 cm) @
8481 8491 5/8" (16 mm) 9" (23 cm)
8482 8492 3/4" (19 mm) 9" (23 cm)
8483 8493 7/8" (22 mm) 9" (23 cm)
8484 8494 1" (25 mm) 9" (23 cm) =
8485 8495 1-1/8" (29 mm) 9" (23 cm) -
8486 8496 1-1/4" (32 mm) 9" (23 cm) & c
8487 8497 1-3/8" (35 mm) 9" (23 cm) S g
8488 8498 1-1/2" (38 mm) 9" (23 cm) =
8489 8499 1-3/4" (44 mm) 9" (23 cm) @
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Ceramide Infused
Products

Ostomy Care

Ostomy Care
New Image Two-Piece
Pouching System

Ostomy Care
One-Piece
System

Premier

Tube Continence Ostomy Care
Wound Care o Bowel Care 0 OgﬁfnoTC{eE;';gs Pouchkins Pediatric
asteners are V Pouching System

Education

Premier One-Piece Pouching System

Urostomy Pouches with GeraPlus Soft Convex Barriers

Upg Design

. 8413xx (CUT-TO-FIT)
> Urostomy Pouch
> Anti-Reflux Valve

Box of 5

includes 1 adapter

SOFT
> CeraPlus (extended wear) Skin Barrier CONVEX
> With Tape Border
> With Belt Tabs A3
> With ComfortWear Panels — Body Side Only
Upgraded Design Features:
> Multi-Chamber Design
» Softer, Streamlined Tap
> Drain Valve Indicator
HCPCS: A4430

Ultra Clear Stock No For Stomas Up To Pouch Length
84134 1” (25 mm) 9” (23 cm)
84138 1-1/2” (38 mm) 9” (23 cm)
841311 2-1/8” (55 mm) 9” (23 cm)
Design
841X (PRE-SIZED) Box of 5
> Urostomy Pouch includes 1 adapter
> Anti-Reflux Valve SOFT
> CeraPlus (extended wear) Skin Barrier CONVEX

> With Tape Border
> With Belt Tabs

> With Comfort\/ear Panels — Body Side Only

Upgraded Design Features:
> Multi-Chamber Design

> Softer, Streamlined Tap

> Drain Valve Indicator

HCPCS: A4430

Beige w/Viewing Option

Stock No Barrier Opening Pouch Length
8412 3/4” (19 mm) 9" (23 cm)
8413 7/8” (22 mm) 9" (23 cm)
8414 17 (25 mm) 9" (23 cm)
8415 1-1/8" (29 mm) 9" (23 cm)

Hollister Incorporated

1.800.323.4060



Premier One-Piece Pouching System

Non Sterile Kits — Drainable

89001 (CUT-TO-FIT) Box of 5 Kits
Colostomy/lleostomy Kit Includes:
| > (1) 88401 SoftFlex (standard wear) Skin Barrier
/ > Without Tape Border
» Without Integrated Filter
> Lock 'n Roll Microseal Closure
» Single-Use Package

HCPCS: A5061
Ultra-Clear

Stock No For Stomas Up To Pouch Length
89001 2-1/2" (64 mm) 12" (30 cm)
89002 (CUT-TO-FIT) Box of 5 Kits
Colostomy/lleostomy Kit Includes: 1 clamp per kit
> (1) 88501 SoftFlex (standard wear) Skin Barrier
/ / > Without Tape Border
£ Without Integrated Fiter

» Clamp Closure
» Single-Use Package

HCPCS: A5061
Ultra-Clear

Stock No For Stomas Up To Pouch Length
89002 2-1/2" (64 mm) 12" (30 cm)
- 89003 (CUT-TO-FIT) Box of 5 Kits
' Colostomy/lleostomy Kit Includes: 1 clamp per kit

= > (1) 8651 Flextend (extended wear) Skin Barrier

» With Tape Border
> Without Integrated Filter
<. » Clamp Closure
» Single-Use Package
HCPCS: A4388
Ultra-Clear

Stock No For Stomas Up To Pouch Length
89003 2-1/2" (64 mm) 12" (30 cm)
= 89004 (CUT-TO-FIT) Box of 5 Kits
@ | Colostomy/lleostomy Kit Includes:
I = > (1) 8531 Flextend (extended wear) Skin Barrier

» With Tape Border

» Without Integrated Filter

> Lock 'n Roll Microseal Closure
T » Single-Use Package

HCPCS: A4388

Ultra-Clear
Stock No For Stomas Up To Pouch Length

89004 2-1/2" (64 mm) 12" (30 cm)

Non Sterile Kits — Urostomy

89005 (CUT-TO-FIT) Box of 5 Kits
Urostomy Kit Includes: 1 adapter per kit
> (1) 8450 Flextend (extended wear) Skin Barrier

» With Tape Border

» (1) 7331 Urostomy Drain Tube Adapter

» Single-Use Package

HCPCS: A4428

Ultra-Clear
Stock No For Stomas Up To Pouch Length

89005 2-1/2" (64 mm) 9" (23 cm)



http://www.hollister.com

wayshg Buiyonod
8081d-8uQ Jallald
alen Awolso




Ostomy Care Ostomy Care Ostomy Care Ostom Continence T
ube :
Ceramide Infused New Image Two-Piece  Premier One-Piece Pouchkins owww@ﬂommmmﬂmm Bowel Care Fast Wound Care Education
Products Pouching System Pouching System Pouching Sy BREEE

| -
O
Y
-
(4]
(/)]
n
(O]
(&
()
C
2
[
Y
o
-]
(&
()
(7))
<

preventing leakage and
providing patient comfort

Pouchkins

Pediatric Pouching System
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Pouchkins Pediatric Pouching System

Premie Pouch

3777 (CUT-TO-FIT) Box of 15
O ~» Use as a Premie Closed or Drainable Pouch
- » SoftFlex (standard wear) Skin Barrier — Flat
;\ » Without Tape Border
» Without Starter Hole
> Without Integrated Filter
» Soft Wire Closure (if drain opening is desired)
HCPCS: A5052 + A4362
Ultra-Clear
Stock No For Stomas Up To Pouch Length
3777 5/8" (15 mm) 4-1/2" (11,5 cm)

Newborn Pouch

: il 3778 (CUT-TO-FIT) Box of 15
‘ > Newborn Pouch; Use With or Without the Drain Valve
— ~ > SoftFlex (standard wear) Skin Barrier — Flat
» Without Tape Border
> Without Integrated Filter
» Soft Wire Closure (if larger drain opening is desired)

" HCPCS: A5062 + A4362

I

Ultra-Clear
Stock No For Stomas Up To Pouch Length
3778 1-3/8" x 7/8" (35 mm x 22 mm) 6-1/2" (16 cm)

One-Piece Pouches

( 3796 (CUT-TO-FIT) Box of 10
f » Drainable Pouch
\/ » SoftFlex (standard wear) Skin Barrier — Flat

> Without Starter Hole
— » Without Tape Border
> Without Integrated Filter
> Lock 'n Roll Microseal Closure
» With Comfort\Wear Panels — Body Side Only

HCPCS: A5061

Transparent
Stock No For Stomas Up To Pouch Length
3796 1-1/2" (38 mm) 6-1/2" (16 cm)

www.hollister.com Hollister Incorporated
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http://www.hollister.com

Ceramide Infused
Products

Ostomy Care Ostomy Care
New Image Two-Piece
Pouching System

Ostomy Care
Premier One-Piece
Pouching System

Pediatric
ng System

Ostomy Care

Pol
P

Tube Continence
Wound Care Bowel Care Ostomy Care
Fasteners Care Ostomy Accessories

Education

Pouchkins Pediatric Pouching System

One-Piece Pouches (continued)

e 3795 (CUT-TO-FIT) Box of 10
) » Drainable Pouch

» SoftFlex (standard wear) Skin Barrier — Flat

» Without Starter Hole

» Without Tape Border

> With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

» With Comfort\Wear Panels — Body Side Only

HCPCS: A4424

Transparent

Stock No For Stomas Up To Pouch Length

3795 2" (51 mm) 7" (18 cm)
3797 (CUT-TO-FIT) Box of 10
» Urostomy Pouch Includes 1 adapter

> Anti-Reflux Valve

> SoftFlex (standard wear) Skin Barrier — Flat
Sl » Without Starter Hole

» Without Tape Border

» With ComfortWear Panels — Body Side Only

HCPCS: A5071

Transparent
Stock No For Stomas Up To Pouch Length
3797 1-1/2" (38 mm) 8-3/4" (22 cm)

DID YOU KNOW...

Pouchkins SoftFlex skin barrier

 Designed to be gentle

o No starter hole, which enables the opening to be
placed where needed within the cutting guide

o No tape by design

e Flexible and sized for babies and children

* None of the Pouchkins pediatric pouching systems
are made with natural rubber latex

o Any 1-3/4" New Image pouch will fit this skin barrier

Hollister Incorporated 1.800.323.4060



Pouchkins Pediatric Pouching System

Two-Piece Skin Barrier

3761 (CUT-TO-FIT) Box of 5
» SoftFlex (standard wear) Skin Barrier — Flat

» Without Starter Hole

» Without Tape Border

HCPCS: Ad414

Transparent
Stock No Flange Size For Stomas Up To
3761 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
Two-Piece Pouches
) 3799 Box of 10
w » Drainable Pouch
&5 > Without Integrated Filter
> Lock 'n Roll Microseal Closure
= > With Belt Tabs
» With ComfortiWear Panel — Body Side Only
HCPCS: A5063
Transparent
Stock No Flange Size Pouch Length
3799 @ 1-3/4" (44 mm) 6-1/2" (16 cm)
18292/18282 Box of 20

» Drainable Pouch

» With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

> With Belt Tabs

» With Comfort\Wear Panel
- Transparent — Bodly Side Only
- Beige — Both Sides

HCPCS: A4425

Transparent Beige Pouch
Stock No Stock No Flange Size Length
18292 18282 @ 1-3/4" (44 mm) 7" (18 cm)

18382/18392 Box of 60

> Closed Mini-Pouch

» With Integrated AF300 Filter

> With Belt Tabs

> With ComfortiWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4419

Transparent Beige Pouch
Stock No Stock No Flange Size Length
18382 18392 @& 1-3/4" (44 mm) 7" (18 cm)

www.hollister.com

Hollister Incorporated
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Ostomy Care
Ceramide Infused
Products

Ostomy Care
New Image Two-Piece
Pouching System

Ostomy Care
Premier One-Piece
Pouching System

System

Ostomy Care
Pouchkins Pediatric

a

Tube Continence
Wound Care Bowel Care Ostomy Care
Fasteners Care Ostomy Accessories

Education

Pouchkins Pediatric Pouching System

Two-Piece Pouches (continued)

Upgraded Design Recommended replacement for 1840x/1841x/1842xx

series below
1890x/1891x/1892x Box of 10
» Urostomy Pouch Includes 2 adapters

» Anti-Reflux Valve
» With Belt Tabs
» With Comfort\Wear Panels
- Transparent and Ultra-Clear — Body Side Only

- - Beige — Both Sides
Upgraded Design Features:
» Multi-Chamber Design
» Softer, Streamlined Tap
» Drain Valve Indicator
HCPCS: A4432
Ultra-Clear Transparent  Beige Flange Pouch
Stock No Stock No  Stock No Size Length
18922 18902 18912 @ 1-3/4" (44 mm) 9" (23 cm)
Original Design
18402/18412/18422 Box of 10
» Urostomy Pouch Includes 1 adapter
> Anti-Reflux Valve
> With Belt Tabs
-— » With Comfort\Wear Panels
) - Transparent and Ultra-Clear — Body Side Only
- Beige — Both Sides
HCPCS: A4432
Ultra-Clear Transparent  Beige Flange Pouch
Stock No Stock No  Stock No Size Length
18422 18402 18412 @ 1-3/4" (44 mm) 9" (23 cm)
Pediatric Ostomy Belt
\} 3774 Single Unit
| ) » Ostomy Belt
. - White Color
HCPCS: A4367
Stock No Length
3774 10"-17" (25 cm-43 cm)

? DID YOU KNOW...

Shadow Buddies dolls

o Exclusive to Hollister, Shadow Buddies
dolls are special friends for children who
have had or will have ostomy surgery

e Great teaching tool to help with education
and care giving

® Huggable dolls with heart-shaped eyes and
a stoma provide comfort and support

To order, refer to Shadow Buddies information

in the Ostomy Education Resources section.

Shadow Buddies is a trademark of The Shadow Buddies Foundation

Hollister Incorporated 1.800.323.4060
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Ostomy Care

Ostomy Accessories

Why use an ostomy
accessory?

Ostomy accessories can be used together
with your pouching system. You may use
one or more of these products. Here are

a few reasons why you might want to use
an ostomy accessory:

* [t may help the performance of your
pouching system. For example, an
accessory could help increase wear time,
protect your skin, or make the removal
of your adhesive easier

* [t may help solve a problem such as
leakage or skin irritation

* [t may help improve the quality of your
life by eliminating odor



Count on the Right Fit With

Adapt Barrier Rings

Hollister understands that no two people or
stomas are alike — and that barrier rings can play a critical role in

helping ensure the best outcome for your patients

Whether you choose flat or convex, slim or regular, round or oval—
Adapt barrier rings:

* Are designed to be stretched or shaped

® Help prevent ostomy output from getting under the pouch seal,

which may reduce leakage and skin irritation

e Can be cut or stacked together to improve the fit of the

pouching system

* Are alcohol free, so there is no sting from alcohol when applied to

broken or irritated skin

Talk to your Hollister ostomy representative about the full line of

Adapt barrier rings, now available with and without ceramide.

% Hollister

sjonpoid
pasnju| apiwesa)
aren AwoysQ

walshg Buyonod
90314-0Mm| abew| maN
aren Awojso

walshg Buyonod
809]d-8UQ Jolwalg
aren Awojso

walshg Buyonod
OLeIPad SuMyonod
aren Awojso

o
L
S
2
>
[+
o
@
@
&5
S
=3
@

SJaUa)Sed alen
aqny QIE) [omog oousupuoy | 9Jed Awoisp

2189 puno

uoneanp3




Ostomy Care Ostomy Care
New Image Two-Piece Ceramide Infused
Pouching System Products

Tube Continence Ostomy Care Ostomy Care
Wound Care o Bowel Care 0 O?SE?T% eg;rrgs Pouchkins Pediatric  Premier One-Piece
asteners are V Pouching System Pouching System

Education

Ostomy Accessories
Adapt Skin Barrier Rings
88xx Box of 10
o > CeraRing Barrier Rings (Flat)
> Flextend M (extended wear) with Ceramide
HCPCS: A4385
Stock No Outer Diameter Thickness
8805 2" (48 mm) 4.5 mm
8815 2" (48 mm) 2.3 mmEND
78xx Box of 10
. © > Barrier Rings (Flay
> Flextend M (extended wear)
HCPCS: A4385
Stock No Outer Diameter Thickness
7805 2" (48 mm) 4.5 mm
7815 2" (48 mm) 2.3 mmEND
7806 4" (98 mm) 2.3 mmEND
o o 895xx Box of 10
° > CeraRing Convex Barrier Rings (C ONVEX

> Flextend (extended wear) with Ceramide
HCPCS: A4411

Stock No Inner Diameter
89520 13/16" (20 mm) — can be stretched to 1" (25 mm)
89530 1-3/16" (30 mm) — can be stretched to 1-3/8" (35 mm)
89540 1-9/16" (40 mm) — can be stretched to 1-3/4" (45 mm)
o g 795xx Box of 10
et > Convex Barrier Rings

°_, > Flextend (extended wear) CCONVEX

HCPCS: A4411

Stock No Inner Diameter
79520 13/16" (20 mm) — can be stretched to 1" (25 mm)
79530 1-3/16" (30 mm) — can be stretched to 1-3/8" (35 mm)
79540 1-9/16" (40 mm) — can be stretched to 1-3/4" (45 mm)

o 896XX Box of 10

> CeraRing Oval Convex Barrier Rings
O Fextend (extended wear) with Ceramide (CONVEX

HCPCS: A4411

Stock No Inner Diameter
89601 7/8" x 1-1/2" (22 mm x 38 mm)

— can be stretched to 1-1/8" x 1-3/4" (27 mm x 43 mm)
89602 1-3/16" x 1-7/8" (30 mm x 48 mm)

— can be stretched to 1-3/8" x 2-1/8" (35 mm x 53 mm)
89603 1-1/2" x 2-3/16" (38 mm x 56 mm)

— can be stretched to 1-3/4" x 2-3/8" (43 mm x 61 mm)

o 796xx Box of 10
o > Oval Convex Barrier Rings ( CONVEX

o > Flextend (extended wear)

HCPCS: A4411
Stock No Inner Diameter
79601 7/8" x 1-1/2" (22 mm x 38 mm)
— can be stretched to 1-1/8" x 1-3/4" (27 mm x 43 mm)
79602 1-3/16" x 1-7/8" (30 mm x 48 mm)
— can be stretched to 1-3/8" x 2-1/8" (35 mm x 53 mm)
79603 1-1/2" x 2-3/16" (38 mm x 56 mm

)
— can be stretched to 1-3/4" x 2-3/8" (43 mm x 61 mm)

Hollister Incorporated 1.800.323.4060



A Sense of Security

Means Everything

Adapt barrier extenders
Three strips create a

X custom frame around
At Hollister Ostomy Care, we know ) )
your skin barrier.

a sense of security and leakage

prevention are top priorities for you.

Our Adapt barrier extenders offer an additional layer of protection
for those concerned about lifting around the edges of their

skin barrier. With a thin and flexible hydrocolloid formulation,
Adapt barrier extenders conform easily to body contours. Three
convenient strips make it easy to create a custom frame around
the skin barrier. The end result is enhanced security, when it

matters most.

% Hollister
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Tube Continence Ostomy Care Ostomy Care Ostomy Care Ostomy Care
Fast Bowel Care C O(s);:?Tc{e(s:g;gs Pouchkins Pediatric Premier One-Piece  New Image Two-Piece Ceramide Infused
asteners are y Pouching System Pouching System Pouching System Products

Wound Care

Education

Ostomy Accessories
Adapt Skin Barrier Strips
79400 Box of 10
» Skin Barrier Strips
\ > Flextend (extended wear)
HCPCS: A4385
Stock No Size Length
79400 609 5-1/8" (13 cm)
Adapt Barrier Extenders
79402 Box of 30
» Barrier Extenders
» Hydrocolloid Formulation
HCPCS: A4362*
Stock No
79402
* 3 extenders = 1 unit, Box of 30 = 10 billable units
Adapt Skin Barrier Paste
i 79300/79301
-m » Non-Adhesive
HCPCS: A4406
Stock No Description Quantity
79300 2.1 0z (60 g) tube Box of 1
79301 0.50z (14 g) tube Box of 20
Adapt Stoma Powder
= 7906 Box of 1
E
& HCPCS: A4371
Stock No Description
7906 10z (28.3 g) puff bottle
Adapt Odor Eliminator and Lubricant
[ 78500/78501
= % HCPCS Code: A4394
Stock No Description Quantity
78500 8 0z (236 mL) bottle Box of 1
78501 0.27 0z (8 mL) packet 50 Packets/Box
Adapt Ostomy Belts
A 7300/7299 Box of 10
“\ HCPCS: A4367
Beige
Stock No Size
7300 23"-43" (58 cm-109 cm) Medium
7299 34"-65" (86 cm-165 cm) Large

Hollister Incorporated

1.800.323.4060



Ostomy Accessories

Adapt Skin Prepping Product

7917 1 Box
> Skin Protective Wipes 50 Wipes Each
> Non-Adhesive
> Alcohol Free NO STING
HCPCS: A5120

Stock No

7917

*Not recommended for use with extended wear skin barriers, as it may decrease wear time

Adapt Adhesives and Removers

e 7760 1Box
— > Universal Remover Wipes 50 Wipes Each
— > For Adhesives and Barriers
= » Silicone Based
> Alcohol Free
HCPCS: A4456
Stock No
7760
7737 Box of 1
> Medical Adhesive Remover
» Silicone Based NO STING

> Alcohol Free
HCPCS: A4455

Stock No Description
7737 1.7 0z (50 mL) 360 degree spray can
7730 Box of 1
- > Medical Adhesive
@ » Improves Adhesive Contact Between Skin and Barrier
4 HCPCS: A4364
Stock No Description
7730 3.2 0z (90 g) spray can

Flextend (extended wear) Skin Barrier

8800
8801

HCPCS for 8800: A4385
HCPCS for 8801: A5122

Stock No Size
8800 4x4" (10 cmx 10 cm) Box of 5
8801 8x 8" (20 cm x 20 cm) Box of 3

www.hollister.com

Hollister Incorporated
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Tube Continence Ostomy Care Ostomy Care Ostomy Care Ostomy Care
Fast Bowel Care C OOtS:?,II\ly Ca';? Pouchkins Pediatric Premier One-Piece New Image Two-Piece Ceramide Infused
asteners are BB/ Pouching System Pouching System Pouching System Products

Wound Care

Education

Ostomy Accessories

Odor Eliminators

773x
E » m9 Odor Eliminator Spray
LE HCPCS: No Code
Stock No (unscented) Description Quantity
7732 2 0z (60 mL) pump spray Box of 12
7733 8 0z (240 mL) pump spray Box of 6
(Green Apple
Stock No Scented)  Description Quantity
7734 2 0z (60 mL) pump spray Box of 12
7735 8 0z (240 mL) pump spray Box of 6
771X
@ > m9 Odor Eliminator Drops
— HCPCS: A4394
Stock No Description Quantity
7715 1 0z (30 mL) bottle Box of 12
7717 8 0z (240 mL) bottle Box of 6

Cleaner/Decrystallizer

7736 Box of 12
» m9 Cleaner/Decrystallizer

> Cleans Urinary Drainage Systems

> pH Balanced and Non-Acidic

> Free Wash Bottle Included

HCPCS: A5131
Stock No Description
7736 16 0z (480 mL) hottle

Drainable Pouch Clamp

‘ 8770 Box of 20
HCPCS: A4363

Stock No Color
8770 Beige

Urostomy Drain Tube Adapter

7331 Box of 10
— HCPCS: A4421
Stock No
7331

Hollister Universal Catheter Access Port

9779 Box of 8
‘ ‘ » Graduated nipple and punch allows introduction
of catheter or drain through pouch
> Sterile
Stock No
9779

Hollister Incorporated 1.800.323.4060
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Ostomy Accessories o § S
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Other Accessories 83
Loop Ostomy Bridge s § o
7767 Box of 20 s3g
S > Sterile 253
HCPCS: Ad421 238
Stock No =g
7767
33 g
Bedside Drainage Collection System with Anti-Reflux Valve 538
— 2 o3
9839 Box of 20 28=
» Sample Port 208
» Sterile Fluid Pathway S8 @
HCPCS: A4357
Stock No Description ) g o
9839 68 0z (2000 mL) Capacity § :;3 g’
223
Skin Barrier Pastes and Powders gs g
7910 Box of 12 -
D » Karaya 5 Paste
g o
HCPCS: A4405 g (7}
Stock No Description = S
7910 4.5 0z (135 mL) tube 2'S
I
5
7905 Box of 12
> Karaya 5 Powder
HCPCS: A4371 g
=
Stock No Description S =
7905 2.5 0z (75 mL) puff bottle & g
D

Skin Barriers

7800 Box of 5

w
> Premium (standard wear) Skin Barrier g
HCPCS: A4362 =
Stock No Size -]
7800 4x4" (10 cmx 10 cm)
7700 Box of 5

> HolliHesive (standard wear) Skin Barrier
HCPCS: A4362

slauajsed
agnL

Stock No Size
7700 4x4" (10 cm x 10 cm)
Replacement Filters §
=
O% 7766 Box of 5 Packs =
00O » For use with 366x, 383x and 389x S
> 1 pack contains 20 Filters and 2 Plugs @
HCPCS: A4368
Stock No
7766 m
(=
Q
=
=
=

www.hollister.com Hollister Incorporated
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Tube Continence Ostomy Care Ostomy Care Ostomy Care Ostomy Care Ostomy Care
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asteners are y Pouching System Pouching System Pouching System Products

Wound Care

Education

Irrigation Products

General Information

» Similar to an enema with the water being placed into the stoma.

> Routine irrigation is recommended to be done on doctor’s orders (to
regulate emptying the bowel at a scheduled time).

» Appropriate for some people with sigmoid or descending colostomies.

> Not appropriate for people with urostomy or ileostomy.

> Allow approximately one hour for irrigation procedure.

@&‘ 721 Box of 1
! ) > Cone Irrigator Kit Includes:
E > (1) Irrigator

> (1) Stoma Cone with Connector
> (1) Cleaning Brush

HCPCS: A4398 + A4399

Stock No

7721

w 7723 Box of 10
» Stoma Cone with Connector
> Replacement Unit
HCPCS: A4399

Stock No

7723

(e 1460x (CUT-TO-FIT) Box of 5
= > Flextend (extended wear) Skin Barrier

» With Tape Border

HCPCS: A4409
Stock No Flange Size For Stomas Up To
14602 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
14603 @ 2-1/4" 57 mm) 1-3/4" (44 mm)
14604 @ 2-3/4" 70 mm) 2-1/4" (57 mm))
— 1815x Box of 5

> Drainable Irrigator Sleeve to be used
with New Image Two-Piece System

> With Belt Tabs

> Includes Clamp

P~

Transparent

Stock No Flange Size Sleeve Length
18152 @ 1-3/4" (44 mm) 30" (76 cm)
18153 @ 2-1/4" 57 mm) 30" (76 cm)
18154 @ 2-3/4" 70 mm) 30" (76 cm)

Hollister Incorporated 1.800.323.4060



Irrigation Products

7728/7724 Box of 20
> |rrigator Sleeve with Belt Tabs
> Includes Clamp

HCPCS: A4397

Stock No Opening Size Sleeve Length
7728 2" (51 mm) 22" (56 cm)
7724 3" (76 mm) 22" (56 cm)

318x (PRE-SIZED) Box of 30

» Stoma Cap, Tape Adhesive, Integrated Filter,
Odor-Barrier Film, Without ComfortWear Panels

HCPCS: A5055

Beige
Stock No Opening Size
3184 2" (51 mm) 4-1/4" (11 cm)
3186 3" (76 mm) 4-1/4" (11 cm)
7300/7299 Box of 10
/ > Ostomy Belts
ve HCPCS: A4367
Beige
Stock No Size
7300 23"-43" (58 cm-109 cm) Medium
7299 34"-65" (86 cm-165 cm) Large

-

Stock No

7740 Box of 10
» Adapt Stoma Lubricant
» For Use with Stoma Irrigator
HCPCS: A4402
Description

7740

4 0z (120 mL) bottle

www.hollister.com

Hollister Incorporated
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Upgrade to the New Image
Two-Piece Pouching System!

Ostomy Care
New Image Two-Piece
Pouching System

Ostomy Care
Premier One-Piece
Pouching System

CenterPointLock
Two-Piece Pouching System

Ostomy Care
Pouchkins Pediatric
Pouching System

At Hollister, we are dedicated to providing a
choice of quality, differentiated products, with
features that meet the individual needs of
clinicians and patients.

Please be advised that the CenterPointLock
two-piece pouching system will be
discontinued effective December 31, 2018.

Ostomy Care
Ostomy Accessories

Continence
Care

The CenterPointLock two-piece ostomy
system was developed and launched over
three decades ago. Since then, our products
have undergone advancements for the benefit
of our customers, including improvements in
both skin barrier and pouching technology.

Bowel Care

We are encouraging people who are using the
CenterPointLock two-piece ostomy system to
upgrade to the New Image two-piece system
so they can experience the security and quality
of the new generation Hollister two-piece

Tube
Fasteners

system!
g Click below to see conversion charts
(3]
=]
= Skin Barrier Conversion Pouch Conversion
(=)
=
: 11
o
5 Hollister
o
=
=
w

Hollister Incorporated 1.800.323.4060
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Integrated Floating Flange

wialsAg Buiyanod
OUIeIpad SuaNOd
alen Awolso

e Audible clicks signal a secure attachment
e Discreet low profile attachment of pouch to barrier

CeraPlus Skin Barrier

$91108$899y AWO0ISO
aren AwojsQ

The CeraPlus skin barrier with Remois technology* is
infused with ceramide, the skin’s naturally occurring
protection against dryness. It is designed to maintain
adhesive properties, and features a formulation infused
with ceramide to help:

alen
99UBUIU0Y

e Protect the skin’s natural moisture barrier

e Maintain good peristomal skin health

e Decrease transepidermal water loss (TEWL) from dam-
aged or eroded skin

aJeq [amog

*Remois technology is a technology of Alcare Co., Ltd.

New Image Pouches

agnL

e \Waterproof, integrated AF300 filter is designed to allow
gas and air to escape, but keeps odor and output in the
pouch. Liquid cannot penetrate the filter, therefore does
not require a protective sticker

e Choice of secure pouch closure options — clamp or
integrated closure

¢ Comfortwear panels provide enhanced discretion and
comfort

e Numerous pouch size options to meet individual
preferences

SI9U9)SE
2129 puno\
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Tube Continence Ostomy Care Ostomy Care Ostomy Care Ostomy Care
Fast Bowel Care C OOISE?TV Cal;f: Pouchkins Pediatric Premier One-Piece New Image Two-Piece Ceramide Infused
asteners are BB/ Pouching System Pouching System Pouching System Products

Wound Care

Education

CenterPointLock Two-Piece Pouching System

Letter Matching System

To help you select compatible CenterPointLock two-piece system
components, every CenterPointLock system product box label features
a letter designation: ®, ©, @, ®, or ©. Once you've selected a
CenterPointLock two-piece system skin barrier, select a pouch, irrigator
drain, or stoma cap with a matching letter on the box label.

Flat Skin Barriers with Floating Flange

872x (CUT-TO-FIT)

Box of 5

> Flextend (extended wear) Skin Barrier, Tape Border

HCPCS: A4409
Stock No Letter Match Flange Size For Stomas Up To
8727 ® 1-1/2" (38 mm) 1" (25 mm)
8722 0} 1-3/4" (44 mm) 1-1/4" (32 mm)
8723 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
8724 ® 2-3/4" (70 mm) 2-1/4" (57 mm)

875X (CUT-TO-FIT) Box of 5

> Flextend (extended wear) Skin Barrier,

Without Tape Border

HCPCS FOR 8752, 8753 & 8757: A4409

HCPCS FOR 8754: A4410
Stock No Letter Match Flange Size For Stomas Up To
8752 0) 1-3/4" (44 mm) 1-1/4" (32 mm)
8753 ) 2-1/4" (57 mm) 1-3/4" (44 mm)
8754 ® 2-3/4" (70 mm) 2-1/4" (57 mm)

372x (CUT-TO-FIT) Box of 5

> FlexWear (standard wear) Skin Barrier, Tape Border

HCPCS FOR 3722-3724 & 3727: A4414

HCPCS FOR 3726: A4415
Stock No Letter Match Flange Size For Stomas Up To
3727 ® 1-1/2" (38 mm) 1" (25 mm)
3722 0} 1-3/4" (44 mm) 1-1/4" (32 mm)
3723 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
3724 ® 2-3/4" (70 mm) 2-1/4" (57 mm)
3726 © 4" (102 mm) 3-1/2" (89 mm)

376X (CUT-TO-FIT) Box of 5

» SoftFlex (standard wear) Skin Barrier,

Without Tape Border

HCPCS FOR 3762, 3763 & 3767: A4414

HCPCS FOR 3764 & 3766: A4415
Stock No Letter Match Flange Size For Stomas Up To
3767 ® 1-1/2" (38 mm) 1" (25 mm)
3762 ® 1-3/4" (44 mm) 1-1/4" (32 mm)
3763 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
3764 ® 2-3/4" (70 mm) 2-1/4" (57 mm)
3766 © 4" (102 mm) 3-1/2" (89 mm)

Note: New Image and GenterPointLock

pouching systems are not interchangeable.

Hollister Incorporated

1.800.323.4060



CenterPointLock Two-Piece Pouching System

Flat Skin Barriers with Floating Flange (continued)
370x (CUT-TO-FIT) Box of 5
> HolliHesive (standard wear) Skin Barrier, Tape Border

HCPCS FOR 3702-3704 & 3707: Ad4414
HCPCS FOR 3706: A4415

Stock No Letter Match Flange Size For Stomas Up To
3707 ® 1-1/2" (38 mm) up to 3/4" (19 mm)
3702 [0 1-3/4" (44 mm) upto 1" (25 mm)
3703 ©) 2-1/4" (57 mm) up to 1-1/2" (38 mm)
3704 ® 2-3/4" (70 mm) upto 2" (51 mm)
3706 © 4" (102 mm) up to 3-1/4" (82 mm)
874x (PRE-SIZED) Box of 5
> Flextend (extended wear) Skin Barrier, Tape Border
HCPCS: A4409
Stock No Letter Match Flange Size Barrier Opening
8743 ® 1-1/2" (38 mm) 7/8" (22 mm)
8744 ® 1-1/2" (38 mm) 1" (25 mm)
8745 0} 1-3/4" (44 mm) 1-1/8" (29 mm)
8746 0] 1-3/4" (44 mm) 1-1/4" (32 mm)
8747 @ 2-1/4" (57 mm) 1-3/8" (35 mm)
8748 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
374X (PRE-SIZED) Box of 5

> FlexWear (standard wear) Skin Barrier, Tape Border
HCPCS: A4414

Stock No Letter Match Flange Size Barrier Opening
3747 ® 1-1/2" (38 mm) 3/4" (19 mm)
3742 ® 1-1/2" (38 mm) 1" (25 mm)
3748 0} 1-3/4" (44 mm) 1-1/4" (32 mm)
3743 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
3749 Q@ 2-1/4" (57 mm) 1-3/4" (44 mm)

Convex Skin Barriers with Floating Flange

877x (CUT-TO-FIT) Box of 5
> Flextend (extended wear) Skin Barrier, C
Convex, Tape Border CONVEX

HCPCS: A4407

Stock No Letter Match Flange Size Barrier Opening
8774 (0] 1-3/4" (44 mm) 1" (25 mm)
8778 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
87711 ® 2-3/4" (70 mm) 2" (51 mm)

873x (PRE-SIZED) Box of 5
> Flextend (extended wear) Skin Barrier,
Convex, Tape Border < convex

HCPCS: A4407

Stock No Letter Match Flange Size Barrier Opening
8731 ® 1-1/2" (38 mm) 5/8" (16 mm)
8732 ® 1-1/2" (38 mm) 3/4" (19 mm)
8733 0] 1-3/4" (44 mm) 7/8" (22 mm)
8734 0] 1-3/4" (44 mm) 1" (25 mm)
8735 Q 2-1/4" (57 mm) 1-1/8" (29 mm)
8736 Q@ 2-1/4" (57 mm) 1-1/4" (32 mm)
8737 @ 2-1/4" (57 mm) 1-3/8" (35 mm)
8738 Q@ 2-1/4" (57 mm) 1-1/2" (38 mm)

www.hollister.com Hollister Incorporated
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CenterPointLock Two-Piece Pouching System

Ceramide Infused
Products

Ostomy Care

Convex Skin Barriers with Floating Flange (continued)

373X (PRE-SIZED) Box of 5

L > FlexWear (standard wear) Skin Barrier,
SE5 Convex, Tape Border < convex
o @«
=3 HCPCS: A4373
g g % Stock No Letter Match Flange Size Barrier Opening
S8=3 3730 ® 1-1/2" (38 mm) 1/2" (13 mm
2 3731 ® 1-1/2" (38 mm) 5/8" (16 mm
3732 ® 1-1/2" (38 mm) 3/4" (19 mm
3733 0] 1-3/4" (44 mm) 7/8" (22 mm
© 8¢ 3734 10) 1-3/4" (44 mm) 1" (25 mm
S& g 3735 [©) 2-1/4" (57 mm) 1-1/8" (29 mm
=2 2 3736 @ 2-1/4" (57 mm) 1-1/4" (32 mm
= 3737 ) 2-1/4" (57 mm) 1-3/8" (35 mm
=] °§’ =] 3738 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
Zs3 3739 ® 2-3/4" (70 mm) 1-5/8" (41 mm
S 37310 ® 2-3/4" (70 mm) 1-3/4" (44 mm)
37311 ® 2-3/4" (70 mm) 2" (51 mm

Drainable Pouches

o 389x/383x Box of 10
» Drainable Pouch, Replaceable Filter,
Clamp Closure, Belt Tabs, Without Comforti//ear Panels.
Includes 1 Bag of 20 Hollister Replacement Filters and
2 Plugs, #7766

Ostomy Care
Pouchkins Pediatric
Pouching System

o 8
83 HCPCS: A4425 + A4368
=3 Transparent Beige Letter Flange Pouch
EZ Stock No Stock No Match Size Length
g S 3897 3837 ® 1-1/2" (38 mm) 12" (30 cm)
& 3892 3832 10} 1-3/4" (44 mm) 12" (30 cm)
3893 3833 @ 2-1/4" (57 mm) 12" (30 cm)
3894 3834 ® 2-3/4" (70 mm) 12" (30 cm)

881x Box of 10
» Drainable Pouch, Without Integrated Filter,
Clamp Closure, Belt Tabs, ComfortWear Panels — Both Sides

HCPCS: A5063

Continence
Care

Beige Letter Flange Pouch
o Stock No Match Size Length
] 8817 ® 1-1/2" (38 mm) 12" (30 cm)
= 8812 0} 1-3/4" (44 mm) 12" (30 cm)
[ 8813 @ 2-1/4" (57 mm) 12" (30 cm)
% 8814 ® 2-3/4" (70 mm) 12" (30 cm)
(=]

380x/381x Box of 10
» Drainable Pouch, Without Integrated Filter,
Clamp Closure, Belt Tabs, Without Comfort\//ear Panels

HCPCS: A5063

Tube
Fasteners

Transparent Beige Letter Flange Pouch
Stock No Stock No Match Size Length
3807 3817 ® 1-1/2" (38 mm) 11" (28 cm)
3802 3812 @ 1-3/4" (44 mm) 11" (28 cm)
3803 3813 Q@ 2-1/4" (57 mm) 11" (28 cm)

L 3804 3814 ® 2-3/4" (70 mm) 11" (28 cm)

S 3806 — © 4" (102 mm) 11" (28 cm)

=]

=

=3

=]

=

[—

2

©

o

=

=}

Ll
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CenterPointLock Two-Piece Pouching System

Drainable Pouches (continued)

387x Box of 10
» High Output Drainable Pouch, Without Integrated Filter,
Clamp Closure, Belt Tabs, Without Comfort\//ear Panels

HCPCS: A4412

Transparent Letter Flange Pouch
Stock No Match Size Length
3872 (0] 1-3/4" (44 mm) 16" (40 cm)
3873 @ 2-1/4" (57 mm) 16" (40 cm)
3874 ® 2-3/4" (70 mm) 16" (40 cm)

384x Box of 10

» Drainable Mini-Pouch, Without Integrated

Filter, Clamp Closure, Belt Tabs, Without Comfortl//ear Panels

HCPCS: A5063

Beige Letter Flange Pouch
Stock No Match Size Length
3847 ® 1-1/2" (38 mm) 9" (23 cm)
3842 0) 1-3/4" (44 mm) 9" (23 cm)
3843 () 2-1/4" (57 mm) 9" (23 cm)
3844 ® 2-3/4" (70 mm) 9" (23 cm)
Closed Pouches

834x Box of 15

» Closed Pouch, Integrated Filter, Odor-Barrier Rustle-Free Film,

Belt Tabs, ComfortWear Panels — Both Sides
HCPCS: A4419

Beige Letter Flange Pouch
Stock No Match Size Length
8347 ® 1-1/2" (38 mm) 7-1/2" (19 cm)
8342 (0] 1-3/4" (44 mm) 7-1/2" (19 cm)
8343 @ 2-1/4" (57 mm) 7-1/2" (19 cm)
8344 ® 2-3/4" (70 mm) 7-1/2" (19 cm)

334x Box of 15

» Closed Pouch, Integrated Filter, Belt Tabs,
Without ComfortiWear Panels

HCPCS: A4419

Beige Letter Flange Pouch
Stock No Match Size Length
3347 ® 1-1/2" (38 mm) 9" (23 cm)
3342 (0] 1-3/4" (44 mm) 9" (23 cm)
3343 @ 2-1/4" (57 mm) 9" (23 cm)
3344 ® 2-3/4" (70 mm) 9" (23 cm)

Urostomy Pouches

890x Box of 10
» Urostomy Pouch, Belt Tabs, ComfortWear Panels —
Both Sides

HCPCS: A4432

Beige Letter Flange Pouch
Stock No Match Size Length
8902 (0] 1-3/4" (44 mm) 9" (23 cm)
8903 @ 2-1/4" (57 mm) 9" (23 cm)

www.hollister.com

Hollister Incorporated
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Ostomy Care Ostomy Care
New Image Two-Piece Ceramide Infused
Pouching System Products

Tube Continence Ostomy Care Ostomy Care
Wound Care = Bowel Care 0 Ogi:?mc{ e(s;:)rrgs Pouchkins Pediatric  Premier One-Piece
asteners are ) Pouching System Pouching System

Education

CenterPointLock Two-Piece Pouching System

Urostomy Pouches (continued)

390x Box of 10
» Urostomy Pouch, Belt Tabs, Without ComfortWear Panels

HCPCS: A4432

=3 Transparent Letter Flange Pouch
Stock No Match Size Length
3907 ® 1-1/2" (38 mm) 9" (23 cm)
3902 (0] 1-3/4" (44 mm) 9" (23 cm)
3903 @ 2-1/4" (57 mm) 9" (23 cm)
3904 ® 2-3/4" (70 mm) 9" (23 cm)
Stoma Cap

340x Box of 25
» Stoma Cap, Integrated Filter, Without Comfort\/ear Panels

HCPCS: A5055

Beige Letter Flange Pouch
Stock No Match Size Length
3407 ® 1-1/2" (38 mm) 4-1/2" (11 cm)
3402 0} 1-3/4" (44 mm) 4-1/2" (11 cm)
3403 @ 2-1/4" (57 mm) 4-1/2" (11 cm)
3404 ® 2-3/4" (70 mm) 4-1/2" (11 cm)

Irrigator Sleeve

382x Box of 5
> |rrigator Sleeve, Belt Tabs
> Includes clamp

HCPCS: A4397

Transparent Letter Flange Pouch
Stock No Match Size Length
3827 ® 1-1/2" (38 mm) 30" (76 cm)
3822 0] 1-3/4" (44 mm) 30" (76 cm)
3823 ©) 2-1/4" (57 mm) 30" (76 cm)
3824 ® 2-3/4" (70 mm) 30" (76 cm)
3826 © 4" (102 mm) 30" (76 cm)

Hollister Incorporated 1.800.323.4060



Karaya 5 One-Piece Pouching System

Drainable Pouches

366X (PRE-SIZED)

Box of 10

» Drainable Pouch, Karaya 5 (standard wear)

Skin Barrier— Convex, Tape Border, Replaceable Filter, Pouch

Clamp Closure, Belt Tabs, Without Comfort\//ear Panels.
Includes 1 Bag of 20 Hollister Replacement Filters and

2 Plugs, #7766

HCPCS: A4389 + A4368

< cowex

Transparent Pouch Pouch
Stock No Size Barrier Opening Length
3662 1" (25 mm) 5/8" (16 mm) 12" (30 cm)
3668 1-1/4" (32 mm) 7/8" (22 mm) 12" (30 cm)
3663 1-1/2" (38 mm) 1-1/8" (29 mm) 12" (30 cm)
3669 1-3/4" (44 mm) 1-3/8" (35 mm) 12" (30 cm)
3664 2" (51 mm) 1-1/2" (38 mm) 12" (30 cm)
3665 2-1/2" (64 mm) 2" (51 mm) 12" (30 cm)

360X (PRE-SIZED) Box of 10

» Drainable Pouch, Karaya 5 (standard wear)

Skin Barrier— Convex, Tape Border, Without Integrated Filter,
Pouch Clamp Closure, Belt Tabs, Without ComfortWear Panels

HCPCS: A4389

< cowex

Transparent Pouch Pouch
Stock No Size Barrier Opening Length
3608 1-1/4" (32 mm) 7/8" (22 mm) 12" (30 cm)
3603 1-1/2" (38 mm) 1-1/8" (29 mm) 12" (30 cm)
3609 1-3/4" (44 mm) 1-3/8" (35 mm) 12" (30 cm)
3604 2" (51 mm) 1- 1/2" (38 mm) 12" (30 cm)
3605 2-1/2" (64 mm) 2" (51 mm) 12" (30 cm)
3606 3" (76 mm) 2-1/2" (64 mm) 12" (30 cm)

323X (PRE-SIZED) Box of 30

» Drainable Mini-Pouch, Karaya 5 (standard wear)

Skin Barrier— Convex, Tape Border, Without Integrated Filter,
Pouch Clamp Closure, Belt Tabs, Without ComfortWear Panels

HCPCS: A4389

< cowex

Transparent Pouch Pouch
Stock No Size Barrier Opening Length
3232 1" (25 mm) 5/8" (16 mm) 9" (23 cm)
3238 1-1/4" (32 mm) 7/8" (22 mm) 9" (23cm)
3233 1-1/2" (38 mm) 1-1/8" (29 mm) 9" (23cm)
3239 1-3/4" (44 mm) 1-3/8" (35 mm) 9" (23 cm)
3234 2" (51 mm) 1-1/2" (38 mm) 9" (23 cm)

322x (PRE-SIZED) Box of 30

» Drainable Pouch, Karaya 5 (standard wear)

Skin Barrier— Convex, Tape Border, Without Integrated Filter,
Pouch Clamp Closure, Belt Tabs, Without ComfortWear Panels

HCPCS: A4389

< cowex

Transparent Pouch Pouch
Stock No Size Barrier Opening Length
3222 1" (25 mm) 5/8" (16 mm) 12" (30 cm)
3228 1-1/4" (32 mm) 7/8" (22 mm) 12" (30 cm)
3223 1-1/2" (38 mm) 1-1/8" (29 mm) 12" (30 cm)
3229 1-3/4" (44 mm) 1-3/8" (35 mm) 12" (30 cm)
3224 2" (51 mm) 1-1/2" (38 mm) 12" (30 cm)
3225 2-1/2" (64 mm) 2" (51 mm) 12" (30 cm)
3226 3" (76 mm) 2-1/2" (64 mm) 12" (30 cm)

www.hollister.com

Hollister Incorporated
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Ostomy Care Ostomy Care
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Pouching System Products

Tube Continence Ostomy Care Ostomy Care
Wound Care = Bowel Care 0 Ogiﬁ?mc{ eg;rrgs Pouchkins Pediatric  Premier One-Piece
asteners are ) Pouching System Pouching System

Education

Karaya 5 One-Piece Pouching System

Drainable Pouches (continued)

327x (PRE-SIZED)

HCPCS: A4389

Box of 30

» Drainable Pouch, Karaya 5 (standard wear)
Skin Barrier— Convex, Tape Border, Without Integrated Filter,
Pouch Clamp Closure, Belt Tabs, Without ComfortWear Panels

< cowex

Transparent Pouch Pouch
Stock No Size Barrier Opening Length
3278 1-1/4" (32 mm) 7/8" (22 mm) 16" (40 cm)
3273 1-1/2" (38 mm) 1-1/8" (29 mm) 16" (40 cm)
3279 1-3/4" (44 mm) 1-3/8" (35 mm) 16" (40 cm)
3274 2" (51 mm) 1- 1/2" (38 mm) 16" (40 cm)
3275 2-1/2" (64 mm) 2" (51 mm) 16" (40 cm)
3276 3" (76 mm) 2-1/2" (64 mm) 16" (40 cm)
Closed Pouches

332x (PRE-SIZED) Box of 30

HCPCS: A4417

» Closed Pouch, Karaya 5 (standard wear)
Skin Barrier— Convex, Tape Border, Integrated Filter,
Belt Tabs, Without ComfortiWear Panels

< convex

Transparent Pouch Pouch
Stock No Size Barrier Opening Length
3328 1-1/4" (32 mm) 7/8" (22 mm) 9" (23 cm)
3323 1-1/2" (38 mm) 1-1/8" (29 mm) 9" (23 cm)
3329 1-3/4" (44 mm) 1-3/8" (35 mm) 9" (23 cm)
3324 2" (51 mm) 1-1/2" (38 mm) 9" (23cm)
3325 2-1/2" (64 mm) 2" (51 mm) 9" (23 cm)
3326 3" (76 mm) 2-1/2" (64 mm) 9" (23 cm)

716X (PRE-SIZED) Box of 30

> Requires a Belt
HCPCS: A4387

> Closed Pouch, Karaya 5 (standard wear)
Skin Barrier— Convex, Without Tape Border, Without
Integrated Filter, Belt Tabs, Without ComfortiWear Panels

< convex

Transparent Pouch Pouch
Stock No Size Barrier Opening Length
7168 1-1/4" (32 mm) 7/8" (22 mm) 9" (23 cm)
7163 1-1/2" (38 mm) 1-1/8" (29 mm) 9" (23 cm)
7169 1-3/4" (44 mm) 1-3/8" (35 mm) 9" (23 cm)
7164 2" (51 mm) 1- 1/2" (38 mm) 9" (23 cm)
7165 2-1/2" (64 mm) 2" (51 mm) 9" (23 cm)
7166 3" (76 mm) 2-1/2" (64 mm) 9" (23 cm)
Urostomy Pouches

143x (PRE-SIZED) Box of 10

HCPCS: A4429

» Urostomy Pouch, Karaya 5 (standard wear)
Skin Barrier— Convex, Tape Border, Belt Tabs,
Without ComfortiWear Panels

< cowex

Transparent Pouch Pouch
Stock No Size Barrier Opening Length
1432 1"(25 mm) 5/8"(16 mm) 9" (23 cm)
1438 1-1/4"(32 mm) 7/8"(22 mm) 9" (23 cm)
1433 1-1/2"(38 mm) 1-1/8"(29 mm) 9" (23 cm)
1439 1-3/4"(44 mm) 1-3/8"(35 mm) 9" (23 cm)
1434 2"(51 mm) 1-1/2"(38 mm) 9" (23 cm)

Hollister Incorporated

1.800.323.4060
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Continence

Hollister Secure Start Services
Personalized Patient Support

M# ‘ A\j"“\

Support Throughout the Continuum of Care

We are proud to offer dedicated support for each and
every patient we serve along the continuum of care.
Hollister Secure Start services provide a lifetime of
personalized support for our members.

Our team is focused on helping patients with:
® Finding the right product fit
® Navigating insurance coverage
® |dentifying supplier options
® Providing condition specific education
® And morel!

To learn more, call us at 1.888.808.7456.

% Hollister

The Hollister logo and Secure Start are trademarks of Hollister Incorporated.
©2017 Hollister Incorporated.
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VaPro Plus Pocket Touch Free Hydrophilic Intermittent Catheter
VaPro Touch Free Hydrophillic Intermittent Catheter, Coudé Tip
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@ VaPro Plus
4]

We're for
the one

who makes
their dreams
a reality.
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RX Only. Federal (USA) Law restricts this device to sale by or on the order of a physician
or other healthcare practitioner licensed under state law to order this product.

% Continence Care
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Medicare Utilization Chart

Medicare’s Usual Maximum Quantity for Urological Supplies

The quantity of urological supplies needed by a patient is determined by
many factors. There will be variation according to individual need and
their needs may vary over time. The table below lists the maximum

number of items/units of service that are medically necessary. The actual

quantity needed for a particular patient may be more or less than the
amount listed. The medical necessity for use of a greater quantity of
supplies than the amounts listed must be clearly documented in the

patient’s medical record, and must be available upon request. The HCPCS

and reimbursement information provided herein is intended to provide
general information concerning coding of Hollister products only. Please

refer to the HCPGS Code Disclaimer for more informaton.

Per Medicare LCD for Urological Supplies (L33803),
effective 1-1-2017.

HCPCS Long Description Quantity

A4217  Sterile water/saline, 500 mL *

A4310 Insert tray without drainage bag and without 1 tray/insertion
catheter (accessories only)

A4311  Insertion tray without drainage bag with indwelling 1 tray/insertion
catheter, foley type, two-way latex with coating (Teflon,
silicone, silicone elastomer, or hydrophilic, etc.)

A4312  Insertion tray without drainage bag with indwelling 1 tray/insertion
catheter, foley type, two-way all silicone

A4313  Insertion tray without drainage bag with indwelling 1 tray/insertion
catheter, foley type, three-way, for continuous irrigation

A4314 Insertion tray with drainage bag with indwelling 1 ea/mo
catheter, foley type, two-way latex with coating (Teflon,
silicone, silicone elastomer, or hydrophilic, etc.)

A4315  Insertion tray with drainage bag with indwelling 1 ea/mo
catheter, foley type, two-way, all silicone

A4316 Insertion tray with drainage bag with indwelling 1 ea/mo
catheter, foley type, three-way, for continuous irrigation

A4320 Irrigation tray with bulb or piston syringe, any purpose *

A4321 Therapeutic agent for urinary catheter irrigation *

A4322 Irrigation syringe, bulb, or piston, each *

A4326 Male external catheter with integral *
collection chamber, any type, each

A4327 Female external urinary collection device; meatal cup, each 1 ea/wk

A4328 Female external urinary collection device; pouch, each 1 ea/day

A4331  Extension drainage tubing, any type, any length, with *
connector/adapter, for use with urinary leg bag or
urostomy pouch, each

A4332  Lubricant, individual sterile packet, each 200 ea/mo

A4333  Urinary catheter anchor device, adhesive skin 3 ea/wk
attachment, each

A4334  Urinary catheter anchoring device, leg strap, each 1 ea/mo

A4335  Incontinence supply; miscellaneous *

A4336 Incontinence supply, urethral insert, any type, each *

A4338 Indwelling catheter; foley type, two-way latex with coating 1 ea/mo
(Teflon, silicone, silicone elastomer, or hydrophilic, etc.), each

A4340 Indwelling catheter; specialty type, (€.g., coudé, mushroom, 1 ea/mo
wing, etc.), each

A4344  Indwelling catheter, foley type, two-way, all silicone, each 1 ea/mo

A4346 Indwelling catheter; foley type, three-way for continuous 1 ea/mo
irrigation, each

A4349 Male external catheter, with or without adhesive, 35 ea/mo

disposable, each

*No established usual maximum, refer to Medicare Utilization Guidelines.

www.hollister.com Hollister Incorporated
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Wound Care

Education

Medicare Utilization Chart

HCPCS Long Description Quantity

A4351  Intermittent urinary catheter; straight tip, with or without 200 ea/mo
coating (Teflon, silicone, silicone elastomer, or hydrophilic,
etc.), each

A4352  Intermittent urinary catheter; coudé (curved) tip, with or 200 ea/mo
without coating (Teflon, silicone, silicone elastomeric, or
hydrophilic, etc.), each

A4353 Intermittent urinary catheter, with insertion supplies 200 ea/mo

A4354  Insertion tray with drainage bag but without catheter 1 ea/mo

A4355 Irrigation tubing set for continuous bladder irrigation 1 ea/day
through a three-way indwelling foley catheter, each

A4356  External urethral clamp or compression device 1ea/3 mo
(not to be used for catheter clamp), each

A4357  Bedside drainage bag, day or night, with or without 2 ea/mo
anti-reflux device, with or without tube, each

A4358  Urinary drainage bag, leg or abdomen, vinyl, with or 2 ea/mo

without tube, with straps, each

A4360 Disposable external urethral clamp or compression device, Not Covered
with pad and/or pouch, each

A4402  Lubricant, per ounce *
A4450 Tape, non-waterproof, per 18 square inches 10 units (18 sq in)/mo
A4452  Tape, waterproof, per 18 square inches 10 units (18 sq in)/mo
A4455  Adhesive remover or solvent (for tape, cement, or other adhesive),
per ounce *
A4520 Incontinence garment, any type (e.g., brief, diaper), each *
A4456  Adhesive remover, wipes, any type, each Not Covered
A4554  Disposable underpads, all sizes *
A5102 Bedside drainage bottle with or without tubing, rigid or 1ea/3 mo
expandable, each
A5105  Urinary suspensory with leg bag, with or without tube, each *
A5112  Urinary drainage bag, leg or abdomen, latex, with or 1 ea/mo
without tube, with straps, each
A5113  Leg strap; latex, replacement only, per set *
A5114  Leg strap, foam or fabric, replacement only, per set *
A5131  Appliance cleaner, incontinence and ostomy 1 (16 0z)/mo
appliances, per 16 ounce
A5200 Percutaneous catheter/tube anchoring device, adhesive *

skin attachment
A9270  Non-covered item or service

*No established usual maximum, refer to Medicare Utilization Guidelines.

Note: Intermittent catheterization using a sterile intermittent catheter kit (A4353)

This product is covered when the patient requires catheterization and the beneficiary
meets one of the following criteria (1-5):

1) The beneficiary resides in a nursing facility

2) The beneficiary is immunosuppressed, for example (not all-inclusive): on a
regimen of immunossuppressive drugs post-transplant, on cancer chemotherapy,
has AIDS, has a drug-induced state such as chronic oral corticosteriod use

3) The beneficiary has radiologically documented vesico-urethral reflux while on a
program of intermittent catheterization

4) The beneficiary is a spinal-cord-injured-female with neurogenic bladder who is
pregnant (for duration of pregnancy only)

5) The beneficiary has had distinct, recurrent urinary tract infections, while on a
program of sterile intermittent catheterization with A4351/A4352 and sterile
lubricant A4332, twice within the 12 months prior to the initiation of sterile
intermittent catheter kits.

Per Medicare LCD for Urological Supplies (L33803),

effective 1-1-2017.

Hollister Incorporated 1.800.323.4060
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RX Only. Federal (USA) Law restricts this device to sale by or on the order of a physician or other
healthcare practitioner licensed under state law to order this product.
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Intermittent Catheters

VaPro Plus Touch Free Hydrophilic Intermittent Catheter

~q 74xxx Box of 30
» Protective Tip and Sleeve allows for
@wr=me no touch catheterization
T nmemsne o Pre-Hydrated and Ready to Use
> Integrated 1000 mL Collection Bag
» Smooth hydrophilic coating
» Smooth Eyelets
» Not Made with Natural Rubber Latex
HCPCS: A4353
Stock No Length (inches) Size Description
74122 8 12 Fr Straight
74142 8 14 Fr Straight
74124 16 12 Fr Straight
74144 16 14 Fr Straight

VaPro Plus Pocket Touch Free Hydrophilic Intermittent Catheter

71xxx-30 Box of 30
» All the attributes of VaPro Plus Catheter
in a Pocket Size Package
HCPCS: A4353
Length (inches) Size Description
71082-30 8 8 Fr Straight
71102-30 8 10 Fr Straight
71122-30 8 12 Fr Straight
71142-30 8 14 Fr Straight
71084-30 16 8 Fr Straight
71104-30 16 10 Fr Straight
71124-30 16 12 Fr Straight
71144-30 16 14 Fr Straight
71164-30 16 16 Fr Straight

VaPro Touch Free Hydrophillic Intermittent Catheter, Coudé Tip

73xxx Box of 30
» Protective Tip and Sleeve allows for
no touch catheterization
> Pre-Hydrated and Ready to Use
> Coude Tip
» Smooth Hydrophilic Coating
» Smooth Eyelets
» Not Made with Natural Rubber Latex

HCPCS: A4352

Stock No Length (inches) Size Description
73124 16 12 Fr Coudé
73144 16 14 Fr Coudé
73164 16 16 Fr Coudé
Onli Ready to Use Hydrophilic Intermittent Catheter

82xxx-30 Box of 30

l > Pre-Hydrated and Ready to Use
] » Smooth Hydrophilic Coating

» Smooth Eyelets

» Ergonomic Gripper on 16" Catheter

» Not Made with Natural Rubber Latex

HCPCS: A4351
Stock No Length (inches) Size Description
82081-30 7 8 Fr Straight
82101-30 7 10Fr Straight
82121-30 7 12 Fr Straight
82141-30 7 14 Fr Straight
82084-30 16 8 Fr Straight
82104-30 16 10Fr Straight
82124-30 16 12 Fr Straight
82144-30 16 14 Fr Straight
82164-30 16 16 Fr Straight

RX Only. Federal (USA) Law restricts this device to sale by or on the order of a physician or

other healthcare practitioner licensed under state law to order this product.

Hollister Incorporated

1.800.323.4060



Intermittent Catheters

Advance Plus Touch Free Intermittent Catheter System

R o o 94xxX/95XXX Box of 100
L = 16" length

> Gel Reservoir

» Protective Tip

> Integrated 1500 mL Collection Bag with Large Handle

» Smooth Eyelets

» Not Made with Natural Rubber Latex
HCPCS: A4353

Stock No Size Description
94064 6 Fr Straight
94084 8 Fr Straight
94104 10 Fr Straight
94124 12Fr Straight
94144 14 Fr Straight
94164 16 Fr Straight
94184 18 Fr Straight
95124 12 Fr Coudé
95144 14 Fr Coudé
95164 16 Fr Coudé

Advance Plus Pocket Touch Free Intermittent Catheter System

e 93xxx Box of 100
’ = > All the attributes of the full length
" = Advance Plus Catheter in a Pocket Size Package
HCPCS: A4353
Stock No Size Description
93104 10 Fr Pocket
93124 12Fr Pocket
93144 14 Fr Pocket
93164 16 Fr Pocket

Advance Plus Touch Free Intermittent Catheter Kit

e S 96XXX/97XXX Box of 100
S AT pdvance Plus Catheter

7 ;Igl » Kit Contains Gloves, Underpad Drape,
and Benzalkonium Chloride Swabsticks
» Not Made with Natural Rubber Latex
HCPCS: A4353

Stock No Size Description
96064 6 Fr Straight
96084 8 Fr Straight
96104 10 Fr Straight
96124 12 Fr Straight
96144 14 Fr Straight
96164 16 Fr Straight
96184 18 Fr Straight
97124 12 Fr Coudé
97144 14 Fr Coudé
97164 16 Fr Coudé

RX Only. Federal (USA) Law restricts this device to sale by or on the order of a physician or
other healthcare practitioner licensed under state law to order this product.

www.hollister.com Hollister Incorporated
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Intermittent Catheters

Apogee HC Hydrophilic Intermittent Catheter

90xxx/91xxx

» Smooth Insertion
> Simple To Use
» Not Made with Natural Rubber Latex
» Sliding sleeve to aid insertion for 16 inch product
» Burstable sterile water pack that activates coating

HCPCS: A4351 for all except
HCPCS: A4352 for 91226, 91426, 91626

Box of 30

Stock No Length Size Description
91006 6 10Fr Straight
91206 6 12 Fr Straight
91406 6 14 Fr Straight
90810 10 8 Fr Straight
91010 10 10 Fr Straight
91216 16 12 Fr Straight
91416 16 14 Fr Straight
91616 16 16 Fr Straight
91816 16 18 Fr Straight
91226 16 12 Fr Coudé
91426 16 14 Fr Coudé
91626 16 16 Fr Coudé

RX Only. Federal (USA) Law restricts this device to sale by or on the order of a physician or
other healthcare practitioner licensed under state law to order this product.

Hollister Incorporated

1.800.323.4060



Intermittent Catheters

Apogee Family of Intermittent Catheters

I | 10xx/1xxXX Box of 30
» Smooth Eyelets Box of 50
> Not Made with Natural

1 Rubber Latex (unless noted)
> Non-lubricated
|

Apogee IC Intermittent Catheters

HCPCS: A4351
Length

Stock No (inches) Size Description

10806 6 8 Fr Firm

11006 6 10 Fr Firm

11206 6 12 Fr Firm

11406 6 14 Fr Firm

11446* 6 14 Fr Firm

10610 10 6 Fr Firm

10810 10 8 Fr Firm

11010 10 10 Fr Firm

10616 16 6 Fr Firm

10816 16 8Fr Firm

11016 16 10 Fr Firm

11216 16 12 Fr Firm

11416 16 14 Fr Firm

11616 16 16 Fr Firm

11816 16 18 Fr Firm

*No funnel  Qty: 30/box

Apogee IC Intermittent Catheters Coudé Tip
HCPCS: A4352

Length

Stock No (inches) Size Description

10826 16 8Fr Firm

11026 16 10 Fr Firm

11226 16 12 Fr Firm

11426 16 14 Fr Firm

11626 16 16 Fr Firm

11826 16 18 Fr Firm

Qty: 30/box

Apogee Intermittent Catheters, Other Styles
HCPCS: A4351 for all except
HCPCS: A4352 for 1087

Length

Stock No (inches) Size Description

1036 16 10 Fr Soft

1046 16 12Fr Soft

1061 16 14 Fr Soft

1083 16 16 Fr Soft

1049 16 12Fr  Firm, Curved Catheter

1065 16 14 Fr  Firm, Curved Catheter

1074A 16 14 Fr Soft, Curved Catheter

1087 16 16 Fr Firm, Coudé, Curved Catheter

1051 16 12 Fr Red Rubber Latex*

1067 16 14 Fr Red Rubber Latex*

1084 16 16 Fr Red Rubber Latex*

Qty: 30/box except curved catheters: 50/box

*Caution: This product contains natural rubber latex which may cause allergic reactions.
RX Only. Federal (USA) Law restricts this device to sale by or on the order of a physician or

other healthcare practitioner licensed under state law to order this product.

www.hollister.com

Hollister Incorporated
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Intermittent Catheters

Ostomy Care
Ceramide Infused
Products

Apogee Plus System

=) =2 Bxx Case of 100
...... v > 16" length
> Protective Tip
> Pre-lubricated
» Smooth Eyelets
> Integrated 1500 mL Collection Bag
» Not Made with Natural Rubber Latex (unless noted)

HCPCS: A4353

Ostomy Care
New Image Two-Piece
Pouching System

3 Stock No Size Description
Sa 3 BoF 8Fr Firm
SE£2 B10F 10Fr Firm
ELC < B12F 12Fr Firm
S2%§ B14F 14Fr Firm
828 B16F 16 Fr Firm
& B18F 18 Fr Firm
B12C 12Fr Coudé

5 B14C 14 Fr Coudé

g é £ B16C 16 Fr Coudé
S3E B12S 12 Fr Soft
E’E E) B14S 14 Fr Soft
S =5 B14R 14 Fr Red Rubber Latex*
g § ,533_ B16R 16 Fr Red Rubber Latex*
& B14F-Female 14 Fr, 6" Firm

*Caution: This product contains natural rubber latex which may cause allergic reactions.

Ostomy Care
Ostomy Accessories

Apogee Plus System Kit
. BxxxB Case of 100

e - > Apogee Plus Catheter
» Kit Contains Gloves, Underpad Drape,

@ _/' % Gauze, and PVP Swabsticks
§ o ) » Not Made with Natural Rubber Latex (unless noted)
5 8 HCPCS: A4353
S Stock No Size Description
B6FB 6 Fr Firm**
B8FB 8 Fr Firm**
B10FB 10 Fr Firm
@ B12FB 12Fr Firm
s B14FB 14 Fr Firm
(&) B16FB 16 Fr Firm
© B18FB 18 Fr Firm
2 B12CB 12 Couds
[} B14CB 14 Fr Coudé
B16CB 16 Fr Coudé
B12SB 12Fr Soft
B14SB 14 Fr Soft
(7] B12RB 12Fr Red Rubber Latex*
o O B14RB 14 Fr Red Rubber Latex*
= E;. B16RB 16 Fr Red Rubber Latex*
= £ B14FB-Female 14 Fr, 6" Firm
[V

/A\ WARNING: The gloves in this kit can expose you to chemicals including
Diisononyl phthalate (DINP) which is known to the State of California to cause cancer.
For more information go to www.P65Warnings.ca.gov.

% *Caution: This product contains natural rubber latex which may cause allergic reactions.
S **The protective tip on this product is closer to 10mm.
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= RX Only. Federal (USA) Law restricts this device to sale by or on the order of a physician or
S other healthcare practitioner licensed under state law to order this product.
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Hollister Incorporated 1.800.323.4060



Male External Catheters

InView Male External Catheters

— 974xx/975xx/976xx Box of 30
= 974xx-100/975xx-100/976xx-100 Box of 100
\ > Self-Adhesive
- > Clear Material Enables Monitoring of Skin

» Not Made with Natural Rubber Latex

HCPCS: A4349
SPECIAL: shorter length sheath
Stock No  Stock No

Box of 30 Box of 100 Color Size

- Pa— 97425 97425-100 | 25 mm

—_— 97429 97429-100 | 29 mm

97432 97432-100 u 32 mm

97436 97436-100 | 36 mm

97441 97441-100 u 41 mm

STANDARD: the daily catheter for general use

Stock No  Stock No

Box of 30 Box of 100 Color Size

- 97525 97525-100 | 25 mm

— 97529 97529-100 | 29 mm

97532 97532-100 ] 32 mm

97536 97536-100 u 36 mm

97541 97541-100 u 41 mm

EXTRA: 70% more adhesive than Standard for added security

Stock No  Stock No

Box of 30 Box of 100 Color Size

— 97625 97625-100 | 25 mm

— 97629 97629-100 | 29 mm

97632 97632-100 | 32 mm

97636 97636-100 u 36 mm

97641 97641-100 L 41 mm

Extended Wear Male External Catheter

©] 920x Box of 30
HU » Self-Adhesive

> Unique Inner Flap
» Easy Applicator Collar
» Contains Natural Rubber Latex

HCPCS: A4349

Stock No Color Size
9206 ] 22 mm-25mm
9207 | 26 mm-30 mm
9208 ] 31 mm-35 mm
9209 L] 36 mm-39 mm

Caution: This product contains natural rubber latex which may cause allergic reactions.

Everyday Male External Catheter
910x Box of 30

R @ > Self-Adhesive
W » Easy Applicator Collar
» Contains Natural Rubber Latex

HCPCS: A4349

Stock No Color Size
9106 ] 22 mm-25 mm
9107 | 26 mm-30 mm
9108 | 31 mm-35 mm
9109 ] 36 mm-39 mm

Caution: This product contains natural rubber latex which may cause allergic reactions.

www.hollister.com Hollister Incorporated
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Tube Continence Ostomy Care Ostomy Care Ostomy Care Ostomy Care
Fast Bowel Care c OSSLOT%(&E;?;S Pouchkins Pediatric Premier One-Piece New Image Two-Piece Ceramide Infused
asteners are y Pouching System Pouching System Pouching System Products

Wound Care

Education

Leg Bag Systems

Vented Urinary Leg Bag Combination Pack

i - 9645/9655 Box of 10
i > Includes:
& /A (1) Vented Urinary Leg Bag — Medium or Large
/ (1) Extension Tubing with Vacuum Relief Valve, (18” Long,
Oval, 11/32" Effective Inside Diameter), with Connector
w (1) Pair, Fabric Leg Bag Straps — Medium (23" Long,
1-1/8” Wide)
» Not Made with Natural Rubber Latex, Contains Sterile Components
> Anti-reflux valve to help prevent back flow of urine into tube
HCPCS: A4358
Stock No Description Length Width
9645 Medium — 18 oz (540 mL) 10" 4-1/4"
9655 Large — 30 0z (900 mL) 11-1/8" 5"
Urinary Leg Bag
§J8 9814/9805 Box of 10
1 > Includes:
(1) Urinary Leg Bag — Medium or Large
> Not Made with Natural Rubber Latex
» Anti-reflux valve to help prevent back flow of urine into tube
“ HCPCS: A9270
HCPCS: A4358 (if straps are added)
Stock No Description Length Width
9814 Medium — 18 oz (540 mL) 10" 4-1/4"
9805 Large — 30 0z (900 mL) 11-1/8" 5"

Urinary Leg Bag Combination Pack

9348/9349 Box of 12
7 > Includes:
/ (1) Urinary Leg Bag — Medium or Large
& (1) Extension Tubing (18" Long, Oval, 11/32" Effective Inside
: Diameter) with Connector
(1) Pair, Fabric Leg Bag Straps — Medium
(23" Long, 1-1/8" Wide)
-, Not Made with Natural Rubber Latex; Contains Sterile
Components
> Anti-reflux valve to help prevent back flow of urine into tube
HCPCS: A4358
Stock No Description Length Width
9348 Medium — 18 0z (540 mL) 10" 4-1/4"
9349 Large — 30 0z (900 mL) 11-1/8" 5"

Hollister Incorporated 1.800.323.4060



Leg Bag Accessories

Fabric Leg Bag Straps

9342/9343 10 Pair
» Not Made with Natural Rubber Latex

HCPCS: A5114

Stock No Description Length Width
9342 Small 15" 1-1/8"
9343 Medium 23" 1-1/8"
Extension Tubing

9345/9346 Box of 10

> Kink-resistant with Connector
Oval, 11/32" Effective Inside Diameter
» Thermoplastic Elastomer, Not Made with Natural Rubber Latex

HCPCS: A4331

Stock No Description Length
9345 Non Sterile 18"
9346 Sterile 18"

www.hollister.com Hollister Incorporated
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23
S:g Collection Systems
ES 8
S Ea
8 3 Bedside Drainage Collection System with Anti-Reflux Valve
oo
9839 Box of 20
L » Sample Port
S&5 > Sterile Fluid Pathway
g,% 3 > Not Made with Natural Rubber Latex
E8E HCPCS: A4357
a 23 Stock No Description Length Width
= 9839 68 0z (2000 mL) 12" 9-3/4"
o 8 . . .
§ & é Male Urinary Pouch External Collection Device*
2S¢ 9873 Box of 10
SE5 ° » Cut-to-Fit, Flextend Skin Barrier
88 » Thin and Flexible
» No Additional Tape Needed
» Odor-Barrier Film
(] % = » Convenience Drain
Sz :% > Not Made with Natural Rubber Latex
a
Eg = HCPCS: A4326
"% € 3 Stock No Description Length Width
e 9873 Male Urinary Pouch 7-1/2" 4-1/2"
9811 Box of 10
» Cut-to-Fit, SoftFlex Skin Barrier
> Odor-Barrier Film

» Convenience Drain
» Tape Strips and Skin Gel Wipe Included

Ostomy Care
Ostomy Accessories

i > Not Made with Natural Rubber Latex
HCPCS: A4326
Stock No Description Length Width
9811 Male Urinary Pouch 7-1/2" 4-1/2"

Continence
Care

Female Urinary Pouch External Collection Device*

9840 Box of 10
Q » Cut-to-Fit, SoftFlex Skin Barrier
> Qdor-Barrier Film

» Convenience Drain
> Alternative to Indwelling Catheter for Bedridden Females
» Adapt Paste, Tape Strips, and Skin Gel Wipe Included
» Not Made with Natural Rubber Latex
HCPCS: A4328
Stock No Description Length Width
9840 Female Urinary Pouch 7-1/2" 4-1/2"

Bowel Care

* Meant to be connected to leg bag or gravity drainage

Wound Care Tibe
Fasteners

Education

Hollister Incorporated 1.800.323.4060
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Fecal Collectors

Fecal Collectors

Ostomy Care
New Image Two-Piece
Pouching System

Ostomy Care
Premier One-Piece
Pouching System

Ostomy Care
Pouchkins Pediatric
Pouching System

Ostomy Care
Ostomy Accessories

Continence
Care

Bowel Care

Tube
Fasteners

Wound Care

Education

Hollister Incorporated
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Tube Continence Ostomy Care Ostomy Care Ostomy Care Ostomy Care
Fast Bowel Care C OOtStOTy Care Pouchkins Pediatric Premier One-Piece New Image Two-Piece Ceramide Infused
asteners are SEUAESESIIE Pouching System Pouching System Pouching System Products

Wound Care

Education

Fecal Collectors

Fecal Collectors

©

9880 Box of 10
» Cut-to-Fit Flextend (extended wear) Tapered Skin Barrier
> Odor-Barrier Pouch Film

» Convenience Drain

HCPCS: A4330

Stock No Description Pouch Length
9880 Large 12" (30 cm)
° 9823 Box of 10
» Cut-to-Fit Flextend (extended wear) Tapered Skin Barrier
» Ultra-Clear Pouch Film
» Convenience Drain
X HCPCS: A4330
Stock No Description Pouch Length
9823 Medium 10" (25 cm)
o 9822/9821 Box of 10
| » Cut-to-Fit SoftFlex (standard wear) Skin Barrier
-4 » Odor-Barrier Pouch Film
| » Convenience Drain
L2 HCPCS: A4330
Stock No Description Pouch Length
9822 Medium 10" (25 cm)
9821 Large 12" (30 cm)
7  DID YOU KNOW...

To view video instructions for product application, visit
http://www.hollister.com/us/bm/fc/

Hollister Incorporated

1.800.323.4060
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Tube Fasteners
AnchorFast Guard Oral Endotracheal Tube Fastener
AnchorFast Oral Endotracheal Tube Fastener
Horizontal Tube Attachment Device (HTAD): Sterile
Vertical Tube Attachment Device (VTAD): Sterile
Drain Tube Attachment Device (DTAD): Sterile
Feeding Tube Attachment Device (FTAD)
Suction Tube Attachment Device (STAD)
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Continence
Wound Care Bowel Care Ostomy Care
Fasteners Care Ostomy Accessories

Education

When your choice

IS too important
fo take a chance.

Anchorfast

Oral Endotracheal Tube Fastener

With a long history of quality and innovation,
you can trust the AnchorFast product.

® Used at over 3,700 hospitals in the United States
® 20 years of demonstrated quality

® (Ongoing innovation driven by customer feedback

Learn more at www.hollister.com/anchorfast
or call 888.740.8999

£ Hollister

CAUTION: Federal (USA) Law restricts this device to sale by or on the order of a physician. Prior to use of the
AnchorFast oral endotracheal tube fastener, be sure to read the entire product Instructions for Use package insert
that accompanies the product.

The Hollister logo and AnchorFast are trademarks of Hollister Incorporated.

© 2016 Hollister Incorporated


http://www.hollister.com/en/anchorfast

Tube Fasteners

AnchorFast Guard Oral Endotracheal Tube Fastener

. 9800
; *‘3’ » Integrated Tube Protection Sleeve
~» Secures Oral Endotracheal Tubes (5 mm-10 mm inner diameter)
> Helps Optimize Oral Care
> Helps Safeguard Skin Health
> Individually Packaged
> Not Made with Natural Rubber Latex
Stock No HCPCS Description Quantity/Box

9800 A9900* /A9999**  AnchorFast Guard Oral Endotracheal 12
Tube Fastener

*to be used with a rented ventilator **to be used with a patient-owned ventilator

AnchorFast Oral Endotracheal Tube Fastener
9799

» Secures Oral Endotracheal Tubes (5 mm-10 mm inner diameter)
% ‘ > Helps Optimize Oral Care
> Helps Safeguard Skin Health

> Individually Packaged
> Not Made with Natural Rubber Latex
Stock No HCPCS Description Quantity/Box

9799 A9900* /A9999**  AnchorFast Oral Endotracheal 12
Tube Fastener

*to be used with a rented ventilator **to be used with a patient-owned ventilator

AnchorFast Replacement Neck Band Straps

Stock No HCPCS Description Quantity/Box
9788 — Replacement Neck Band Straps 4

Caution: Federal (USA) Law restricts this device to sale by or on the order of a physician.
Prior to use of the AnchorfFast Guard oral endotracheal tube fastener, be sure to read the
entire product Instructions for Use package insert that accompanies the product.

2 DID YOU KNOW...

For more information about AnchorFast oral endotracheal tube
fasteners, visit www.hollister.com/anchorfast

www.hollister.com Hollister Incorporated
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Ostomy Care Ostomy Care
New Image Two-Piece Ceramide Infused
Pouching System Products

Tube Continence Ostomy Care Ostomy Care
Wound Care - Bowel Care @ O(S)Stmo'/'\'c{ ef:)rrgs Pouchkins Pediatric  Premier One-Piece
dsteners Al y Pouching System Pouching System

Education

Tube Fasteners

Horizontal Tube Attachment Device (HTAD): Sterile

9781
e » Secures Drains, Tubes, or Catheters (5 Fr-40 Fr)
b

Parallel to Patient’s Skin
> Tubes Can be Secured at Exit Site, or Distal to Exit Site
> Helps Safeguard Skin Health
» Sterile, Not Made with Natural Rubber Latex
Stock No HCPCS Description Quantity/Box

9781 A5200 Horizontal Tube 5
Attachment Device (HTAD): Sterile

Vertical Tube Attachment Device (VTAD): Sterile
* 9782

gy - » Secures Drains, Tubes, or Catheters (5 Fr-40 Fr)
Vertical to Patient’s Skin

> Secures Tube at Exit Site

> Helps Safeguard Skin Health

» Sterile, Not Made with Natural Rubber Latex

Stock No HCPCS Description Quantity/Box

9782 A5200 Vertical Tube 5
Attachment Device (VTAD): Sterile

Drain Tube Attachment Device (DTAD): Sterile

9780

» Secures a Variety of Drains or Tubes (10 Fr-24 Fr)
i Vertical to Patient’s Skin

» Sterile, Not Made with Natural Rubber Latex

Stock No HCPCS Description Quantity/Box

9780 A5200 Drain Tube 5
Attachment Device (DTAD): Sterile

Feeding Tube Attachment Device (FTAD)

9786
» Secures Nasogastric/Nasointestinal Tubes (5 Fr-18 Fr)
» Butterfly-Shaped FlexWWear Skin Barrier
Conforms to Patient’s Nose
> Unique Swivel Clamp Helps Eliminate
Pressure on the Nares
» Not Made with Natural Rubber Latex
Stock No HCPCS Description Quantity/Box

9786 B9998 Feeding Tube 20
Attachment Device (FTAD)

Suction Tube Attachment Device (STAD)

9785
» Secures Nasogastric Tubes (12 Fr-18 Fr)
» Butterfly-Shaped FlexWear Skin Barrier Conforms
to Patient’s Nose
> Unique Swivel Clamp Helps Eliminate Pressure on the Nares
» Not Made with Natural Rubber Latex
Stock No HCPCS Description Quantity/Box

9785 A9999 Suction Tube 20
Attachment Device (STAD)

Hollister Incorporated 1.800.323.4060
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Table of Contents ® Wound Care

Medicare Utilization Chart

FastCast OLS Total Contact Cast System

Foam Dressings

TRIACT Foam with Silicone Border

Restore Foam with TRIACT Technology Non-Border

Restore LITE Foam with TRIACT Technology Non-Border
Restore Silver Foam with TRIACT Technology Non-Border

Restore Foam with Silicone Border
Restore Foam with Silicone Non-Border
Contact Layers with TRIACT Technology
Restore Contact Layer FLEX

Restore Contact Layer, Silver

Restore to CalciCare Conversion Chart
CalciCare and Restore Calcium Alginates
CalciCare Calcium Alginate

CalciCare Calcium Alginate, Silver
Restore Calcium Alginate

Restore Calcium Alginate, Silver
Restore Hydrogel

Restore Wound Cleanser and Skin Care

Restore Wound Cleanser

Restore Skin Cleanser

Restore Cleanser & Moisturizer

Restore Skin Conditioning Creme

Restore Hydrocolloids

Restore Hydrocolloid: Sterile

Restore Extra Thin Hydrocolloid: Sterile
Restore Hydrocolloid with Foam Backing: Sterile

Hollister Incorporated
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Tube Continence Ostomy Care Ostomy Care Ostomy Care Ostomy Care
Fast Bowel Care c O?tgkorlr\lc{eg:::s Pouchkins Pediatric Premier One-Piece  New Image Two-Piece Ceramide Infused
asteners are y ' Pouching System Pouching System Pouching System Products

Wound Care

Education

Medicare Utilization Chart

Medicare Usual Dressing Change Frequency
for Wound Care Supplies

The quantity and type of dressings dispensed at any one time must

take into account the current status of the wound(s), the likelihood of
change, and the recent use of dressings. Dressing needs may change
frequently (e.g., weekly) in the early phases of wound treatment and/

or with heavily draining wounds. Surgical dressings must be tailored to
the specific needs of an individual patient. The table below lists some
coverage guidelines and usual dressing change frequencies. The medical
necessity for more frequent dressing changes must be documented in the
patient’s medical record and submitted with the claim. The HCPCS and
reimbursement information provided herein is intended to provide general
information concerning coding of Hollister products only. Please refer to
the HGPCS Code Disclaimer for more information.

Per Medicare LCD for Surgical Dressings (L33831), effective 7-24-2017.

Frequency Wound

HCPCS Long Description of Change Condition
A4450  Tape, non-waterproof, based on
per 18 square inches drsg size
A4452  Tape, waterproof, per based on
18 square inches drsg size

A4461  Surgical dressing holder, non-reusable, each

A4463  Surgical dressing holder, reusable, each *
A4465  Non-elastic binder for extremity *
A4490  Surgical stockings above knee length, each  *
A4495  Surgical stockings thigh length, each *
A4500  Surgical stockings below knee length, each  *
A4510  Surgical stockings full length, each *
A4649  Surgical supply; miscellaneous *
AB025  Gel Sheet for dermal or epidermal *
application, (e.g., silicone, hydrogel,
other), each
A6154  Wound pouch, each 3/wk

AB196  Alginate or other fiber gelling dressing, 1/day mod-heavy exudate
wound cover, sterile, pad size 16 sq in or
less, each dressing

A6197  Alginate or other fiber gelling dressing, 1/day mod-heavy
wound cover, sterile, pad size more than exudate
16 sq in but less than or equal to 48 sq in,
each dressing

A6198  Alginate or other fiber gelling dressing, 1/day mod-heavy
wound cover, sterile, pad size more than exudate
48 sq in, each dressing

AB199  Alginate or other fiber gelling dressing, 2 units mod-heavy
wound filler, sterile, per 6 inches (12 in)/day exudate

* No established usual maximum, refer to Medicare Utilization Guidelines.
Hollister Incorporated 1.800.323.4060



Medicare Utilization Chart

Frequency
HCPCS Long Description of Change
Composite dressing, sterile, pad size 3/wk

AG203

16 sq in or less, with any size
adhesive border, each dressing

Condition

AG204

Composite dressing, sterile, pad size 3/wk
more than 16 sq in but less than or equal

to 48 sq in, with any size adhesive

border, each dressing

A6205

Composite dressing, sterile, pad size more  3/wk
than 48 sq in, with any size adhesive
border, each dressing

AG206

Contact layer, sterile, 16 sq in or less, 1/wk
each dressing

line the wound

A6207

Contact layer, sterile, more than 16 sq in but 1/wk
less than or equal to 48 sq in, each dressing

line the wound

A6208

Contact layer, sterile, more than 48 sqin, ~ 1/wk
each dressing

line the wound

A6209

Foam dressing, wound cover, sterile, 3/wk
pad size 16 sq in or less, without adhesive
border, each dressing

mod-heavy
exudate

A6210

Foam dressing, wound cover, sterile, 3/wk
pad size more than 16 sq in but less than

or equal to 48 sq in, without adhesive

border, each dressing

mod-heavy
exudate

A6211

Foam dressing, wound cover, sterile, 3/wk
pad size more than 48 sq in, without
adhesive border, each dressing

mod-heavy
exudate

A6212

Foam dressing, wound cover, sterile, 3/wk
pad size 16 sq in or less, with any size
adhesive border, each dressing

mod-heavy
exudate

A6213

Foam dressing, wound cover, sterile, 3/wk
pad size more than 16 sq in but less than

or equal to 48 sq in, with any size adhesive
border, each dressing

mod-heavy
exudate

A6214

Foam dressing, wound cover, sterile, 3/wk
pad size more than 48 sq in, with any
size adhesive border, each dressing

mod-heavy
exudate

A6216

(Gauze, non-impregnated, non sterile, 3/day
pad size 16 sq in or less, without
adhesive border, each dressing

A6217

Gauze, non-impregnated, non sterile, 3/day
pad size more than 16 sq in but less

than or equal to 48 sq in, without

adhesive border, each dressing

A6218

(Gauze, non-impregnated, non sterile, 3/day
pad size more than 48 sq in, without
adhesive border, each dressing

A6219

(Gauze, non-impregnated, sterile, 1/day
pad size 16 sq in or less, with any size
adhesive border, each dressing

* No established usual maximum, refer to Medicare Utilization Guidelines.

www.hollister.com

Hollister Incorporated
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Medicare Utilization Chart

Ceramide Infused
Products

Ostomy Care

Frequency

HCPCS Long Description of Change Condition
L A6220  Gauze, non-impregnated, sterile, 1/day
g &5 pad size more than 16 sq in but less
o § 2 than or equal to 48 sq in, with any
E‘ 22 size adhesive border, each dressing
CR=E=
38 :; e AB221 Gauzg, non-impregnated, §teri|¢, 1/day
= pad size more than 48 sq in, with any
size adhesive border, each dressing
= § = AB222  Gauze, impregnated with other than 1/day
© % & water, normal saline, or hydrogel, sterile
gS2 pad size 16 sq in or less, without
SEE adhesive border, each dressing
N s o
o —
& AB223  Gauze, impregnated with other than 1/day
water, normal saline, or hydrogel, sterile
P pad size more than 16 sq in but less
SS3 than or equal to 48 sq in, without
g %) adhesive border, each dressing
g22
% £8 A6224  Gauze, impregnated with other than 1/day
S3& water, normal saline, or hydrogel, sterile

pad size more than 48 sq in, without
adhesive border, each dressing

A6228  Gauze, impregnated with water or * Non-Covered
normal saline, sterile, pad size 16 sq in or
less, without adhesive border, each dressing

Ostomy Care
Ostomy Accessories

ABG229  Gauze, impregnated with water or * Non-Covered
normal saline, sterile, pad size more than
16 sq in but less than or equal to
48 sq in, without adhesive border,
each dressing

AG6230  Gauze, impregnated with water or normal * Non-Covered
saline, sterile, pad size more than 48 sq in,
without adhesive border, each dressing

Continence
Care

A6234  Hydrocolloid dressing, wound cover, 3wk light-mod exudate
sterile, pad size 16 sq in or less, without
adhesive border, each dressing

A6235  Hydrocolloid dressing, wound cover, 3wk light-mod exudate
sterile, pad size more than 16 sq in but
less than or equal to 48 sq in,
without adhesive border, each dressing

Bowel Care

AG236  Hydrocolloid dressing, wound cover, 3wk light-mod exudate
sterile, pad size more than 48 sq in,
without adhesive border, each dressing

Tube
Fasteners

A6237  Hydrocolloid dressing, wound cover, 3wk light-mod exudate
sterile, pad size 16 sq in or less, with
any size adhesive border, each dressing

) A6238  Hydrocolloid dressing, wound cover, 3wk light-mod exudate

S sterile, pad size more than 16 sq in but

= less than or equal to 48 sq in, with any size

3 adhesive border, each dressing

= AG239  Hydrocolloid dressing, wound cover, 3wk light-mod exudate
sterile, pad size more than 48 sq in, with
any size adhesive border, each dressing

=

% * No established usual maximum, refer to Medicare Utilization Guidelines.

S

o

Ll

Hollister Incorporated 1.800.323.4060



Medicare Utilization Chart

HCPCS Long Description
A6240

Frequency
of Change

Hydrocolloid dressing, wound filler, 3/wk
paste, sterile, per ounce

Wound
Condition

light-mod exudate

A6241

Hydrocolloid dressing, wound filler, 3wk
dry form, sterile, per gram

light-mod exudate

A6242

Hydrogel dressing, wound cover, sterile, 1/day
pad size 16 sq in or less, without
adhesive border, each dressing

min-no exudate

A6243

Hydrogel dressing, wound cover, sterile, 1/day
pad size more than 16 sq in but less than

or equal to 48 sq in, without adhesive border,

each dressing

min-no exudate

A6244

Hydrogel dressing, wound cover, sterile, 1/day
pad size more than 48 sq in, without
adhesive border, each dressing

min-no exudate

A6245

Hydrogel dressing, wound cover, sterile, 3/wk
pad size 16 sq in or less, with any size
adhesive border, each dressing

min-no exudate

A6246

Hydrogel dressing, wound cover, sterile, 3wk
pad size more than 16 sq in but less

than or equal to 48 sq in, with any size

adhesive border, each dressing

min-no exudate

A6247

Hydrogel dressing, wound cover, sterile, 3/wk
pad size more than 48 sq in, with any
size adhesive border, each dressing

min-no exudate

A6248

Hydrogel dressing, wound filler, 1/day up to
gel, per fluid ounce 3 0z/mo

min-no exudate

A6250

Skin sealants, protectants, moisturizers, *
ointments, any type, any size

A6251

Specialty absorptive dressing, wound 1/day
cover, sterile, pad size 16 sq in or less
without adhesive border, each dressing

mod-heavy
exudate

A6252

Specialty absorptive dressing, wound 1/day
cover, sterile, pad size more than 16 sq in

but less than or equal to 48 sq i,

without adhesive border, each dressing

mod-heavy
exudate

A6253

Specialty absorptive dressing, wound 1/day
cover, sterile, more than 48 sq in,
without adhesive border, each dressing

mod-heavy
exudate

A6254

Specialty absorptive dressing, wound every other
cover, sterile, pad size 16 sq in or less day
with any size adhesive border, each dressing

mod-heavy
exudate

A6255

Specialty absorptive dressing, wound every other
cover, sterile, pad size more than 16 sqin~ day
but less than or equal to 48 sq in, with

any size adhesive border, each dressing

mod-heavy
exudate

A6256

Specialty absorptive dressing, every other
wound cover, sterile, more than 48 sq in, day
with any size adhesive border,

each dressing

mod-heavy
exudate

* No established usual maximum, refer to Medicare Utilization Guidelines.

www.hollister.com

Hollister Incorporated
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http://www.hollister.com

Tube Continence Ostomy Care Ostomy Care Ostomy Care Ostomy Care
Fast Bowel Care C OOStOTCy (S:aore Pouchkins Pediatric Premier One-Piece  New Image Two-Piece Ceramide Infused
asteners are stomy ACCESSOries Pouching System Pouching System Pouching System Products

Wound Care

Education

Medicare Utilization Chart

Frequency
HCPCS Long Description of Change Condition

AB257  Transparent film, sterile, 16 sq in or less, ~ 3/wk min exudate
each dressing

A6258  Transparent film, sterile, more than 3/wk min exudate
16 sq in but less than or equal
to 48 sq in, each dressing

AB259  Transparent film, sterile, more than 3/wk min exudate
48 sq in, each dressing

A6260 Wound cleanser, any type, any size *

AB6261  Wound filler, gel/paste, per fluid ounce, 1/day
not otherwise classified

AG262  Wound filler, dry form, per gram, 1/day
not otherwise classified

AB266  Gauze, impregnated, other than water, 1/day
normal saline, or zinc paste, sterile,
any width, per linear yard

ABG402  Gauze, non-impregnated, sterile, 3/day
pad size 16 sq in or less, without
adhesive border, each dressing

AB403  Gauze, non-impregnated, sterile, 3/day
pad size more than 16 sq in but less
than or equal to 48 sq in, without
adhesive border, each dressing

AB404  Gauze, non-impregnated, sterile, 3/day
pad size more than 48 sq in,
without adhesive border, each dressing

AB407  Packing strips, non-impregnated, sterile 3/day
up to 2 inches in width, per linear yard

AB410  Eye pad, sterile, each *
A6411  Eye pad, non sterile, each *
AB412  Eye patch, occlusive, each *
AB6413  Adhesive bandage, first-aid type, *

any size each
AB441  Padding bandage, non-elastic, same as drsg

non-woven/non-knitted, width greater chg freq
than or equal to three inches and
less than five inches, per yard

AB442  Conforming bandage, non-elastic, same as drsg
knitted/woven, non sterile, width chg freq
less than three inches, per yard

AB443  Conforming bandage, non-elastic, same as drsg
knitted/woven, non sterile, width chg freq

greater than or equal to three inches
and less than five inches, per yard

A6444  Conforming bandage, non-elastic, same as drsg
knitted/woven, non sterile, width chg freq
greater than or equal to five inches,
per yard

* No established usual maximum, refer to Medicare Utilization Guidelines.

Hollister Incorporated 1.800.323.4060



Medicare Utilization Chart

HCPCS Long Description
A6445

Conforming bandage, non-elastic,
knitted/woven, sterile, width less
than three inches, per yard

Frequency
of Change

same as drsg
chg freq

Condition

A6446

Conforming bandage, non-elastic,
knitted/woven, sterile, width greater
than or equal to three inches and
less than five inches, per yard

same as drsg
chg freq

AG447

Conforming bandage, non-elastic,
knitted/woven, sterile, width greater
than or equal to five inches, per yard

same as drsg
chg freq

AB448

Light compression bandage, elastic,
knitted/woven, width less than three
inches, per yard

1/wk

A6449

Light compression bandage, elastic,
knitted/woven, width greater than or
equal to three inches and less than
five inches, per yard

1/wk

A6450

Light compression bandage, elastic,
knitted/woven, width greater than or
equal to five inches, per yard

1/wk

AB451

Moderate-compression bandage, elastic,
knitted/woven, load resistance of 1.25 to

1/wk

1.34 foot pounds at 50% maximum stretch,
width greater than or equal to three inches

and less than five inches, per yard

AB452

High-compression bandage, elastic,
knitted/woven, load resistance greater
than or equal to 1.35 foot pounds at
50% maximum stretch, width greater
than or equal to three inches and less
than five inches, per yard

1/wk

A6453

Self-adherent bandage, elastic,
non-knitted/non-woven, width less
than three inches, per yard

1/wk

AG454

Self-adherent bandage, elastic,
non-knitted/non-woven, width greater
than or equal to three inches and less
than five inches, per yard

1/wk

AB455

Self-adherent bandage, elastic,
non-knitted/non-woven, width greater
than or equal to five inches, per yard

1/wk

AG456

Zinc paste-impregnated bandage,

non-elastic, knitted/woven, width greater

than or equal to three inches and less
than five inches, per yard

1/wk

AB457

Tubular dressing with or without elastic,
any width, per linear yard

AB501

Compression burn garment, bodysuit
(head to foot), customer fabricated

* No established usual maximum, refer to Medicare Utilization Guidelines.

www.hollister.com

Hollister Incorporated
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Medicare Utilization Chart

Ostomy Care
Ceramide Infused
Products

Frequency

HCPCS Long Description of Change Condition
Q A6502  Compression burn garment, chin strap, *
S5 5 customer fabricated
S22
E- o ”g’» AB503  Compression burn garment, facial hood, *
S &% custom fabricated
? = 3
S § = AB504  Compression burn garment, glove to wrist, *
custom fabricated
g é 5 AB505  Compression burn garment, glove to *
32 elbow, custom fabricated
>5 o>
§ k) % A6506  Compression burn garment, glove to *
] § 3 axilla, custom fabricated
A6507  Compression burn garment, foot to knee *
- length, custom fabricated
2SR5
3Ss (‘% A6508  Compression burn garment, foot to *
E% ) thigh length, custom fabricated
S=5§ .
g £ ABG509  Compression burn garment, upper trunk *
(a1

to waist including arm openings (vest),
custom fabricated

A6510  Compression burn garment, trunk, *
including arms down to leg openings
(leotard), custom fabricated

Ostomy Care
Ostomy Accessories

AB511  Compression burn garment, lower trunk *
including leg openings (panty),
custom fabricated

e AB512  Compression burn garment, *
S o not otherwise classified
£
EC A6513  Compression burn mask, face and/or *
3 neck, plastic or equal, custom fabricated
A6530  Gradient compression stocking, below * open venous ulcer
knee, 18-30 mm HG, each
(<5}
S A6531  Gradient compression stocking, below * open venous ulcer
= knee, 30-40 mm HG, each
=
2 A6532  Gradient compression stocking, below * open venous ulcer
knee, 40-50 mm HG, each
AB533  Gradient compression stocking, thigh * open venous ulcer
) length,18-30 mm HG, each
(5]
§ § AB534  Gradient compression stocking, thigh * open venous ulcer
= a length, 30-40 mm HG, each
[
AB535  Gradient compression stocking, thigh * open venous ulcer
length, 40-50 mm HG, each
o A6536  Gradient compression stocking, full * open venous ulcer
8 length/chap style,18-30 mm HG, each
=]
5 A6537  Gradient compression stocking, full * open venous ulcer
§ length/chap style, 30-40 mm HG, each
A6538  Gradient compression stocking, full open venous ulcer
S
= * No established usual maximum, refer to Medicare Utilization Guidelines.
S
=
wl

Hollister Incorporated 1.800.323.4060



Medicare Utilization Chart

HCPCS Long Description

Frequency
of Change Con

length/chap style, 40-50 mm HG, each

AB539  Gradient compression stocking, waist * open venous ulcer
length,18-30 mm HG, each

AB540  Gradient compression stocking, waist * open venous ulcer
length, 30-40 mm HG, each

AB541  Gradient compression stocking, waist * open venous ulcer
length, 40-50 mm HG, each

A6544  Gradient compression stocking, garter belt * open venous ulcer

AB545  Gradient compression wrap, non-elastic, ~ 1/6 mo  open venous ulcer
below knee, 30-50 mm HG, each

AB549  Gradient compression stocking/sleeve, * open venous ulcer
not otherwise specified

A9720  Non-covered item or service

* No established usual maximum, refer to Medicare Utilization Guidelines.

www.hollister.com

Hollister Incorporated
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Ostomy Care
Ceramide Infused
Products

Ostomy Care Ostomy Care
Premier One-Piece New Image Two-Piece
Pouching System Pouching System

Tube Continence Ostomy Care
. Bowel Care 5 Ogtﬁﬁl‘"?c{eg;fgs Pouchkins Pediatr
asteners are V Pouching System

Wound Care

Education

FastCast OLS Total Contact Cast System

FastCast OLS Total Contact Cast*

> Vascular Management with low-level compression sock
> Infection Management and Prevention with the included
Hydrofera Blue Readly foam and Endoform dermal template

> Pressure Relief with FastCast OLS total contact cast system

Stock No Product Description

FC0001 FastCast OLS 50“ - 1 Cast Kit

FC0001-8 FastCast OLS 50“ - 8 Cast Kits

FC0002 FastCast OLS 50" - 5 Cast Kits &1 Med Boot
FC0003 FastCast OLS 50" - 5 Cast Kits &1 Lg Boot
FC0006 FastCast OLS 56" - 1 Cast Kit

FC0006-8 FastCast OLS 56" - 8 Cast Kits

FC0007 FastCast OLS 56" - 5 Cast Kits & 1 Lg Boot
FC0008 FastCast OLS 56" - 5 Cast Kits &1 XLg Boot
FCO011 FastCast OLS Small CAM Boot

FC0012 FastCast OLS Medium CAM Boot

FC0013 FastCast OLS Large CAM Boot

FC0014 FastCast OLS Extra Large CAM Boot
FC0024 FastCast OLS 4" Cast Roll Replacement

*Caution: Federal (USA) law restricts this device to sale by or on the order of a physician
or licensed healthcare professional. Refer to Instructions for Use for contraindications,
warnings, precautions, and possible complications.

Hollister Incorporated

1.800.323.4060



Foam Dressings

TRIACT Technology Wound Interface

TRIACT technology is an innovative lipido-colloid formulation in select Restore
wound dressings. The unique composition of TRIACT technology provides a moist
wound interface and allows virtually pain-free removal. It also reduces trauma

to delicate tissue upon removal. Dressings with TRIACT technology are designated
with the TRIACT logo on the packaging.

» Helps to provide a moist, wound-healing environment
> Helps to minimize pain at dressing change1
> Helps to prevent damage to newly formed tissue during dressing removal

TRIACT Foam with Silicone Border

» TRIACT Technology helps create a moist, wound-healing interface

> TRIACT Technology helps prevent damage to newly formed
/’/ tissue during dressing removal

» Silicone border offers virtually pain-free removal

Stock No HCPCS Description Quantity/Box
550762 AB212 4" x 4" with pad size 2.5" x 2.5" 10
550763 AB212 6" x 6" with pad size 4" x 4" 10
550764 A6213 6" x 8" with pad size 4" x 6" 10
550765 A6213 8" x 8" Sacral Pad 5" x 5.5" 10

Restore Foam with TRIACT Technology Non-Border

» Absorbent Foam Dressing with TRIACT Wound Interface Layer
» Requires Secondary Fixation

> Can be Cut to Size

> Indicated for Moderate to Heavy Exuding Acute and Chronic Wounds

Stock No HCPCS Description Quantity/Box
509380 A6209 25"x2.5" 10
509381 A6209 40 x 4" 10
509382 A6210 6"x6" 10

509384 AG210 Heel 4.7" x 7.5" 10

Restore LITE Foam with TRIACT Technology Non-Border

> Thin, Conformable Non-Adhesive Absorbent Dressing
with TRIACT Technology
> Manages Light to Moderate Exuding Acute and

Chronic Wounds
Stock No HCPCS Description Quantity/Box
509393 A6209 25"x2.5" 10
509394 AB210 4"x5" 10
509395 A6210 6"x6" 10
509396 AB210 6" x 8" 10

1 Meaume S. et al, The importance of pain reduction through dressing selection in routine
wound management: the MAPP study. Journal of Wound Care November 2004, 13(10)

www.hollister.com Hollister Incorporated
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Ostomy Care
Ceramide Infused
Products

Ostomy Care Ostomy Care
Premier One-Piece New Image Two-Piece
Pouching System Pouching System

Tube Continence Ostomy Care
. Bowel Care 5 Og;:n‘"?c{egggs Pouchkins Pediatr
asteners are V Pouching System

Wound Care

Education

Foam Dressings

Restore Silver Foam with TRIACT Technology Non-Border*

> Non-Adhesive, Non-Occlusive Antimicrobial
Absorbent Dressing with TRIACT

> May Help to Reduce Infection in Moderately to High
Exuding Partial- and Full-Thickness Wounds

> Super-Absorbent Foam Pad Ensures Drainage of
Exudate and Helps Protect the Skin Around the Lesion

% from Maceration
> Soft, Semi-Permeable Backing
> Contains Silver Sulfate
Stock No HCPCS Description Quantity/Box
509345 AB209 4" x 4" 10
509346 AB6210 6" x 8" 10

Caution: Federal (USA) law restricts this device to sale by or on the order of a physician
or licensed healthcare professional. Refer to Instructions for Use for contraindications,
warnings, precautions, and possible complications.

Silicone Wound Interface

Restore Foam with Silicone Border

> Absorption of moderate to heavy exudate

. > Protection of difficult wound-sites, peri-wound skin and
- bony prominences

» Simple application, easy removal & patient comfort

Stock No HCPCS Description Quantity/Box
520003 A6212 3.5" x 3.5" with pad size 2.5" x 2.5" 10
520005 A6212 5" x 6.2" with pad size 3.4" x 4.6" 10
520000 A6213 7" x 7" with pad size 5.5" x 5.5" 10
520001 A6213 7.3"x7.4" Sacral Pad 6.1" x 5.7" 10

Restore Foam with Silicone Non-Border
> Absorption of moderate to heavy exudate

> Protection of difficult wound-sites, peri-wound skin and
\/ bony prominences
; » Simple application, easy removal & patient comfort

Stock No HCPCS Description Quantity/Box
520023 A6209 2.5"x2.5" 10
520025 A6210 4"x 5" 10
520027 A6211 6.5"x8" 10

-’

520020 A6210 Heel 8" x 5" 10

Hollister Incorporated 1.800.323.4060



Contact Layers with TRIACT Technology

Restore Contact Layer FLEX

A\, > TRIACT Formulation Promotes Non-Adherence, and Helps
\ AR Prevent Disruption of the Healing Process During Dressing
Removal

» Can Be Shaped to Fit Contours of Deep or Irregular Wounds,
and in Difficult Anatomical Locations

> Virtually Pain-Free Dressing Removal for Enhanced Patient
Comfort

> Forms a Gel in the Presence of Exudate to Help Maintain a
Moist Wound Interface

> Dressing’s Gentle Tack Helps Hold Dressing in Place and
Minimizes Trauma to the Wound Bed

> Can Be Used on a Wide Variety of Wound Types, and in

Conjunction with NPWT
Stock No HCPCS Description Quantity/Box
506487 A6206 2"x2" 10
506488 A6207 4"x 5" 10
506489 A6207 6"x 8" 10

Restore Contact Layer, Silver*

> Non-Adhesive, Non-Occlusive Antimicrobial Wound
Contact Dressing with TRIACT Technology

> May Help to Reduce Infection in Low to Moderately
Exuding Partial- and Full-Thickness Wounds

> Shown to be Effective Against Bacteria Most Frequently

; Associated with Wound Infections
4 > Apply Directly to the Wound and Cover with a Secondary Dressing
> Contains Silver Sulfate
Stock No HCPCS Description Quantity/Box
509341 AB207 4"x5" 10
509342 AB207 6"x8" 10

*Caution: Federal (USA) law restricts this device to sale by or on the order of a physician
or licensed healthcare professional. Refer to Instructions for Use for contraindications,
warnings, precautions, and possible complications.

Restore to CalciCare Conversion Chart

Restore CalciCare

Description SKUs Description SKUs
Restore Calcium 529938 CalciCare Calcium 529938R
Alginate 2"x 2" Alginate 2"x 2"

Restore Calcium 529937 CalciCare Calcium 529937R
Alginate 4"x 4" Alginate 4"x 4.75"

Restore Calcium 529939 CalciCare Calcium 529939R
Alginate 4"x 8" Alginate 4"x 8"

Restore Calcium 529940 CalciCare Calcium 529940R
Alginate, 12" rope Alginate, 18" rope

Restore Calcium 529967 CalciCare Calcium 529967R
Alginate, Silver 2"x 2" Alginate, Silver 2"x 2"

Restore Calcium 529968 CalciCare Calcium 529968R
Alginate, Silver Alginate, Silver

4"x 475" 4"x 475"

Restore Calcium 529969 CalciCare Calcium 529969R
Alginate, Silver, Alginate, Silver 18" rope

12" rope

www.hollister.com Hollister Incorporated
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Ostomy Care
Ceramide Infused
Products

Ostomy Care Ostomy Care
Premier One-Piece New Image Two-Piece
Pouching System Pouching System

Tube Continence Ostomy Care
. Bowel Care 5 Ogtﬁl‘"?c{eg;fgs Pouchkins Pediatr
asteners are V Pouching System

Wound Care

Education

CalciCare and Restore Calcium Alginates

CalciCare Calcium Alginate

» Composed of a High G (Guluronic Acid) Calcium/Sodium
Alginate

» Soft and Conformable, Highly Absorbent, and Fast Gelling
> Forms a Moist Environment for Optimal Wound Healing

» Non-Woven Pad is Reinforced for Intact Removal

Stock No HCPCS Description Quantity/Box
529938R A6196 2"x2" 10
529937R A6197 4"x4.75" 10
529939R A6197 4"x8" 5
529940R A6199 1"x 18" Rope 5

CalciCare Calcium Alginate, Silver*

» Composed of a High G (Guluronic Acid) Calcium/Sodium
Alginate
» The Dressings are Soft and Conformable, Highly Absorbent,
\/ and Fast Gelling, as Wound Fluid is Absorbed
> Forms a Moist Environment for Optimal Wound Healing
» Non-Woven Pad is Reinforced for Intact Removal

> Releases Silver lons in the Presence of Wound Exudate
» Effective Barrier to Bacterial Penetration

Stock No HCPCS Description Quantity/Box
529967R A6196 2"x2" 10
529968R A6197 4"x4.75" 10
529969R A6199 1"x 18" Rope 5

Caution: Federal (USA) law restricts this device to sale by or on the order of a physician
or licensed healthcare professional. Refer to Instructions for Use for contraindications,
warnings, precautions, and possible complications.

Restore Calcium Alginate

» Highly Absorptive
» Made From Calcium Sodium Alginate, Creating Conformable

Protective Gel When in Contact with Exudate
» Forms Moist Wound Interface

» Remains Intact When Saturated so it is Removed in One Piece

Stock No HCPCS Description Quantity/Box
529938 A6196 2"x 2" 10
529937 A6196 4"x 4" 10
529939 A6197 4"x 8" 5
529940 A6199 12" Rope 5

Restore Calcium Alginate, Silver*

> Releases Silver lons in the Presence of Wound Exudate
» Effective Antimicrobial Agent Against a Broad Spectrum

r of Microorganisms
» Indicated for Moderate to Heavily Exuding Partial- to
. Full-Thickness Wounds
q Assists in Maintaining a Moist Environment and Allows
Intact Removal

» Contains Silver Sodium Hydrogen Zirconium Phosphate
Stock No HCPCS Description Quantity/Box
529967 AG196 2"x2" 10
529968 A6197 4"x4.75" 10
529969 AG199 1" x 12" Rope 5

*Caution: Federal (USA) law restricts this device to sale by or on the order of a physician
or licensed healthcare professional. Refer to Instructions for Use for contraindications,
warnings, precautions, and possible complications.
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Ostomy Care Ostomy Care
New Image Two-Piece Ceramide Infused
Pouching System Products

Tube Continence Ostomy Care Ostomy Care
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Education

Restore Wound Cleanser and Skin Care

Restore Wound Cleanser

> Helps Remove Particulate Matter and Other Debris
From Wound Bed

.} » No-Rinse Alternative to Saline and Harsh
Antiseptic Cleansers
=
Stock No HCPCS Description Quantity/Box
529975 AB260 8 0z pump spray 12
529976 A6260 12 0z pump spray 12

Restore Skin Cleanser

| > For Use on Intact Skin
= > Cleanses Peristomal and Perineal Skin of Urinary
4 and Fecal Discharge
> Gentle, Non-Irritating

= > Must Be Rinsed
Stock No HCPCS Description Quantity/Box
517210 A9270 8 0z (237 mL) Pump Spray 12

Restore Cleanser & Moisturizer

=

» Effective Skin Protection for People with Urinary and/
or Fecal Incontinence

B > Cleanser, Moisturizer, Protective Breathable Barrier for Skin
> Dimethicone-Based
= > No Rinse
Stock No HCPCS Description Quantity/Box
529977 A6250 7.5 0z (222 mL) Pump Spray 12
529978 A6250 11.5 0z (340 mL) Pump Spray 12

Restore Skin Conditioning Creme
> Moisturizes and Soothes Dry, Flaky Skin

= » May be Used Under Adhesive Products
Stock No HCPCS Description Quantity/Box
517220 AB250 40z (120 mL) Bottle 12




Restore Hydrocolloids

Restore Hydrocolloid: Sterile

» Conformable Semi-Occlusive Dressing with Flexible Quter Layer

» Maintains Moist Wound Environment

» Manages Minimal to Moderate Exudate in Partial- and
Full-Thickness Wounds

» Available With or Without Tapered Edges, Specialty Shapes

> Includes Disposable Wound Measuring Guide

Stock No HCPCS Description Quantity/Box
519953 A6234 Without Tapered Edges 4" x 4" 5
519954 A6235 Without Tapered Edges 6" x 8" 3
519955 A6236 Without Tapered Edges 8" x 8" 3
519956 AB234 With Tapered Edges 4" x 4" 5
519963 AB235 With Tapered Edges 6" x 6" 5
519957 A6235 With Tapered Edges 6" x 8" 3
519958 A6236 With Tapered Edges 8" x 8" 3
519959 A6235 With Tapered Edges/Triangle Shaped 17 sqin 5
519965 A6235 With Tapered Edges/Triangle Shaped 26.5sqin 5

Restore Extra Thin Hydrocolloid: Sterile

> Thinner Semi-Occlusive Dressing with Flexible Backing
» Maintains Moist Wound Environment

» Manages Minimal Exudate in Shallow Wounds

» Helps Protect Skin from Friction Injury

» Includes Disposable Wound Measuring Guide

Stock No HCPCS Description Quantity/Box
519921 AB234 4"x4" 5
519923 AB235 6"x8" 3
519925 AB236 8"x8" 3

Restore Hydrocolloid with Foam Backing: Sterile

» Occlusive Dressing with White Foam Backing
» For Low Friction Areas with Moderate Exudate
\_/‘/ > Includes Disposable Wound Measuring Guide

Stock No HCPCS Description Quantity/Box
519930 A6234 40 x 4" 5
519932 AB235 6"x8" 3
519935 AB236 8"x8" 3

2 DID YOU KNOW...

Disposable Wound Measuring Guides are included
with all Restore hydrocolloid dressings. To order
additional Wound Measuring Guides, please refer to
the Educational Resources section of this catalog.

Disposable Wound Guides -
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Ostomy Education e Glossary

AF300 Filter: “AF” stands for air flow and “300” represents the 300
mm2 air flow surface area on every AF300 filter.

Ceramide: A natural component of the human skin that links the cells
of the stratum corneum together to form a waterproof protective barrier.
This helps prevent water loss that can lead to skin damage and dryness.

CeraPlus Skin Barrier: A skin barrier that has all the basic
characteristics of an ostomy skin barrier (adhesion, absorption, and
erosion resistance) and is infused with ceramide. CeraPlus is an example
of an extended wear skin barrier.

Closed Pouch: A pouch without an opening at the bottom. Quick and
easy to discard. It must be removed to be emptied.

Colostomy: An ostomy (surgical opening) created in the colon, part
of the large intestine.

ComfortWear (pouch) Panels: Provide a soft cloth between the pouch
film and the skin.

Convex Skin Barrier: A skin barrier shaped to press more deeply
around the stoma. May be used when the stoma does not protrude from
the abdomen.

Cut-to-Fit Skin Barrier: A skin barrier that can be customized to a
needed size and shape. Ideal for stomas that are not round or stomas
that are still changing in size.

Drainable Pouch: A pouch with an opening at the bottom. An integrated
closure system or plastic clamp is used to keep the pouch closed until it
is time to empty it.

Filter: Releases gas but not odor out of the pouch. The key performance
factors of any filter are air flow, deodorization, and liquid protection.

Flange: The plastic ring in a two-piece ostomy system that is used to
connect the skin barrier and pouch together.

Flat Skin Barrier: May be used when the stoma protrudes from the
abdomen.

Flextend Skin Barrier: A skin barrier designed to be durable and
resistant to liquid discharge. Flextend is an example of an extended wear
skin barrier.

www.hollister.com Hollister Incorporated
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Ostomy Education e Glossary

FlexWear Skin Barrier: A skin barrier designed to be worn more than
one day. A FlexWear skin barrier is designed to be more resistant to
breakdown than a SoftFlex skin barrier. FlexWWear is an example of a
standard wear skin barrier.

Floating Flange: Type of skin barrier flange found on Hollister two-piece
pouching systems that allows you to put your fingers under the skin
barrier flange while attaching the pouch.

FormaFlex Skin Barrier: A skin barrier that can be stretched to fit the
size and shape of the stoma without the use of scissors. It is a barrier

option in the New Image two-piece pouching system. FormaFlex is an

example of an extended wear skin barrier.

lleostomy: A sugically created opening in the last portion of the small
intestine.

Irrigation: A procedure sometimes used by individuals with a colostomy
to control bowel elimination. It is not for everyone with a colostomy and
requires special equipment and instruction by a knowledgeable healthcare
provider.

Lock ’n Roll Microseal Closure: Integrated system for closing the
bottom of drainable pouches. Utilizes plastic interlocking fasteners to
create a secure closure. Found on New Image, Premier, and Pouchkins
drainable pouches.

Medical Adhesive-Related Skin Injury (MARSI): Occurrences in which
erythema and/or other manifestation such as blister, tear or other injury
persists more than 30 minutes after removal of medical adhesive.

Odor-Barrier Pouch: Is highly resistant to letting odors pass through
the pouch film. The odor barrier quality increases confidence when wearing
a pouch.

Peristomal Moisure-Associated Skin Damage (PMASD): Inflammation
and erosion of the skin adjacent to the stoma, associated with exposure to
effluent such as urine or stool.

Pre-Sized Skin Barrier: A skin barrier that is already cut to the
proper size.

QuietWear Pouch Material: Material comprised of a pouch film and
ComfortWear panel that are laminated together. This special design
results in the reduction of the pouch rustling noise.

Hollister Incorporated 1.800.323.4060



Ostomy Education e Glossary

SoftFlex Skin Barrier: A skin barrier that provides gentle adhesive
attachment to the skin. SoftFlex is designed to limit skin damage with
frequent removal and can be changed daily (or more often). SoftFlex is an
example of a standard wear skin barrier.

Stoma: A surgically created opening in the gastrointestinal or urinary
tract. Also known as an ostomy. The stoma is pink and moist and
doesn’t have feeling.

Urostomy: A surgically created opening into the urinary system; drains
urine and sometimes mucus.

Urostomy Pouches: Pouch with a drain tap at the bottom so urine
can be emptied quickly and easily.

Wear Time: The length of time a product can be worn before failure.
Wear time varies widely based upon a variety of factors.

www.hollister.com Hollister Incorporated
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Ostomy Education e Enterocutaneous Fistula
Management

Key Goals for Nursing Management

e Protect the skin — The output from a fistula can be very irritating to
the skin. Broken skin contributes to pain and discomfort. A skin barrier
can protect the skin from contact with the drainage.

e Contain the output — If the output is minimal, gauze dressings may
be sufficient for containment. However, if the volume of the output from
the fistula is significant or frequently overwhelms the dressing, a pouch
may be more appropriate. Using a pouch can be more efficient and can
protect healthcare providers from exposure to bodily fluids.

e Measure the output — With a high output fistula, loss of fluids
and electrolytes can be a major concern. Measuring the drainage is
easier using a pouching system. Sometimes connecting a pouch to a
bedside collector can relieve the stress on the pouch, so the wear time
improves.

e Manage costs — Care of fistulas can be costly in terms of supplies
and human resources. Using a pouching system and appropriate
accessories can be more cost-effective and manageable than frequent
dressing changes.

e Control odor — Containment of the drainage in a pouching system,
even in small quantities, can manage odor effectively. Other accessory
products can also assist with odor control when the pouch is changed
or emptied.

e Provide patient comfort — Effectively managing a fistula can
contribute to patient dignity. Protecting the skin, collecting the
discharge, containing costs, and controlling odor all contribute to
patient comfort.

Nix, D & Bryant, R. (2016). Fistula Management, Chapter 17 in Carmel, J.E., Colwell, J.C., & Goldberg,
M.T. (Eds). Wound Ostomy and Continence Nurses Society Core Curriculum Ostomy Management. Wolters
Kluwer, PA.

Hollister Incorporated 1.800.323.4060



Ostomy Education ® Resources

All of the Hollister educational materials listed below
are also available on our website: www.hollister.com

Educational DVDs Literature No
DVD 1: A Guide to Your Ostomy Surgery (English) 921856
DVD 1: A Guide to Your Ostomy Surgery (Spanish) 922224
DVD 2: A Guide to Living with Your Ostomy (English) 921857
DVD 2: A Guide to Living with Your Ostomy (Spanish) 922225
Online Education Program available at www.hollister.com

Case Studies

For a complete description and current listing, visit the Clinical Evaluations and
Case Studies section found in the Professional Resources portion of our website,
www.hollister.com. For more information, contact your Hollister Ostomy Sales
Representative.

Stoma Measuring Guide 903515
Educational Booklets Literature No
Understanding Your Colostomy 923054
Understanding Your Colostomy (Spanish) (online only) 923234
Understanding Your lleostomy 923055
Understanding Your lleostomy (Spanish) (online only) 923235
Understanding Your Urostomy 923056
Understanding Your Urostomy (Spanish) (online only) 923236
Can They Still Wiggle and Giggle? Coloring Book 907617
The Day | Got My Stoma (online only) 910497

Caring for Your Child With an Ostomy — Pediatric (English) 923057

Caring for Your Child With an Ostomy — Pediatric (Spanish) 923257
(online only)

Caring for your Loved One with an Ostomy 923058
Caring for your Loved One with an Ostomy (Spanish) (online only) 923258

www.hollister.com Hollister Incorporated
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Ostomy Education ® Resources

Ceramide Infused
Products

Ostomy Care

Ostomy Care Tips Literature No

Aaapt Barrier Rings 923059

o8 Adapt Convex Barrier Rings 923060

§ ng' % Adapt Lubricating Deodorant 923061

g é’ g Adapt Medical Adhesive Spray/Adapt Remover Spray & Wipes 923073

8= e Adapt No-Sting Skin Protective Wipe 923079

= Adapt Ostomy Belt 923062

©8e Aaapt Paste 923063

85 Z Adapt Stoma Powder 923064

£9 £ Colostomy Irrigation (online only) 923065

k] § E Using Convexity 923066

Fistula Management (onfine only) 923067

o High Output 923121

S % (‘%;’ lleostomy Dietary Guidelines 923117

%‘ £ Lock 'n Roll Microseal Closure 923068

Z3¢2 Medicare Reimbursement Guide 923118

One-Piece Pouching System (English) 923069

o 8 One-Piece Pouching System (Spanish) 923070

S g Ostomy Educational Theatre (online only) 923115

£8 Patient Anatomy Guide 923072

3 5 Peristomal Skin Care 923085

Pouchkins Newborn Pouching System (online only) 923119

Pouchkins One-Piece Pouching System (online only) 923074

g . Pouchkins Premie Pouching System (online only) 923076

.é g Pouchkins Two-Piece Pouching System (online only) 923075

S Routine Care of Your Ostomy (English) 923077

Routine Care of Your Ostomy (Spanish) 923078

Stoma Site Selection (online only) 923080

§ Two-Piece Pouching System (English) 923081

g Two-Piece Pouching System (Spanish) 923082

3 Two-Piece Pouching System with FormaFlex Skin Barrier 923083

(online only)

Types of Ostomies 923084

- e Universal Catheter Access Port (UCAP) (online only) 923114

§ ,§ Where a Soft Convex Skin Barrier May Improve Fit 923116

& Living with an Ostomy Booklets Literature No

Travel 923123

- Healthy Eating 923124

8 Sex & Parenthood 923125

'§ Home & Work Life 923126

= Sports & Fitness 923127
S
i

Hollister Incorporated 1.800.323.4060



Ostomy Education ® Resources

Professional Organizations:

Wound, Ostomy and Continence Nurses Society (WOCN)

WWW.WOCN.org

1.888.224.9626

Shadow Buddies Item No
Light Skin Tone Girl 905439
Light Skin Tone Boy 905440
Medium Skin Tone Girl 905441
Medium Skin Tone Boy 905442
Dark Skin Tone Girl 905443
Dark Skin Tone Boy 905444
Additional Resources Item No
Stoma Model (White Plastic) 858674

Consumer Resources

Hollister Secure Start Service
1.888.808.7456
www.securestartservices.com

United Ostomy Associations of America, Inc. (JOAA)
info@uoaa.org

www.ostomy.org

1.800.826.0826

Crohn’s and Colitis Foundation of America (CCFA)
www.ccfa.org
1.800.932.2423

Shadow Buddies
www.shadowbuddies.org
1.913.642.4646

www.hollister.com

Hollister Incorporated
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Ostomy Care Ostomy Care
New Image Two-Piece Ceramide Infused
Pouching System Products
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Wound Care i Bowel Care . Og;:‘no%{ eg;:gs Pouchking Pediatric  Premier One-Piece
ESIEHER s y Pouching System Pouching System

Education

Continence Care Education e Glossary

Anti-Reflux: Refers to a tube or collapsible material within a urine
collection device to help prevent urine from re-entering the tubing

Applicator Collar: Found on some Hollister male external catheters; a
plastic guide with notches for the thumb and forefinger to assist proper
placement against the tip of the penis

Bladder: A balloon-like muscular organ which lies in the pelvis and
functions to store and expel urine

Bladder Catheterization: A procedure in which a catheter is passed
through the urethra or stoma into the bladder for the purpose of draining
urine and performing diagnostic tests of bladder or urethral function

Benzalkonium Chloride (BZK): An antimicrobial solution used for
disinfecting the urethral opening prior to inserting an intermittent catheter.
Does not stain skin or clothing. Less likely to cause sensitivity

Catheter (Urinary): A hollow tube inserted through the urethra or a
stoma to the bladder to withdraw urine or administer medication

Closed System: Refers to a "touchless" gel catheter located within a
urine collection bag. The enclosed catheter is manipulated through the
bag, guided through the protective tip as it is inserted into the urethra
or stoma without being directly touched. For VaPro Plus, the catheter is
placed outside the collection bag and the funnel of the catheter attaches
to the collection bag port.

Closed System Kit: Closed system catheter includes the catheter located
within the urine collection bag, and usually includes gloves, PVP or BZK
swab sticks, and underpad drape

Collection Bag: A leg bag or bedside bag designed to collect urine by
gravity that is connected by tubing to an indwelling or external catheter,
urinary pouch, or also to wound drainage systems

Color Coded: On Hollister intermittent catheters, the funnel ends are
color and size coordinated so catheters may be consistently ordered
by size or funnel color

Connector: A device that secures the extension tubing to the catheter
or urinary pouch system

Coudeé Tip: A slight bend manufactured in the tip of the catheter which
makes insertion past the prostate easier for some men. A notch at the
funnel end is a guide for alignment during insertion

External Condom Catheter: Device that is secured externally with
various adhesives to the penis shaft for the purpose of urine collection.
Must be connected with tubing to a urine collection bag

Extension Tubing: Tubing that provides the connection between an
external or indwelling catheter and a urine collection bag or leg bag. May
also serve as a connection between an ostomy pouch or wound drainage
collector. Made of latex or vinyl

Eyelet: An oval-shaped hole in the insertion end of the catheter to
facilitate drainage of urine from the bladder. Eyelets are usually two in
number, and may be across from each other or offset. Smooth eyelets
help protect the urethra from insertion trauma

Hollister Incorporated 1.800.323.4060



Continence Care Education e Glossary

Female Urinary Pouch: A cut-to-fit, one-piece, vinyl pouch with

a flexible synthetic barrier which is attached externally to the female
urethral/vaginal area. The pouch is usually connected to a bedside
collection bag. Recommended for the more immobile female

Firm Catheter: Refers to lesser pliability of a urethral catheter

Flexible: Refers to greater pliability of a urethral catheter or of a skin
barrier found on the external female and male urinary pouches

Flextend Barrier: A skin barrier with special additives that achieve a
stronger adhesive seal and are more resistant to breakdown from fluids.
Skin-prepping agents are not recommended under Flextend Skin Barriers

French Size: Abbreviated Fr, the measuring gauge for the outer
diameter of a straight or indwelling catheter

Funnel: Colored non-insertion end of an intermittent catheter allows for
ease of fluid control. A catheter tipped syringe may be attached at the
funnel for fluid instillation into the bladder. Color corresponds to specific
French size

Gel Reservoir: A small, lubricant-filled flexible device unique to Hollister
built into the Advance Plus touch free intermittent catheter system. The
catheter is evenly coated with gel as it passes through the gel reservoir

Grip Section: A finely ribbed area on the catheter in a closed catheter
system which assists with catheter control for continuous catheter
advancement

Hydrophilic Catheter: A coated catheter that is lubricated with water

Incontinence: Loss of natural control of bowel and/or bladder functions

Indwelling Catheter: A flexible tube that remains in the bladder
continuously to drain urine. May be referred to as a Foley catheter

Inner Flap: A thin, latex extra membrane inside Hollister Extended Wear
latex male external catheters. The inner flap rests against the tip of the
penis to prevent urine backwash and undermining of the catheter adhesive

Intermittent Catheter: A flexible tube that is used to empty the bladder
on a regular schedule; used for self-catheterization. For single use only.

Latex: A material made from natural rubber. Red rubber catheters and
some male external catheters are made from latex

Leg Bag Straps: Hold the leg bag in place

Luer End: No funnel on non insertion end. A syringe may be connected
to the Luer end for bladder irrigation or insertion of medication

Lubricant: A water soluble jelly applied to a catheter prior to insertion
which allows for easier insertion and helps minimize urethral irritation

Male External Urinary Pouch: A cut-to-fit, one-piece vinyl pouch with a
synthetic adhesive backing that may be used for the very short penis, or
the flush or retracted penis. Usually attached to a bedside collection bag,
and is recommended more for those with limited mobility

Meatus: The opening of the urethra in both men and women

www.hollister.com Hollister Incorporated
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Continence Care Education e Glossary

Neurogenic Bladder (also known as, Neurogenic Lower Urinary
Tract Dysfunction): A loss of normal neural control of the bladder and
sphincter function associated with a neurological condition, such as
diabetes, stroke, multiple sclerosis, spina bifida or spinal cord injury

Non Latex: A material not made with Natural Rubber Latex; usually vinyl
or silicone for catheters or plastic for collection bags. Minimizes risk of
allergic reaction

Pre-Lubricated Catheter: Refers to a catheter which is lubricated uy
passing through a gel reservoir, or a lubricated catheter in a closed
system, or a catheter in packaging which contains a lubricant packet
which is ruptured to lubricate the catheter prior to opening the packaging,
or a pre-lubricated catheter with hydrophillic technology used in the
packaging allows the catheter to be lubricious and ready to use out of
the pack

Protective Tip: A specially designed system on some intermittent
catheters which functions to prevent urethra bacterial contamination

of the catheter. It is inserted into the urethra. The 15 mm length on the
Hollister protective tip helps decrease the risk of introducing bacteria
into the urethra. The tapered tip with multiple slits is designed for
comfortable insertion

Ring Cap: Cap on the protective tip protects the catheter tip. Ring assists
with cap removal especially for those with limited dexterity. Oval cap
design prevents roll away

Sizing Guide: Used for external catheters, these semicircular cutouts help
determine the diameter of the penis in order to guide selection for correct fit

Soft Catheter: A gentle, flexible catheter with limited firmness

SoftFlex Barrier: A flexible synthetic material that will conform to
rounded and some irregular surfaces. Gentle enough to be removed in
24 hours or less

Straight Tip: Refers to the tapered, rounded insertion end of a catheter

Urethra: The natural tube through which urine exits the bladder

Vacuum Relief Valve: A feature on the leg bag tubing that helps prevent
collapse of the tubing, as well as collapse of an external urinary pouch
or catheter

Vented Leg Bag: A special vacuum relief mechanism featured on the
oval kink-resistant tubing and the companion pouch which also features
an air vent. These combined features help to minimize a vacuum in the
leg bag as well as in the tubing. A vacuum is created as the urine cools
outside the body. The vacuum will stall urine drainage through the tubing
and/or prevent the leg bag from emptying completely

Hollister Incorporated 1.800.323.4060
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Tube Fasteners Education ® Resources

Educational Materials

See hollister.com for a current listing of educational materials.

Video Resources
See hollister.com for a current listing of educational materials.

Specialty Organizations
American Association for Respiratory Care (AARC)

WWW.aarc.org
1.972.243.2272

Wound, Ostomy and Continence Nurses Society (WOCN)
WWW.wocn.org
1.888.224.9626

Society of Critical Care Medicine (SCCM)
WWW.SCCM.Org
1.847.827.6869

National Pressure Ulcer Advisory Panel
WWW.Nnpuap.org
1.202.521.6789

American Association of Critical Care Nurses (AACN)
WWW.aacn.org
1.800.394.5995

http://www.hollister.com/en/criticalcare/
criticalcareprofessionalresources/clinicalevaluationscasestudies

Hollister Incorporated 1.800.323.4060
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Wound Care Education e Glossary

Abrasion: Wearing away of the skin through some mechanical process
(friction or trauma)

Abscess: Accumulation of pus formed in tissue as a result of infection

Alginate: A highly absorptive dressing derived from brown seaweed

Cellulitis: Inflammation of the tissues indicating a local infection;
characterized by redness, edema, and tenderness

Collagen: Protein found in skin and connective tissue

Debridement: Removal of foreign material and devitalized or
contaminated tissue from a wound

Dehiscence: Separation of wound edges

Denude: Removal or loss of superficial skin layers

Dressing: Any of various material used for covering and protecting wounds

Edema: Swelling

Epidermis: Outermost layer of the skin

Erythema: Diffuse redness of the skin

Eschar: Dead tissue

Excoriation: A scratch or abrasion on the skin

Exudate: Wound fluid or drainage

Friction: Rubbing that causes mechanical trauma to the skin or tissue,
layers, mucosa

Full-thickness: Tissue destruction extending through the dermis
to involve subcutaneous level and possibly muscle, fascia, or bone

Granulation: Formation of connective tissue and many new capillaries
in a full-thickness wound; typically appears as red and cobblestoned

Hydrocolloid dressing: A category of wound dressings composed

of materials, such as gelatin, pectin, and carboxymethylcellulose, that
provide a moist healing environment and adhere to the skin around
the wound

Hydrogel: Water- or glycerin-based gels, impregnated gauzes, or sheet
dressings. Hydrogels maintain a moist healing environment and absorb
a minimal amount of wound exudate

Hydrophilic: Attracting moisture

Infection: Invasion and multiplication of microorganisms in the body tissues

Maceration: Softening of tissue by soaking in fluids

Necrotic: Devitalized tissue; may appear yellow and moist, gray,
or dark and leathery

Partial-thickness: Wounds that extend through the epidermis and
may involve the dermis; these wounds heal by re-epithelialization

Peri-wound: The area immediately around the wound

www.hollister.com Hollister Incorporated
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Wound Care Education e Glossary

Pressure Injury Stages:

Pressure Injury: A pressure injury is localized damage to the skin and
underlying soft tissue usually over a bony prominence or related to a
medical or other device. The injury can present as intact skin or an

open ulcer and may be painful. The injury occurs as a result of intense
and/or prolonged pressure or pressure in combination with shear. The
tolerance of soft tissue for pressure and shear may also be affected by
microclimate, nutrition, perfusion, co-morbidities and condition of the soft
tissue.

Stage 1 Pressure Injury: Non-blanchable erythema of intact skin:
Intact skin with a localized area of non-blanchable erythema, which
may appear differently in darkly pigmented skin. Presence of blanchable
erythema or changes in sensation, temperature, or firmness may
precede visual changes. Color changes do not include purple or maroon
discoloration; these may indicate deep tissue pressure injury.

Stage 2 Pressure Injury: Partial-thickness skin loss with

exposed dermis

Partial-thickness loss of skin with exposed dermis. The wound bed is
viable, pink or red, moist, and may also present as an intact or ruptured
serum-filled blister. Adipose (fat) is not visible and deeper tissues are

not visible. Granulation tissue, slough and eschar are not present. These
injuries commonly result from adverse microclimate and shear in the skin
over the pelvis and shear in the heel. This stage should not be used to
describe moisture associated skin damage (MASD) including incontinence
associated dermatitis (AD), intertriginous dermatitis (I'TD), medical
adhesive related skin injury (MARSI), or traumatic wounds (skin tears,
burns, abrasions).

Stage 3 Pressure Injury: Full-thickness skin loss

Full-thickness loss of skin, in which adipose (fat) is visible in the ulcer and
granulation tissue and epibole (rolled wound edges) are often present.
Slough and/or eschar may be visible. The depth of tissue damage varies
by anatomical location; areas of significant adiposity can develop deep
wounds. Undermining and tunneling may occur. Fascia, muscle, tendon,
ligament, cartilage and/or bone are not exposed. If slough or eschar
obscures the extent of tissue loss this is an Unstageable Pressure Injury.

Stage 4 Pressure Injury: Full-thickness skin and tissue loss
Full-thickness skin and tissue loss with exposed or directly palpable
fascia, muscle, tendon, ligament, cartilage or bone in the ulcer. Slough
and/or eschar may be visible. Epibole (rolled edges), undermining and/
or tunneling often occur. Depth varies by anatomical location. If slough or
eschar obscures the extent of tissue loss this is an Unstageable Pressure
Injury.

Unstageable Pressure Injury: Obscured full-thickness skin

and tissue loss

Full-thickness skin and tissue loss in which the extent of tissue damage
within the ulcer cannot be confirmed because it is obscured by slough or
eschar. If slough or eschar is removed, a Stage 3 or Stage 4 pressure
injury will be revealed. Stable eschar (i.e. dry, adherent, intact without
erythema or fluctuance) on the heel or ischemic limb should not be
softened or removed.

Pressure Injury Stages as revised and copyrighted by Nat'l Pressure Ulcer Advisory Panel, April,, 2016

Hollister Incorporated 1.800.323.4060



Wound Care Education e Glossary

Pressure Injury Stages: (continued)

Deep Tissue Pressure Injury: Persistent non-blanchable deep red,
maroon or purple discoloration

Intact or non-intact skin with localized area of persistent non-blanchable
deep red, maroon, purple discoloration or epidermal separation revealing
a dark wound bed or blood filled blister. Pain and temperature change
often precede skin color changes. Discoloration may appear differently in
darkly pigmented skin. This injury results from intense and/or prolonged
pressure and shear forces at the bone-muscle interface. The wound may
evolve rapidly to reveal the actual extent of tissue injury, or may resolve
without tissue loss. If necrotic tissue, subcutaneous tissue, granulation
tissue, fascia, muscle or other underlying structures are visible, this
indicates a full thickness pressure injury (Unstageable, Stage 3 or

Stage 4). Do not use DTPI to describe vascular, traumatic, neuropathic,
or dermatologic conditions.

Additional pressure injury definitions.

Medical Device Related Pressure Injury: This describes an etiology.
Medical device related pressure injuries result from the use of devices
designed and applied for diagnostic or therapeutic purposes. The
resultant pressure injury generally conforms to the pattern or shape of the
device. The injury should be staged using the staging system.

Mucosal Membrane Pressure Injury: Mucosal membrane pressure
injury is found on mucous membranes with a history of a medical device
in use at the location of the injury. Due to the anatomy of the tissue these
ulcers cannot be staged.

Pus: Thick fluid composed of leukocytes, bacteria, and cellular debris

Shear: Sliding of skin over subcutaneous tissues and bones obstructing
cutaneous capillaries, which may lead to ischemia

Sinus Tract: A course or pathway which can extend in any direction from
the wound base; results in dead space with potential for abscess formation

Slough: Stringy, necrotic tissue; usually yellow, tan, gray, green,
or brown

Strip: Removal of epidermis by mechanical means, usually tape

Ulcer: Loss of epidermis/dermis or mucous membrane with
definite margins

Undermine: Skin edges of a wound that have lost supporting tissue
under intact skin

Wound: A break in the integrity of the skin; an injury to the body which
causes a disruption of the normal continuity of the body structures

Wound Margin: Rim or border of a wound

Skin Structure:

The epidermis, which is the outermost layer of the skin, is characterized
as follows: avascular, varies in thickness (depending on body location),

a dry structure which sheds cells and replaces itself every 4 to 6 weeks;
approximately the thickness of a piece of plastic wrap

www.hollister.com Hollister Incorporated
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The dermis is located directly beneath the epidermis and is
characterized as follows: provides strength and structural support
through a vascular network of connective tissue blood vessels, nerves,
hair, and nails. Sebaceous glands and sweat glands originate from this
layer, which is thicker than the epidermis

Below the dermis is the subcutaneous tissue which is composed

of major vessels, lymphatics, fat, and connective tissue. This area
provides insulation and nutritional support for the skin. Located below
the subcutaneous tissue are fascia, muscles, tendons, and bone. The
thickness of the dermis and subcutaneous layers vary from person

to person and on different parts of the body

Types of Ulcers

Pressure Ulcers: A pressure ulcer is localized injury to the skin and/or
underlying tissue usually over a bony prominence as a result of pressure,
or pressure in combination with shear and/or friction. A number of
contributing or confounding factors are also associated with pressure
ulcers; the significance of these factors is yet to be elucidated.

Venous Ulcers: These are the most common type of lower-leg ulcers
in ambulatory people. The underlying cause involves vein damage or
an incompetent calf muscle pump action which leads to venous
hypertension. As a result, the blood pools in the lower extremities
causing edema and leakage of fibrinogen and other blood products
into the tissues. Trauma to the area or increased pressure within the
tissues results in ulceration.

Arterial Ulcers: Arterial ulcers result from chronic or acute arterial
insufficiency to the skin and subcutaneous tissue of the lower
extremities. The most common cause is a progressive disease:
atherosclerosis. The precipitating event leading to ulceration is
usually trauma, such as a bumped toe or tight shoes. Arterial ulcers
may occur alone or in combination with diabetes, venous stasis, and
numerous other conditions. Multidisciplinary management of these
patients with early intervention and close monitoring is key to
prevention of more serious complications.

Neuropathic Ulcers: Neuropathic ulcers may occur in individuals with
diabetes, spinal cord injury, Hansen’s disease, or other conditions that
result in loss of sensation in the legs and feet. Diabetic foot ulcers are
most commonly caused by peripheral neuropathy and peripheral
vascular disease. Multidisciplinary management of these patients with
early intervention and close monitoring is key to prevention of more
serious complications.

Reference: Miller-Keane Encyclopedia & Dictionary of Medicine, Nursing & Allied Health - Revised Reprint
7th Edition  http://www.us.elsevierhealth.com/dictionary/miller-keane-encyclopedia-dictionary-of-medicine-
nursing-allied-health-revised-reprint-hardcover/9781416026044/

Hollister Incorporated 1.800.323.4060
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Wound Care Education e Skin Tear Resources

The ISTAP Skin Tear Resource Kit has been designed to help implement
a systematic approach to the prevention, management, and treatment of
skin tears.

Hollister is proud to support the International Skin Tear Advisory Panel in
the prevention, assessment, and treatment of skin tears. The support of
Hollister has been provided through an unrestricted educational grant.

This information is provided for general medical educational purposes only.
More information is available at www.skintears.org I@ AP

Skin Tears Defined

A wound caused by shear, friction, and/or blunt force resulting in
separation of skin layers. A skin tear can be partial-thickness (separation
of the epidermis from the dermis) or full-thickness (separation of both the
epidermis and dermis from underlying structures.)1

Skin Tear Risk Assessment Pathway2

RISK FACTORS

GENERAL HEALTH

Chronic/critical disease, polypharmacy, impaired
cognitive, sensory, visual, auditory, or nutrition
MOBILITY

History of falls, impaired mobility, dependent
activities of daily living (ADLs), mechanical trauma
SKIN

Extremes of age, fragile skin, previous skin tears

Note: ltems above in bold are HIGH RISK factors

Reassess with Implement Skin Tear Risk
change of status Reduction Program.

See Quick Reference Guide

and/or ISTAP Risk Reduction
Program.1

Take special note of visual
impairment, impaired mobility,
dependent ADLs, extremes of
age, and previous skin tears.

[Reassess with change of status ]—

www.hollister.com Hollister Incorporated
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Assess and Manage

Skin Tear Decision Algorithm3

m

ASSESS

CONTROL
BLEEDING

CLASSIFY
APPROXIMATE WOUND EDGES (Measure and

Document)
GOALS OF TREATMEN

¢ Treat the cause *Moist wound healing ¢ Protect periwound
¢ |mplement prevention ¢ Avoid trauma skin
protocol ¢ Manage the pain *Manage exudate

* Avoid infection

TREATMENT OPTIONS in accordance with local wound management protocols

Type 1: No skin loss Type 2: Partial flap loss Type 3: Total flap loss
Linear or flap tear which Flap cannot be Entire wound bed
can be repositioned to repositioned to cover is exposed

cover the wound bed the wound

References:

1 LeBlanc, K., Baranoski, S. et al. Skin Tears: State of the Science: Consensus Statements for the Prevention,
Prediction, Assessment, and Treatment of Skin Tears. Advances in Skin and Wound Care. 2011;24(9Suppl):2-15.
2 Ellman, C. et al. (2013) Sustained Results: A learning management system platform which empowers and
educates bedside staff.

3 LeBlanc K., Baranoski S., et al. International Skin Tear Advisory Panel: A Tool Kit to Aid in the Prevention,

Assessment, and Treatment of Skin Tears Using a Simplified Classification System. Advances in Skin and Wound
Care. 2013;26:459-476.

2 DID YOU KNOW...

Partnering for the Prevention and Management

of Skin Tears.

We are proud to support the International Skin Tear Advisory Panel in
the prevention, assessment, and treatment of skin tears. The support of
Hollister has been provided through an unrestricted educational grant.

An ISTAP Skin Tear Resource Kit has been designed to help implement a
systematic approach to the prevention, management, and treatment of
skin tears.

This information is provided for general medical educational purposes
only. More information is available at www.skintears.org.

I@AP"
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Wound Care Education ® Resources

Educational Materials Literature No
FastCast OLS Brochure 922780
Contact Layer Brochure 921818
CalciCare Calcium Alginate Brochure 922571
Skin Tears: State of the Science: Consensus Statements 921822

for the Prevention, Prediction, Assessment, and Treatment
of Skin Tears

Measuring Tools Literature No
Restore Wound Measuring Guide, Small 874366
Restore Wound Measuring Guide, Large 874367

Product Inservice Tools are available through your
Hollister sales representative
Algorithms, Protocols, and Other Educational Tools are available on our website.

For a complete description, visit the Educational Resources portion of our website,
or contact your Hollister sales representative.

www.hollister.com Hollister Incorporated
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Sgg Wound Care Education e Resources

EZE

2E= .

33 Clinical Poster Reprints Literature No
Restore Contact Layer

o 8 c Use of Negative Pressure Wound Therapy with a New 907982

8t8 Wound Contact Layer: Results of a Clinical Evaluation

) .

Egs Restore Contact Layer, Silver

a § § Use of a Contact Layer with Silver Under a Negative 910278

2 Pressure Dressing

© 8 e Specialty Organizations

§ % g The Association for the American Diabetes Association

= ‘g, Advancement of Wound Care (AAWC) www.diabetes.org

g g 5 www.aawconline.org 1.800.DIABETES (342.2383)

SFS 1.866.229.9999 National Spinal Cord Injury
Wound, Ostomy and Continence Association

©8 e Nurses Society (WOCN) www.spinalcord.org

5 g 2 WWW.WOCN.Org 1.800.962.9629

Zeo 1.888.224.9626 U.S. Department of Health

g £5 American Academy of Wound and Human Services Centers

o3 Management (AAWM) for Medicare & Medicaid Services
abwmcertified.org www.cms.hhs.gov

1.202.521.0368

w 8 National Guideline Clearinghouse

332 American Burn Association www.guideline.gov

=8 www.ameriburn.org Euro Wound M

g8 pean Wound Management

£E 1.312.642.9260 Association

(S Wound Healing Society WWW.ewma.org
www.woundheal.org +45 7020 03 05

1.763.765.2377

National Pressure Ulcer
Advisory Panel
WWW.Npuap.org
1.202.521.6789

Tube Bowel Care Continence
Fasteners Care

Wound Care

Education

Hollister Incorporated 1.800.323.4060
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Index e Stock Number

Stock No Stock No Stock No Stock No
TXXXX 1837x 3777 520020
10xx 1838x 3778 520023
1120x 18382 3795 520025
1140x 1839x 3796 520027
1150x 18392 3797 529937
1340x 1840x 3799 529937R
1350x 18402 380x 529938
139xx 1841x 381x 529938R
1410x 18412 382x 529939
1420x 1842x 383x 529939R
143x 18422 384x 529940
1430x 1873x 387x 529940R
1440x 1875x 389x 529967
1450x 1890x 390x 529967R
1460x 1891x 506487 529968
1470x 1892x 506488 529968R
1480x 1900x 506489 529969
149xx 1905x 509341 529969R
1510x 1910x 509342 529974
1520x 1915x 509345 529975
1530x 1920x 509346 529976
1540x 1925x 509380 529977
1550x 1930x 509381 529978
1560x 1935x 509382 550762
1580x 1940x 509384 550763
1590x 1950x 509393 550764
1610x 31003 509394 550765
1640x 31005 509395 71Xxx
1796 31009 509396 716x
1800x 318x 517210 7299
1801x 32004 517220 73XxX
1810x 32005 519921 7300
1811x 32006 519923 7331
1812x 32007 519925 T4xxx
1813x 322x 519930 7700
1814x 323x 519932 771x
1815x 327x 519935 7721
1816x 33016 519953 7723
1817x 332x 519954 7724
1818x 334x 519955 7728
1819 340x 519956 773x
1820x 360x 519957 7730
1828x 366x 519958 7736
18282 370x 519959 7737
1829x 372x 519963 7740
18292 373x 519965 7760
1832x 374x 520000 7766
1833x 376x 520001 7767
1835x 3761 520003 78xx
1836x 3774 520005 7800

www.hollister.com

Hollister Incorporated
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Index e Stock Number

Stock No Stock No Stock No Stock No
78500 84590 88700 9814
78501 846x 88800 9821
7905 8460 89xx 9822
7906 8469x 890x 9823
7910 84690 89001 9839
7917 847x 89002 9840
79300 8479xxx 89003 9873
79301 848x 89004 9880
79400 8489x 89005 Bxxx
79402 849x 8901 BxxxB
795xx 8499x 891x FC0001
796xx 850xx 8931 FC0001-8
80xx 851xx 895xx FC0002
80070 852xx 896X FC0003
80110 853X 896xx FC0006
8031 8531 898x FC0006-8
8081 854xx 899x FC0007
81xx 855% 90xxx FC0008
81070 8551 91xxx FC0011
81110 857x 910x FC0012
8131 858xx 920x FC0013
8181 859x 93xxx FC0014
82xxx-30 861x 9342 FC0024
821xx 862xx 9343

82100 863x 9345

823xx 8631 9346

82300 864x 9348

82302 8641 9349

824xx 8651 94xxx

82400 866x 95xxx

82402 867x 9BxxX

82500 872x 9645

8261x 873x 9655

8262xx 874x 97xxX

827xx 875x 970x

828x 877x 974xx

829x 8770 975xx

8331 88xx 976xx

834x 8800 977x

8371 8801 9779

8381 881x 9780

841x 883xx 9781

8413xx 88300 9782

843x 88302 9785

8439xxx 884xx 9786

844x 88400 9788

8440 88401 9799

8449x 88402 9800

84490 88501 9805

8450 887xx 9811

Hollister Incorporated

1.800.323.4060



Index e Product Name

Name

Adapt Barrier Extenders

Adapt CeraRing Convex Barrier Rings

Adapt CeraRing Flat Barrier Rings

Adapt CeraRing Oval Convex Barrier Rings

Adapt Odor Eliminator and Lubricant

Adapt Ostomy Belts

Adapt Skin Barrier Paste

Adapt Skin Barrier Rings

Adapt Skin Barrier Strips

Adapt Skin Prepping Product

Adapt Stoma Powder

Adapt Adhesives and Removers

Advance Plus Pocket Touch Free Intermittent Catheter System
Advance Plus Touch Free Intermittent Catheter Kit
Advance Plus Touch Free Intermittent Catheter System
AnchorFast Guard Oral Endotracheal Tube Fastener
Anchorfast Oral Endotracheal Tube Fastener
AnchorFast Replacement Neck Band Straps
Apogee Family of Intermittent Catheters

Apogee HC Hydrophilic Intermittent Catheter
Apogee IC Intermittent Catheters, Firm Coudé Style
Apogee IC Intermittent Catheters, Firm Style
Apogee Intermittent Catheters, Other Styles
Apogee Plus System

Apogee Plus System Kit

Bedside Drainage Collection System with Anti-Reflux Valve

CalciCare Calcium Alginate

CalciCare Calcium Alginate, Silver

CenterPointLock Closed Pouches

CenterPointLock Convex Skin Barriers with Floating Flange
CenterPointLock Drainable Pouches

CenterPointLock Flat Skin Barriers with Floating Flange
CenterPointLock Irrigator Sleeve

CenterPointLock Stoma Cap

CenterPointLock Urostomy Pouches

CeraPlus Convex Skin Barriers with Integrated Floating Flange
CeraPlus Flat Skin Barriers with Integrated Floating Flange

Drainable Pouch Clamp

Drainable Pouches with CeraPlus Convex Barriers
Drainable Pouches with CeraPlus Flat Barriers
Drainable Pouches with CeraPlus Soft Convex Barriers
Drain Tube Attachment Device (DTAD): Sterile

www.hollister.com Hollister Incorporated
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Name

Everyday Male External Catheter
Extended Wear Male External Catheter
Extension Tubing

Fabric Leg Bag Straps

FastCast OLS Total Contact Cast System Convenience Kit
Fecal Collectors

Feeding Tube Attachment Device (FTAD)

Female Urinary Pouch External Collection Device
Flextend (extended wear) Skin Barrier

Hollister Universal Catheter Access Port
Horizontal Tube Attachment Device (HTAD): Sterile

InView Male External Catheters
Irrigation Products
Irrigator Sleeve

Karaya 5 Closed Pouches
Karaya 5 Drainable Pouches
Karaya 5 Urostomy Pouches

Loop Ostomy Bridge

MY Cleaner/Decrystallizer
M9 Odor Eliminators
Male Urinary Pouch External Collection Device

New Image Closed Pouches

New Image Convex Skin Barriers with Integrated Floating Flange
New Image Drainable Pouches

New Image Flat Skin Barriers with Integrated Floating Flange
New Image High Output Drainable Pouches

New Image Non Sterile Kits — Drainable

New Image Non Sterile Kits — Urostomy

New Image Sterile Kits — Drainable

New Image Sterile Kits — Urostomy

New Image Urostomy Pouches

0nli Ready to Use Hydrophilic Intermittent Catheter

Pouchkins Newborn Pouch

Pouchkins One-Piece Pouches

Pouchkins Pediatric Ostomy Belt

Pouchkins Premie Pouch

Pouchkins Two-Piece Pouches

Pouchkins Two-Piece Skin Barrier

Premier Closed Pouches with Flat Barriers
Premier Drainable Pouches with Convex Barriers
Premier Drainable Pouches with Flat Barriers
Premier Drainable Pouches with Soft Convex Barriers
Premier High Output Drainable Pouches

Hollister Incorporated 1.888.740.8999



Index e Product Name

Name

Premier Non Sterile Kits — Drainable

Premier Non Sterile Kits — Urostomy

Premier Stoma Cap

Premier Urostomy Pouches with Convex Barriers
Premier Urostomy Pouches with Flat Barriers

Replacement Filters

Restore Calcium Alginate

Restore Calcium Alginate, Silver

Restore Cleanser & Moisturizer

Restore Contact Layer FLEX

Restore Contact Layer, Silver

Restore Extra Thin Hydrocolloid: Sterile

Restore Foam with Silicone Border

Restore Foam with Silicone with TRIACT Technology Non-Border
Restore Foam with TRIACT Technology Non-Border
Restore Hydrocolloid: Sterile

Restore Hydrocolloid with Foam Backing: Sterile

Restore Hydrogel

Restore LITE Foam with TRIACT Technology Non-Border
Restore Silver Foam with TRIACT Technology Non-Border
Restore Skin Cleanser

Restore Skin Conditioning Creme

Restore Wound Cleanser

Skin Barriers

Skin Barrier Pastes and Powders
Stoma Cap

Suction Tube Attachment Device (STAD)

TRIACT Foam with Silicone Border

Urinary Leg Bag

Urinary Leg Bag Combination Pack

Urostomy Drain Tube Adapter

Urostomy Pouches with CeraPlus Soft Convex Barriers

VaPro Hydrophilic Intermittent Catheter, Coudé Tip

VaPro Plus Pocket Touch Free Hydrophilic Intermittent Catheter
VaPro Plus Touch Free Hydrophilic Intermittent Catheter
Vented Urinary Leg Bag Combination Pack

Vertical Tube Attachment Device (VTAD): Sterile

Wound Drainage Collector

www.hollister.com Hollister Incorporated
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Index « HCPCS Codes

Ostomy Care
Ceramide Infused
Products

HCPCS HCPCS
Ad326 A4428
- 74328 A4429
332 A4330 A4430
= e e A4331 A4432
S &% A4349 A4435
8= 28 A4351 4455
= A4352 A4456
- A4353 A5052
28§
525 4357 A5054
‘é 2 ) 4358 25055
e 4362 A5056
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The Hollister logo, Adapt, Adapt CeraRing, Advance Plus, Advance Plus Pocket, AF300, AnchorFast,
AnchorFast Guard, Apogee, Apogee Plus, Apogee IC, Apogee HG, CalciCare, CenterPointLock, CeraPlus,
ComfortWear, Everyday, Extended Wear, FastCast OLS, Flextend, Flextend M, FlexWear, FormaFlex,
Hollister, InView, Karaya 5, Lock 'n Roll, m9, New Image, Onli, Pouchkins, Premier, QuietWear, Restore,
Secure Start, SoftFlex, TRIACT, VaPro, VaPro Plus and VaPro Plus Pocket are trademarks of Hollister
Incorporated.

Endoform is a trademark of Aroa Biosurgery Limited.

Hydrofera Blue Ready is a trademark of Hydrofera LLC.

Remois is a technology of Alcare Co., Ltd.

All other trademarks and copyrights are the property of their respective owners.
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Contact Us

Monday - Friday
8:00am - 5:00pm (CT)

For consumer or healthcare professional questions:
1.888.808.7456

For dealer, distributor, institution and
pharmacy questions or orders:

1.800.323.4060
FAX 1.847.680.1017

£ Hollister

Hollister Incorporated
2000 Hollister Drive
Libertyville, lllinois 60048
1.800.323.4060
© 2018 Hollister Incorporated. Printed in USA.
www.hollister.com 923122-0918  US-00126
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